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WLS SPI Concepts

The Smart Plug-in for BEA WebLogic Server (WLS SPI) allows you to manage WebLogic
Servers from an HP OpenView Operations (OVO) console. WLS SPI adds monitoring
capabilities otherwise unavailable to OVO. For more information on OVO refer to

HP OpenView Operations for UNIX Concepts Guide.

This chapter offers a basic introduction to WLS SPI concepts. The following topics are
covered:

¢ Introducing WLS SPI
¢ Functions of WLS SPI
e Components of WLS SPI

Intfroducing WLS SPI

In conjunction with OVO, WLS SPI offers centralized tools that help you monitor and manage
systems using WebLogic Server. From the OVO console, you can apply the HP OpenView
performance and problem managing processes to monitor systems using WebLogic Server.
WLS SPI metrics are automatically sent to the OVO agent. These metrics can generate
alarms or be consolidated into reports and graphs to help you analyze trends in server usage,
availability, and performance. You can also integrate WLS SPI with HP OpenView Reporter
and HP OpenView Performance Manager (both products must be purchased separately) to
obtain additional reporting and graphing flexibility and capabilities. For details on
integrating WLS SPI with other HP OpenView products see Integrating HP OpenView
Reporting and Graphing Products with WLS SPI on page 83.

Smart Plug-in Data

WLS SPI has several server-related metrics that gather data about the following areas:
e server availability

e gserver performance

* memory usage

® transaction rates

e servlet executing times, time-outs, request rates

e JDBC connection status

e Web application processing

e Java message service processing

e cluster processing

17



e exception counts of scheduled WLS actions

Smart Plug-in Uses and Customizations

As a WebLogic Server administrator, you can choose the metrics crucial to the operation of
WebLogic Server by modifying WLS SPI templates. The templates contain settings that allow
incoming data to be measured against predefined rules. These rules generate useful
information in the form of messages. The messages have color-coding to indicate the severity
level. You can review these messages for problem analysis and resolution. There are several
pre-defined corrective actions for specific events or threshold violations. These corrective
actions can be automatically triggered or operator-initiated.

Functions of WLS SPI

WLS SPI messaging, reporting, and action-executing capabilities are based on the OVO
concept of templates. The settings within these templates define various conditions within the
WebLogic Server and allow information to be sent back to the OVO management server. This
helps you to proactively address potential or existing problems and avoid serious disruptions
to Web transaction processing. The WLS SPI performs the following functions:

e C(Collecting and Interpreting Server Performance and Availability Information
¢ Displaying Information

e Generating Reports Using HP OpenView Reporter

e Graphing Data with OpenView Performance Manager

e (Customizing Templates and Metrics

Collecting and Interpreting Server Performance and Availability Information

After you configure the WLS SPI and the templates are deployed to the managed nodes, the
SPI starts gathering server performance and availability data. This data is compared with the
settings within the deployed templates. The templates define conditions that can occur within
the WebLogic Server, such as queue throughput rates, cache use percentages, timeout rates,
and average transaction times. The templates monitor these conditions against default
thresholds (set within the templates) and trigger messages when a threshold has been
exceeded.

Displaying Information

WLS SPI templates generate messages when a threshold is exceeded. These messages can
appear as:

e Messages in the Message Browser - OVO agent software compares the values
gathered for WebLogic Server performance and availability against the monitor template
settings related to those specific areas. The agent software then forwards appropriate
messages to the OVO console. These messages appear with color-coded severity levels in
the OVO message browser.
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Figurel OVO Message Browser

IXi Message Browser [opc_adm on wasspihl1.india.hp.com]

¢ Instruction Text - Messages generated by WLS SPI programs contain instruction text to
help analyze and solve problems. You can manually perform corrective actions
preassigned to events or they can be triggered automatically.

Instruction text is usually present in the message details. Instruction text is also
available in the HP OpenView Smart Plug-in for BEA WebLogic Server SPI Reference
Guide.

Figure 2 Sample Instruction Text

e ASCII-Text Reports - In addition to the instruction text, some messages cause
automatic action reports to be generated. These reports show conditions of a specific
WebLogic Server instance. If a report is available, you can find it within Annotations area
of the Message Details.

WLS SPI Concepts 13



Generating Reports Using HP OpenView Reporter

You can integrate WLS SPI with HP OpenView Reporter to provide you with
management-ready, Web-based reports. WLS SPI Report package includes the templates for

generating these reports. You can install the Report package on the Reporter Windows
system.

After you have installed the product and completed basic configuration, Reporter will
generate reports of summarized, consolidated data every night. With the help of these reports
you can assess the performance of the WebLogic Server is over a period of time.

Reporter uses WLS SPI data to generate reports that illustrate for example, servlet request
rates, transaction throughput rates, and average transaction execution time.

Figure 3 Reports generated by OV Reporter
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Graphing Data with OpenView Performance Manager

Metrics collected by WLS SPI can be graphed. The values can then be viewed for trend
analysis.

You can integrate WLS SPI with HP OpenView Performance Manager (OVPM) to generate
and view graphs. (use the View Graphs application from the WLSSPI Admin applications
group to view graphs). These graphs show the values of the metrics collected by the WLS SPI.
You can click Perform Action to view graphed data from almost all the WLS SPI alarm
messages. Perform Action is present in the message browser and in the message details (you
can access details by either double-clicking the message or clicking Details...in the message
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browser) in the message browser. The action launches your Web browser, where you can
choose a graph that shows values for the metric that generated the message as well as other
related metrics.

Figure 4 Sample Graph

MNetscape: WLSSPI Graphs

| Awrematically Refresh Refresh Graph New

Customizing Templates and Metrics

WLS SPI Concepts

You can use WLS SPI templates without customization, or you can modify them to suit the
needs of your environment. Some of the modifications and customizations that you can do are
listed below:

e Modify the default templates - Within a template, you can change the default settings for:

collection interval

threshold

message text

duration

severity level of the condition

actions assigned to the condition (operator-initiated or automatic)
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¢ C(Create custom template groups - You can create custom template groups using default
templates as base. For more information, see Chapter 4, Using and Customizing WLS
SPI.

¢ Create custom metrics - You can define your own metrics or User Defined Metrics (UDMs)
to expand the monitoring capabilities of WLS SPI. For more information about UDMs
refer to the HP OpenView Smart Plug-in User Defined Metrics User Guide.

Components of WLS SPI

WLS SPI has two main components:
e Applications (including reports)
e Templates

You can use the applications and templates to configure and receive data in the form of
messages, annotations, and metric reports. These messages (available in the message
browser), annotations (available through message properties) and metric reports (available
through applications or message details) provide information about the conditions present in
the servers running on specific managed nodes.

WLS SPI configuration applications let you configure the management server’s connection to
selected server instances on specific managed nodes. After you have configured the
connection, you can assign templates to the nodes. With OVO agent software running on the
managed nodes, you can use WLS SPI reporting applications to generate metric reports. In
addition, you can generate graphs that show WLS SPI data (available through message
properties).

Applications

WLS SPI applications include configuration, troubleshooting, and report-generating utilities.
In the Application Bank window, the WLS SPI applications are divided into three groups:

e  WLSSPI Admin
e  WebLogic
e  WLSSPI Reports

e JMX Metric Builder: This application group is available only if you install the
WASSPI-UDM-BUILDER software bundle.

WLSSPI Admin Applications Group

WLSSPI Admin applications allow you to configure, control, and troubleshoot WLS SPI. You
require root user permission to run WLSSPI Admin applications.
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WLS SPI Concepts

Figure 5 The WLSSPI Admin Application Group

1 Application Group: WLSSPI Admin

The group contains the following applications:

e Configure WLSSPI - Launches the configuration editor and maintains the WLS SPI
configuration.

e Discover WebLogic - Sets basic configuration properties needed for discovery.

e Init Non-Root - Simplifies the configuration of a non-root HTTPS agent on a UNIX
managed node (OVO 8.x only). For all the steps required to configure a non-root HTTPS
agent on a UNIX managed node see Configuring a Non-Root HTTPS Agent on a UNIX
Managed Node (OVO 8.x Only) on page 51.

e Self-Healing Info - Collects data that you can send to your HP support representative.

e Start Monitoring - Starts the collection of metrics for one application server or all
application servers on a managed node. Launch the Verify application to determine if
monitoring is started or stopped. By default, monitoring is on.

e Stop Monitoring - Stops the collection of metrics for one application server or all
application servers on a managed node.

e Start Tracing - Starts the collection of tracing information for selected metrics. Launch
this application only when instructed by your HP support representative.

e Stop Tracing - Stops the collection of tracing information for selected metrics.
e Verify - Verifies that the WLS SPI is properly installed on the server or managed node.
¢ View Error File - Allows you to view the contents of the WLS SPI error log file.

e View Graphs - Allows you to view WLS SPI graphs, generated by OVPM, in a web
browser (This requires additional setup. For more information see Task 1: Configure the
Management Server to Launch your Web Browser on page 36).

For more information about each of the above applications, see Appendix C, Applications.
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Weblogic Applications Group

You can manage WebLogic Server functions by using the applications in the WebLogic
Applications group.

To access the WebLogic applications double-click WLSSPI - WebLogic in the Application Bank
window.

Figure 6 The WebLogic Applications Group

i=i Application Group: WebLogic

View Application Timeout) Liew Deplowed Apps iew WebLoogic Log View Yeb Logic Sensers

The WebLogic group contains the following applications:

18

Check WebLogic - Does an interactive status check of the WebLogic Server.

Start WLS Console - Launches the WebLogic Server Admin console in your Web browser
(requires setup).

Start WebLogic - Allows you to start the WebLogic server from the OVO console
(requires setup).

Stop WebLogic - Allows you to stop the WebLogic server from the OVO console (requires
setup).

View Deployed Apps - Allows you to view the names and versions of all applications
that are deployed on a WebLogic Server instance.

View WebLogic Log - Allows you to view the WebLogic Server log files.

View WebLogic Servers - Allows you to view the WebLogic domain configuration,
cluster information, and physical machines.

View Application Activation Status - Allows you to view the activation status of the
applications running on a WebLogic Server.

View Application Timeout - Allows you to view the time left before retiring
applications running on a WebLogic Server will timeout.
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WLSSPI Reports Group

The WLSSPI Reports group contains reports that show information about WebLogic
conditions in the server.

You can generate a report about all WebLogic servers configured on a managed node by
dragging the node to a report in the Application Bank window. Each report shows the status of
all the configured WebLogic server instances on the managed node in relation to the metric for
which the report is generated.

Figure 7 Sample WLS SPI Application Bank Report

Exmcuted Applicstion

Application Ditpii

Application Bank Reports Generated from Alarms

An alarm condition can also generate a report. These reports are generated automatically and
are context sensitive, relating only to a single server on the managed node. These reports
appear within the Annotations section of a message.

If you configure the message browser to display the S column, a flag appears under the S
column (adjacent to the message) when a report is generated.

JMX Metric Builder Applications

The JMX Metric Builder Applications group contains the following applications:
¢ Deploy UDM - Deploys the UDM file.

e Gather MBean Data - Collects MBean information that is used with the JMX Metric
Builder.

e JMX Metric Builder - Launches the JMX Metric Builder application that is used to
create UDMs and browse MBeans.

e TUDM Graph Enable/Disable - Starts/stops data collection for UDM graphs. Also starts/
stops the OVO subagent.

For more information about the JMX Metric Builder Applications group and steps to install
the WASSPI-UDM-BIdr software bundle refer to HP OpenView Smart Plug-in User Defined
Metrics User Guide.
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WLS SPI Templates

WLS SPI templates are organized in groups and sub-groups.
Figure 8 WLS SPI Template Groups

The SPI for WebLogic Server template group contains the following template sub-groups and
individual templates:

20

WLSSPI-Logfiles - Contains templates that generate messages based on log file and
error text detected in both the WebLogic Server log files and WLS SPI log files. The
information captured from these log files includes errors that occur in the operation of the
WebLogic Server or WLS SPI and changes made to WebLogic Server configuration.

WLSSPI-Metrics - Contains metric templates that monitor the performance levels and
availability of a WebLogic Server.

Each metric template determines the threshold conditions for the monitored metric, the
message text that is sent to the OVO message browser when the threshold is exceeded,
the actions to execute, and instructions that appear.

WLSSPI-Schedule - Contains collector templates that specify the collection interval of
metric templates. Within the name of each collector template is its collection interval. For
example, the collection interval of template WLSSPI-1h is one hour (where 1h represents
one hour). Each collector template is assigned a collection interval of 5 minutes, 15
minutes, or one hour.

When you open a collector template, you can see the metrics collected within the interval
(listed by number, following the -m option of the collector/analyzer command
wasspi wls ca).

Each collector template controls which metrics are collected when. Specifically, the
collector template does the following:

— Runs the collector/analyzer at each collection interval
— Specifies which metrics are collected

WLSSPI-Messages - This is a single template. It intercepts WLS SPI messages for the
OVO message browser.

WLSSPI-Discovery - This is a single template. It updates the configuration on the OVO
management server and managed nodes.
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Figure 9 OVO Message Browser

Meccage Browser [opc_adm on who. rose. hp. com]

In the message browser shown above, the last three messages, generated by WLS SPI
templates, belong to the WebLogic and WLSSPI message groups (see the column titled
MsgGroup). The WebLogic messages indicate conditions occurring in WebLogic Server, while
the WLSSPI messages indicate conditions occurring in the WLS SPI.

WLS SPI Concepts 21



22

Chapter 1



2 Installing, Removing, and Upgrading WLS SPI

This chapter covers installing, removing, and upgrading the Smart Plug-in for BEA WebLogic
Server (WLS SPI) components.

The following topics are covered in this chapter:
e Installing WLS SPI

¢ Removing WLS SPI

e Upgrading WLS SPI

Installing WLS SPI

You must install the OpenView Operations (OVO) management server and discovery package
before installing WLS SPI. It is not necessary to stop OVO sessions before beginning the WLS
SPI installation.

The discovery package and WLS SPI are available on the HP OpenView Smart Plug-ins for
OVO/UNIX DVD.

) If you want to create UDMs, install the WASSPI-UDM-BIdr software bundle. For more
information about this software bundle refer to HP OpenView Smart Plug-in User Defined
Metrics User Guide.

For a complete list of software requirements, refer to the HP OpenView Smart Plug-in for BEA
WebLogic Server Release Notes.

) The instructions that follow show the command line usage of swinstall. For HP-UX systems,
you can also use the graphical user interface (GUI), but the GUI method is not covered in this
section.

For an HP-UX 11.0 management server, run the following command:
swinstall -s /cdrom/OV_DEPOT/11l.0HPUX.sdtape WLSSPI
For a Solaris management server, run the following command:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape WLSSPI
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WLS SPI Bundles and Filesets

The swinstall commands mentioned in the previous section install filesets for all managed
node platforms. If you have managed nodes running on only one platform, you may install the
filesets necessary only for that platform. Instead of specifying WLSSPI in the swinstall
command, you can specify one or more of the bundle names listed below:

Filesets Bundle Name Description

SPIWebLogicHPUX WLSSPI-CORE Filesets required for a managed node running
WLSSPI-HPUX on HP-UX.

SPIWebLogicLXx86 |WLSSPI-CORE Filesets required for a managed node running
WLSSPI-LXx86 on Linux.

SPIWebLogicSOL WLSSPI-CORE Filesets required for a managed node running
WLSSPI-SOL on Solaris.

SPIWebLogicNT WLSSPI-CORE Filesets required for a managed node running
WLSSPI-NT on Windows.

SPIWebLogicAll WLSSPI-CORE Filesets required for managed nodes running

WLSSPI-HPUX
WLSSPI-LXx86
WLSSPI-SOL
WLSSPI-NT

on HP-UX, Linux, Solaris, and Windows.

Removing WLS SPI

To completely remove all the WLS SPI components, perform these tasks:

e Task 1: Remove WLS SPI Software from the Management Server

e Task 2: Remove WLS SPI Software from the Node Group and Managed Nodes
e Task 3: Delete WLS SPI Templates and Template Groups

e Task 4: Delete WLS SPI application group

e Task 5: Delete the WLS SPI Message and Node groups
e Task 6: Remove the WLS SPI Directory

e Task 7: Remove the Report Package (Optional)

e Task 8: Remove the Graph Package (Optional)

Task 1: Remove WLS SPI Software from the Management Server

1  Open a terminal window and log on as root.
2 Run one of the following commands:
/usr/sbin/swremove WLSSPI
or

/usr/sbin/swremove SPIWebLogicAll
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The swremove command deletes the files from the file system only. The WLS SPI
templates are not deleted from the OVO data repository and must be deleted manually.
Remove the templates and the WLS SPI software from the managed nodes before deleting
the templates from the OVO data repository.

3 Run the command:

cd /opt/OV/wasspi/wls/bin
find . -name “wasspi_ wls*” -exec rm {} \;

This deletes all files that begin with wasspi wls in the directory
/opt/0OV/wasspi/wls/bin/

Task 2: Remove WLS SPI Software from the Node Group and Managed Nodes

To remove WLS SPI software from the node group and managed nodes follow these steps:
1 Open the Node Bank and from the Actions menu select Agents - Assign Templates.

2 Select the WebLogic node group and all managed nodes on which WebLogic templates are
deployed.

Click Remove nodes/groups.
4 Open the Node Group Bank and select the WebLogic node groups.

Select Install/lUpdate SW & Config from the Action menu and select the following check
boxes:

e Templates

e Actions

¢ Monitors

e Commands
6  Click Nodes in List.
7 Click Force Update.

8 Click OK to remove the templates, actions, commands and monitors from the managed
nodes. The following message appears in the message browser:

The following configuration information was successfully distributed:
Templates Actions Commands Monitors

Task 3: Delete WLS SPI Templates and Template Groups

Delete all the template sub-groups and templates from the SPI for WebLogic Server template
group. After deleting these templates and template sub-groups delete the SPI for WebLogic
Server template group. Follow these steps:

1 From the Windows menu, select Message Source Templates and double-click the SPI for
WebLogic Server template group.

2 Press Shift and select all the templates and template groups in the SPI for WebLogic
Server template group.

3 Click Delete From All...The following message appears:
Do you really want to delete the template(s)?
4 Click Yes.
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5
6

Delete the SPI for WebLogic Server template group.

Delete all the customized templates (default WLS SPI templates that you have modified)
residing in other OVO template groups.

Task 4: Delete WLS SPI application group

To delete the WLS SPI applications, follow these steps:

1
2

Open the Application Bank.

Right-click the WLSSPI application group and select Delete. The following message
appears:

Do you really want to delete the application group?

Click Yes.

Task 5: Delete the WLS SPI Message and Node groups

o 0 A W

From the Window menu, select Message Group Bank.

In the Message Group Bank window, right-click the WLSSPI group and select Delete. The
following message appears:

Do you really want to delete the message group?
Click Yes.

Repeat steps 2 and 3 for the WebLogic group.

From the Window menu, select Node Group Bank.

Right-click each WLS SPI and WebLogic Server group and select Delete. The following
message appears:

Do you really want to delete the node group?

Click Yes.

Task 6: Remove the WLS SPI Directory

Run the following command from the command prompt, to remove WLS SPI directory:

rm -rf /opt/OV/wasspi/wls

Task 7: Remove the Report Package (Optional)

If you have installed WLS SPI report package, to remove it (from the Windows system on
which OV Reporter is running) follow these steps:

1
2

Go to Settings — Control Panel > Add/Remove Programs.

Select the WLS SPI report package and click Remove.
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Task 8: Remove the Graph Package (Optional)

If you installed the WLS SPI graph packages (on the OVO management server and on your
system running OVPM), then to remove them follow these steps:

e  For the OVO management server, run the following command:
/usr/sbin/swremove WLSSPI-GRAPHS

e For a Windows system running OVPM, follow these steps:
a Go to Settings = Control Panel > Add/Remove Programs.

b  Select the WLS SPI graph package (HP OpenView SPI for WebLogic Server -
Graphing Component Integration) and click Remove.

e For a HP-UX system (not the OVO management server) running OVPM, follow these
steps:

) If OVPM is installed on the OVO management server, the files are removed in
Task 1: Remove WLS SPI Software from the Management Server.

a Run the following command to verify that the graph package is installed:
swlist | grep WLSSPI-GRAPHS
b Run swremove WLSSPI-GRAPHS, if the graph package is installed.

¢ On a Solaris system (not the OVO management server) running OVPM, follow these steps
the following:

) If OVPM is installed on the OVO management server, the files are removed in
Task 1: Remove WLS SPI Software from the Management Server.

a Run the following command to verify that the graph package is installed:
/usr/bin/pkginfo HPOvSpiWlsGc

b Run /usr/sbin/pkgrm HPOvSpiWlsGc, if the graph package is installed.

Upgrading WLS SPI

A The existing WLSSPI_RPT_METRICS datasource is automatically deleted when you
upgrade the SPI from version A.04.00.00 to 4.20. A new datasource is created and the
existing data is lost.

The datasource will be deleted irrespective of whether you are using CODA or HP OpenView
Performance Agent.

When you upgrade from a previous installation, all your configuration entries are preserved.
To upgrade WLS SPI, complete these tasks:

e Task 1: Remove WLS SPI Software from the Management Server

e Task 2: Delete WLS SPI Templates

e Task 3: Delete WLS SPI Applications

e Task 4: Upgrade the Management Server

Installing, Removing, and Upgrading WLS SPI 27



28

Task 5: Assign Operator Responsibilities for opc_adm

Task 6: Assign Templates

Task 7: Distribute Templates

Task 8: Customize Templates

Task 9: Move Nodes to New Node Group

Task 10: Delete Node Groups

Task 11: Distribute Actions, Monitors, Commands, and Templates
Task 12: Launch the Discover WebLogic Application

Task 13: Install the New Report Package (Optional)

Task 14: Install the New Graph Package (Optional)

Task 1: Remove WLS SPI Software from the Management Server

To remove WLS SPI software from the management server follow these steps:

1
2

Open a terminal window and log on as root.
Run the following commands:

/usr/sbin/swremove WLSSPI
/usr/sbin/swremove SPIWeblLogicAll
/usr/sbin/swremove WLSSP-GRAPHS

Run the following command to delete all the SPI files in the /opt/0V/wasspi/wls/bin/
directory

cd /opt/OV/wasspi/wls/bin
find . -name “wasspi_wls*” -exec rm {} \;

This deletes all files that begin with wasspi wls.

Task 2: Delete WLS SPI Templates

Delete all WLS SPI templates and template groups that appear under the SPI for WebLogic
Server template group and then delete the SPI for WebLogic Server template group. If you
have customized any of the default templates, note the changes because the customizations
are not saved. Then, do the following:

1

From the windows menu, select Message Source Templates and select the SPI for WebLogic
Server template group.

Double-click the WebLogic group (WebLogic 9.x, 8.1, 7.0, 6.1, 6.0, and/or 5.1). Open the
template groups till the lowest level displaying the individual templates.

Press Shift and select all the templates.

Click Delete From All... The following message appears:
Do you really want to delete the template(s)?
Click Yes.

Go up a level and open the next group. Repeat steps 2-5 till you delete all WLS SPI
individual and group templates in the Message Source Template window.
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Task 3: Delete WLS SPI Applications

To delete WLS SPI applications, follow these steps:

1
2

Open the Application Bank.

Right-click the WLSSPI application group and select Delete. The following message
appears:

Do you really want to delete the application group?

Click Yes.

Task 4: Upgrade the Management Server

The WLS SPI software is available on the HP OpenView Smart Plug-ins for OVO/UNIX DVD.

) The instructions that follow show the command line usage of swinstall. For HP-UX systems,
you can also use the graphical user interface (GUI), but the GUI method is not covered.

For an HP-UX 11.0 management server, run the following command:

swinstall -s /cdrom/OV_DEPOT/11l.0HPUX.sdtape WLSSPI

For a Solaris management server, run the following command:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape WLSSPI

Task 5: Assign Operator Responsibilities for opc_adm

To assign operator responsibility for opc_adm, follow these steps:

1

o A WN

Log on to OVO as administrator (opc_adm).

Open the User Bank window, right-click the opc_adm user, and select Modify.

In the Modify User:opc_adm user window, click Responsibilities.

For WLSSPI and WebLogic Message Groups, ensure that all check boxes are selected.
Assign the WLSSPI Node or Message Groups to some other appropriate operators.
Click Close.

Task 6: Assign Templates

To assign the WLSSPI-Discovery and WLSSPI-Messages templates to the management
server follow these steps:

1
2

o U A W

Open the Node Bank window and select the management server.

From the Actions menu, select Agents - Assign Templates. The Define Configuration
window opens.

Click Add. The Add Configuration window opens.
Click Open Template Window. The Message Source Templates window opens.
In the Template Groups pane, select the SPI for WebLogic Server template group.

From the Message Source Templates window, in the right pane, select the
WLSSPI-Discovery template group and WLSSPI-Messages template.
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7 From the Add Configuration window, click Get Template Selections. The WLSSPI-Messages
and WLSSPI-WebLogic-Discovery templates appear in the right pane.

8 From the Add Configuration window, click OK.

Task 7: Distribute Templates

To distribute the WLSSPI-Discovery and WLSSPI-Messages templates to the management
server, follow these steps:

1 Open the Node Bank window and select the management server.

From the Actions menu, select Agents - Install/Update SW & Config.

In the Target Nodes section, select Nodes in List Requiring Update.

In the Install/Update Software and Configuration window, select the Templates check box.
Select Force Update.

Click OK.

o O A WN

The following message appears in the message browser:

The following configuration information was successfully distributed:
Templates

Task 8: Customize Templates

>»

To customize the templates, follow these steps:
1 Copy the default templates.

2 Apply the customizations made to the previous version of templates to the copy of the
current version.

In this version of the WLS SPI, the templates are no longer grouped by WebLogic version
numbers.

Task 9: Move Nodes to New Node Group

Move all managed nodes (running supported versions of the WebLogic Server) in the SPI for
WebLogic Server node groups to the new WebLogic node group. Managed nodes running
supported versions of the WebLogic Server are in the following node groups: WebLogic 9.x,
WebLogic 8.1, WebLogic 7.0, and WebLogic 6.1. To move the nodes, do the following:

1 Open the Node Bank and select SPI for WebLogic Server node group.

2 Double-click WebLogic 9.x node group and note the managed nodes in it. Repeat this step
for the WebLogic 7.0 and WebLogic 6.1 node groups.

3  Go back to the top level of the node bank (where the WebLogic node group is displayed).

4  Drag and drop or copy and paste the nodes (noted in step 2) from the IP submap to the
WebLogic node group.
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Task 10: Delete Node Groups

Delete all versioned node groups that are in the SPI for WebLogic Server node group. This
may include: WebLogic 9.x, WebLogic 8.1, WebLogic 7.0, WebLogic 6.1, WebLogic 6.0, and
WebLogic 5.1. To delete the versioned node groups, do the following:

1
2

Task 1

Open the Node Bank and select SPI for WebLogic Server node group.

Select a versioned WebLogic node group and from the Edit menu, select Delete. The
following message appears:

Do you really want to delete the node group?
Click Yes.
Repeat steps 2 and 3 till you delete all versioned WebLogic node groups.

: Distribute Actions, Monitors, Commands, and Templates

To distribute actions, monitors, commands, and templates, follow these steps:

1

From the Node Bank window, select the nodes or node groups on which you want to install
WLS SPL

From the Actions menu select Agents — Install/Update SW & Config.

In the Install/Update OVO Software and Configuration window, select the following
component check boxes:

e Templates

e Actions

¢ Monitors

e Commands

Using this dialog, deploy updated components on the managed nodes.
Select the Force Update check box.

Select the Nodes in list button. Upon completion, the following message appears in the
message browser for each managed node:

The following configuration information was successfully distributed:
Actions Commands Monitors Templates.

) You may see some WLS SPI errors in the message browser. These errors are the result of the
transition to the updated programs and you can ignore them. WLS SPI templates and
programs are updated on the Management Server and selected managed nodes. These errors
are resolved when the upgrade is complete.
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Task 12: Launch the Discover Weblogic Application

You must launch the Discover WebLogic application. Re-entering any of the WLS SPI
configuration data is not required because all configuration data is saved. To re-deploy the
file, you can drag and drop multiple nodes, node groups, or single nodes. When you re-deploy
the file, relevant information is updated, transmitted, and stored on the node. To launch the
Discover WebLogic application, follow these steps:

1
2
3

From the OVO console, select the node in the Node Bank window.
From the Window menu, select Application Bank.

In the Application Bank window, select WLSSPI - WLSSPI Admin — Discover. (If the above
does not appear as described, select Map - Reload). The Introduction window opens.

Click Next. A second Introduction window opens. Information about the properties
required for the discovery process to work are given in this window

Read this information and click Next. The configuration editor opens.

Make the necessary changes using the configuration editor.

’ When setting the configuration using configuration editor, note the following
points:

e GRAPH_SERVER property is no longer supported in WLS SPI. Instead, set the
GRAPH_URL property.

¢ Note the locations of the UDM files on your managed nodes and delete any
occurrence of the UDM_DEFINITIONS_FILE property from your
configuration.

¢ Do not configure UDMs individually on your managed nodes, instead configure
these UDMs on the management server in the

/opt/0V/wasspi/wls/conf/wasspi wls udmDefnintions.xml file (or,
set the UDM_DEFINITIONS_SOURCE property to use another file).

e After you consolidate the UDMs on the management server, delete the old

UDM files from the managed nodes and distribute the new UDM file to the
managed nodes using the Deploy UDM application.

Click Next to save any changes and exit the editor. The Confirm Operation window opens.
Click OK.

If you click Cancel, all the changes made to the configuration will remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, launch the
Discovery application, click Next in the configuration editor, and then click OK in the
Confirm Operation window.

) Do not close the Discover application window till the discovery process is complete. The
discovery process may take several minutes to complete.
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Task 13: Install the New Report Package (Optional)

Remove older versions of WLS SPI report package from your Windows system running OV
Reporter and install the new WLS SPI report package. To install the new report package
follow these steps:

1 On the Windows system running OV Reporter, go to Settings - Control Panel -
Add/Remove Programs.

2 Select the WLS SPI report package and click Remove.

3 To install the WLS SPI report package, follow the steps given in section Integrating with
HP OpenView Reporter on page 84.

Task 14: Install the New Graph Package (Optional)

e If OVPM is running on a Windows system, remove older versions of WLS SPI graph
package and install the new WLS SPI graph package. To install the new graph package
follow these steps:

a Go to Settings = Control Panel > Add/Remove Programs.

b  Select the WLS SPI graph package (HP OpenView SPI for WebLogic Server -
Graphing Component Integration) and click Remove.

¢ Toinstall the WLS SPI graph package, follow the steps given in section Integrating
with HP OpenView Performance Manager on page 89.

e If OVPM is running on a HP-UX system (not the OVO management server), follow these
steps:

’ If OVPM is installed on the OVO management server, the files are automatically
updated when you install the SPI software.

a Run swlist | grep WLSSPI-GRAPHS to verify that the graph package is installed.
b Run swremove WLSSPI-GRAPHS if the graph package is installed.

¢ Toinstall the WLS SPI graph package follow the steps given in section Integrating
with HP OpenView Performance Manager on page 89.

e If OVPM is running on a Solaris system (not the OVO management server), follow these
steps:

’ If OVPM is installed on the OVO management server, the files are automatically
updated when you install the SPI software.

a Run /usr/bin/pkginfo HPOvSpiWlsGc to verify that the graph package is
installed.

b Run /usr/sbin/pkgrm HPOvSpiWlsGc, if the graph package is installed.

¢ Toinstall the WLS SPI graph package follow the steps given in section Integrating
with HP OpenView Performance Manager on page 89.
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3 Configuring WLS SPI

Introduction

This chapter covers configuring the Smart Plug-in for BEA WebLogic Server (WLS SPI) for
use with OpenView Operations (OVO).

The following topics are covered in this chapter:

Configuration Prerequisites

WLS SPI Configuration (Managed Nodes)

WLS SPI Configuration (from the Management Server)
Additional WLS SPI Configuration

WLS SPI in High Availability Environments

Additional Discovery and Configuration Scenarios

To configure WLS SPI, you must complete all configuration prerequisites, complete WLS SPI
configuration on managed nodes and the management server, and complete additional
configuration based on your environment.

Configuration Prerequisites

You must complete the following tasks before configuring WLS SPI:

Task 1: Configure the Management Server to Launch your Web Browser
Task 2: Assign Operator Responsibilities for opc_adm

Task 3: Assign Templates

Task 4: Deploy Templates

Task 5: Update the remactconf.xml File (OVO 8.x Only)
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Task 1: Configure the Management Server to Launch your Web Browser

WLS SPI uses the ovweb utility to launch the WebLogic administration console in your web
browser and for displaying graphs generated by OpenView Performance Manager (OVPM).
Skip this task if you do not want to start the WebLogic administration console from the OVO
console and do not use OVPM.

1 Enter the browser invocation command in the ovweb. conf file. If no browser invocation
command is included in the ovweb. conf file, ovweb tries to start Netscape Navigator
version 6.0 or higher.

’ The ovweb. conf file must be located in the directory specified by the
environment variable $OvV_CONF (used by OVO). To see the OVO directory
structure on your management server, open /opt/0OV/bin/ov.envvars.sh file
and search for the definition of $OV_CONE.

The browser invocation command must contain%s to allow WLS SPI to pass a URL to the
browser. Open the file and insert the command according to the entry syntax and example
as follows:

Syntax: Browser: <browser command>%s
Example: Browser: /opt/netscape/netscape%s

2 To display the WLS SPI graphs, ensure that your browser is Java Script enabled. Check
the setting within the browser’s Preferences.

3 When running the Discover WebLogic application to configure WLS SPI from the
management server (see Task 3: Launch Discover WebLogic on page 44), set the following
conditional properties:

e Set the ADMIN_HOST and ADMIN_PORTS properties, to start the WebLogic console
from the OVO console.

e Set the GRAPH_URL property, if you are using OVPM.

For more information about launching a browser in OpenView Operations, refer to the man
pages for ovweb, ovweb.conf, and ov.envvars.

Run the following command at the command prompt to access instructions for enabling
graphs:

man ovweb

Task 2: Assign Operator Responsibilities for opc_adm

To assign Operator Responsibilities for opc_adm, follow these steps:
1 Log on to OVO as the administrator (opc_adm).

2 Open the User Bank window, right-click the opc_adm user, and select Modify. The Modify
User:opc_adm user window opens.

3 Click Responsibilities. Ensure that all check boxes are selected for WLSSPI and WebLogic
Message Groups.
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il Responsibilities for Operator [opc_adm]

4  Follow steps 2-4 to assign the WLSSPI Node or Message Groups to another appropriate
operators.

5 Click Close.

Task 3: Assign Templates

To assign the WLSSPI-Discovery and WLSSPI-Messages templates to the management
server, follow these steps:

1 Open the Node Bank window and select the management server.

2 From the Actions menu, select Agents > Assign Templates. The Define Configuration
window opens.

il Define Configuration o ||
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3 Select a Node/Group and click Add. The Add Configuration window opens.

4 Click Open Template Window. The Message Source Templates window opens.

iXi Message Source Templates 1 [opc_adm]

5 Select SPI for WebLogic Server template group from the Template Groups pane. A list of
WLS SPI template sub-groups and templates appears on the right pane.

6  Select WLSSPI-Discovery (from the WLSSI-Schedule group) and WLSSPI-Messages
templates from the right pane.
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7 In the Add Configuration window, click Get Template Selections. The WLSSPI-Discovery
and WLSSPI-Messages templates appear in the right pane.

i1 Add Configuration 10l =|

8 Click OK.

Task 4: Deploy Templates

To deploy the WLSSPI-Discovery and WLSSPI-Messages templates on the management
server, follow these steps:

1 Open the Node Bank window and select the management server.

2 Select Actions - Agents — Install/Update SW & Config... The Install/Update OVO Software
and Configuration window opens.

3 In the Target Nodes pane, select Nodes in list requiring update.
4  Select the Templates check box and click Force Update.
5 Click OK.

The following message appears in the message browser:

The following configuration information was successfully distributed:
Templates

Task 5: Update the remactconf.xml File (OVO 8.x Only)

If you are running DCE-based agents on your managed nodes, the discovery process must run
automatic actions on the management server. To update the remactconf.xml file, follow
these steps:

1 Merge (if you have updated this file) or replace the
/etc/opt/0OV/share/conf/OpC/mgmt sv/remactconf.xml file with
/opt/0OV/wasspi/wls/OV/remactconf.xml file.

2 Run the following command to restart the OVO management server:
opcsv -start

If you modify the remactconf.xml file, you must restart the management server.

) If you do not update the remactconf . xml file, the discovery process fails.
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WLS SPI Configuration (Managed Nodes)

To configure WLS SPI, complete the following tasks (for each managed node):
e Task 1: Verify the Application Server Status
e Task 2: Configure a WebLogic Server User

Task 1: Verify the Application Server Status

Check the status of WebLogic servers in the WebLogic administration console to verify if the
application servers are running.

Figure 10 WebLogic Admin Server console
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Task 2: Configure a Weblogic Server User

Collect the WebLogic login and password for each WebLogic Administration Server. Or, if you
do not want to use the existing login and password, create new login and password. WLS SPI

discovery process uses the login and password to gather basic configuration information and
WLS SPI data collector uses the login and password to collect metrics.

" To simplify WLS SPI configuration keep the login and password for both WebLogic servers
and WebLogic Administration Servers similar.

Weblogic Server Version 6.1

On WebLogic Server version 6.1, you can log on as system— the default administration user.
To configure a different user, follow these steps:

1 In the WebLogic administration console, create a new user and password for WLS SPI.
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2 Create an ACL weblogic.admin.mbean, if it does not already exist.
3 Create ‘access’ permission for the newly created ACL.

4 Add the user (created in step 1) to the list of users for the ‘access’ permission.

Weblogic Server Version 7.0 or Later

On WebLogic Server version 7.0 or later, you can log on as the administration user configured
during installation of WebLogic Server. Or, you can log on as a user that belongs to the
WebLogic Administrators or Monitors group.

To configure a user belonging to Administrators or Monitors group, you must use the
WebLogic administration console. For more information about creating a user and assigning a
user to a group, refer to the Securing WebLogic Resources manual, Users and Groups section.
(http://e-docs.bea.com/wls/docs70/secwlres/usrs_grps.html or http:/e-docs.bea.com/
wls/docs81/secwlres/usrs_grps.html).

) A user that belongs to the Monitors group cannot use the Start WebLogic or Stop WebLogic
application to start or stop WebLogic Servers from the OVO console. This user can also not
perform the JMX call ‘set’ when implementing JMX actions to assign a value to a specified
attribute if you are creating UDMs. For more information about JMX Actions refer to
Appendix E in the HP OpenView Smart Plug-in User Defined Metrics for UNIX User Guide.
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WLS SPI Configuration (from the Management Server)

To configure WLS SPI, complete the following tasks (from the management server):
e Task 1: Assign WLSSPI-Messages Template

e Task 2: Distribute Templates, Actions, Monitors, Commands

e Task 3: Launch Discover WebLogic

e Task 4: Set Additional Properties

e Task 5: Verify the Discovery Process

e Task 6: Add Nodes to the WebLogic Node Group

e Task 7: Deploy WLS SPI Templates

e Task 8: Completing Configuration

e Task 9: Verify WLS SPI Configuration

Task 1: Assign WLSSPI-Messages Template

To assign the WLSSPI-Messages template to the managed nodes, follow these steps:

1 Open the Node Bank window and select the managed nodes.

2 From the Actions menu, select Agents — Assign Templates. The Define Configuration

window opens.

ixi Define Configuration I m]
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3 Click Add. The Add Configuration window opens.

4 Click Open Template Window. The Message Source Templates window opens.

iXi Message Source Templates 1 [opc_adm]

5 In the Template Groups pane, select the SPI for WebLogic Server template group and in the
right pane, select the WLSSPI-Messages template.

6 In the Add Configuration window, click Get Template Selections. The WLSSPI-Messages
template appears in the right pane.

7  Click OK.

Task 2: Distribute Templates, Actions, Monitors, Commands

To distribute templates, actions, monitors, and commands do the following:
1 Select the nodes on which you want to install WLS SPI.

2  Open the Node Bank window and select Actions = Agents — Install/Update SW & Config....
The Install/Update OVO Software and Configuration window opens.

3  Select the following component check boxes:

e Templates
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%l Install / Update D¥D Software and Configuration

e Actions
e  Monitors

e Commands

Select the Force Update check box.
Select the Nodes in list radio button.

After WLS SPI is installed on the selected managed nodes, the following message appears
in the message browser for each managed node:

The following configuration information was successfully distributed:
Templates Actions Commands Monitors

Task 3: Launch Discover Weblogic

>»

Launch the Discovery application on one managed node at a time. To launch the Discover
WebLogic application, follow these steps:

If an instance of WebLogic Server has a server login name and password different from the
default login and password, then before launching the discovery tool you must explicitly
configure the login details for that server using the configuration editor.

1
2

At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

From the Window menu, select Application Bank. The OVO Application Bank opens in a
new window.

Double-click WLSSPI. The Application Group: WLS SPI window opens.

Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All
the WLSSPI Admin applications appear in this window.

Select a node from the OVO Node Bank window and double-click Discover WebLogic (If the
above does not appear as described, select Map = Reload.) The Introduction window opens.
This window contains brief information about the Discovery application.
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7

Click Next. A second Introduction window opens. This window displays information about
which properties may be required in order for the discovery process to work.

Click Next. If you have already set the LOGIN and PASSWORD properties, the
configuration editor opens. To set additional properties, see Task 4: Set Additional
Properties on page 46.

If you have not set the LOGIN and PASSWORD properties, the Set Access Info for Default
Properties window opens.

i WLSSPI Discover Tool: Set Access Info for, Default Pro... E]|§|E]

Flease enter the Lagin and Password infarmation.
This information is required by the SPI{0 access 3 secured

application server's enviranment.

Login |

Password ‘

watify Passward ‘

Customize Mext | Cancel |

8

Set the same LOGIN and PASSWORD properties as configured in the WebLogic login and
password in Task 2: Configure a WebLogic Server User on page 40. You must set the
LOGIN and PASSWORD properties even if you are using the default login/password
(WebLogic version 6.1) or the login/password configured during the WebLogic Server
installation (WebLogic version 7.0 or higher).

) The LOGIN and PASSWORD properties set in this window are used as the default
WebLogic login and password (they are set at the global properties level). That is,
if no NODE level or server-specific LOGIN and PASSWORD properties are set,
this WebLogic login and password are used by WLS SPI to access all WebLogic
Administration Servers. For more information about the configuration structure,
see Structure on page 157.

Setting LOGIN and PASSWORD for different setups

You can set the LOGIN and PASSWORD for different setups in the following ways:

Configuring WIS SPI

If the WebLogic Administration Server login and password are the same for all instances
of WebLogic on all OVO managed nodes, do the following:

a Set the LOGIN and PASSWORD properties in the Set Access Info for Default
Properties window.

b  Set the additional properties required by the discovery process. See Task 4: Set
Additional Properties on page 46.

If the WebLogic Administration Server login and password are different for each managed
node but are similar for all instances of the WebLogic Administration Server on the
managed nodes, do the following:

a Customize the WLS SPI configuration by setting the LOGIN and PASSWORD
properties at the NODE level (for more information about the configuration structure,
see Structure on page 157)
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b In the Set Access Info for Default Properties window, set the most commonly used
WebLogic login and password as LOGIN and PASSWORD properties.

¢ Click Customize. The configuration editor opens. Set the LOGIN and PASSWORD
properties at the NODE level. For more information about using the configuration
editor, see Appendix B, The Configuration.

d Set the additional properties required by the discovery process. See Task 4: Set
Additional Properties on page 46.

If the WebLogic Administration Server login and password are different for each managed
node and they are also different for the instances of the WebLogic Administration Server
on a managed node, do the following:

a Customize the WLS SPI configuration by setting the LOGIN, PASSWORD, NAME,
and PORT properties at the server-specific level (for more information about the
configuration structure, see Appendix B, The Configuration).

b In the Set Access Info for Default Properties window, set the most commonly used
WebLogic login and password as LOGIN and PASSWORD properties.

¢ Click Customize. The configuration editor opens. Set the LOGIN, PASSWORD, NAME,
and PORT properties at the server-specific level. For more information about using
the configuration editor, see Appendix B, The Configuration.

d Set the additional properties required by the discovery process. See Task 4: Set
Additional Properties.

Task 4: Set Additional Properties

The LOGIN and PASSWORD properties are the basic properties needed by the discovery
process. However, depending on your environment, you may need to provide additional
configuration information.

You can set the following properties (for more information about these properties, see
Configuration Properties on page 168):

ADDRESS - ADDRESS is the domain name or IP address where the WebLogic Server is
listening. You must set this property if the WebLogic Server is configured to a virtual IP
address.

ADMIN_PORTS - ADMIN_PORTS is a list of the port numbers of the WebLogic Admin
servers. You must set this property if the domain configuration file (config.xml) is not
located in the following default directories:

— <WebLogic_Install_Dir>/config/<WebLogic_Domain>/ (WebLogic 6.1)

— <BEA_Home_DIR>/user projects/<WebLogic_Domain>/ (WebLogic 7.0 or
WebLogic 7.0 SP1)

— <BEA_Home_DIR>/user projects/domains/<WebLogic_Domain>/
(WebLogic 7.0 SP2 or higher)

where <WebLogic_Install_Dir> is the directory where the WebLogic Server is installed,
<BEA_Home_Dir> is the directory that contains the registry.xml file, and
<WebLogic_Domain> is the WebLogic domain name.

HOME_LIST - HOME_LIST is a list of directories where the WebLogic Server is installed.
You must set this property if the BEA registry.xml file is not accurate or cannot be
found (You can face this problem if you do not use BEA’s installation scripts to install the
WebLogic Server software and Service Packs).
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JAVA_HOME - JAVA_HOME is the default directory where Java is installed. You must
set this property if Java is installed on more than one directory or if you are using your
own Java.

’ When you launch the Discover WebLogic tool JAVA_HOME takes the default
value. If you have specified a different value for JAVA_HOME for any instance of
WebLogic server, then you must explicitly set that value for JAVA_HOME using
the configuration editor. For more information about the JAVA_ HOME property,
see Configuration Properties on page 168.

NODE_NAMES - You must set this property if a remote WebLogic Server is listening on a
virtual IP address. If you do not set this property, the WebLogic Server is not discovered.

EXCLUDE_SAMPLES - You can set this property to ‘true’, at the default properties level,
to exclude the WebLogic Server sample programs from the discovery process. This will
reduce the amount of time it takes for the discovery process to run.

PROTOCOL - You can set this property to specify if the application server port is using
SSL or non-SSL. You must set this property if you are using SSL on the application server
port. Valid values for this property are t3 (non-SSL) and t3s (SSL). For more information,
see Table 1 on page 50.

Setting Additional Properties

To set additional properties, follow these steps:

1

2
3

In the configuration editor, set the properties. For information about setting properties
using the configuration editor, see Appendix B, The Configuration.

Click Next to save changes and exit the editor. The Confirm Operation window opens.

Verify the nodes on which the operation is to be performed and click OK.

) Wait for the discovery process to complete before going to the next task. The discovery process
may take several minutes to complete.

Task 5: Verify the Discovery Process

Depending on the number of managed nodes in your environment, verification may take
several minutes to complete.

1
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Verify that the following messages appear in the Discover WebLogic application window
(the Discover WebLogic application has completed successfully):

Discovery started on node: <node>
Finished running the Discovery application

If the discovery is not successful, the following message appears in the application
window:

Failed to run discovery on node <node>

For information on troubleshooting the discovery process see Troubleshooting the
Discovery Process on page 108.

Verify that the following message appears in the message browser for each managed node:

WASSPI-602 - Updating the WLSSPI configuration data with discovered
information
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Depending on the number of managed nodes in your environment, it may take several
minutes for these messages to display for all managed nodes.

3 If Service Navigator is running, select File > Reload Configurations.

In the Service Map, open the Application node and look for the WebLogic service.
) You can view the Service Map using the Java GUI.

Figure 11 shows a snapshot of the Service Map as it appears after successful discovery.
Using the Service Map, you can find out the application that has a problem (if any). The
lines in the Service Map are color coded to show various levels of severity. For example,
red lines show that the application has critical problems.

Figure 11 Service Map
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4  Launch the Configure WLSSPI application to verify the properties set by the discovery
process. For more information about the configuration editor, see Configure WLSSPI on
page 186.

Task 6: Add Nodes to the Weblogic Node Group

WLS SPI automatically creates the WebLogic node group with preassigned template groups.
To place all nodes running WebLogic Server in this node group, follow these steps:

1 From the OVO console, open the Node Group Bank and the Node Bank window to view
the WebLogic node group and the managed nodes side-by-side.

2 Drag and drop managed nodes on which WebLogic Server is running into the WebLogic
node group.

48 Chapter 3



Task 7: Deploy WLS SPI Templates

To deploy the templates on the managed nodes:
1 Open the Node Group Bank window and select the WebLogic node group.

2 Select Actions - Agents — Install/Update SW & Config. The Install/Update OVO Software
and Configuration window opens.

In the Target Nodes section, select the Nodes in List Requiring Update radio button.
4  Select the Templates and Force Update check boxes.

Click OK.

The following message must appear in the message browser:

The following configuration information was successfully distributed:
Templates

After the templates are deployed, the monitors can now begin running according to their
specific collection interval.

) For information on integrating WLS-SPI with Reporter for generating WebLogic Server
reports that show consolidated information, see Chapter 5, Integrating HP OpenView
Reporting and Graphing Products with WLS SPI.

Task 8: Completing Configuration

To complete the configuration update the configuration information on the management
server and managed nodes, do one of the following:

e  Wait for the automatic configuration template to run (it may take 10 minutes).

e Launch the Configure WLSSPI application (this application updates the configuration
information on the management server and managed nodes). For more information about
Configure WLSSPI application see Configure WLSSPI on page 186.

Task 9: Verify WLS SPI Configuration

Launch the Verify application to verify that WLS SPI is properly installed and configure. For
more information about the Verify application, see Verify on page 193.

1 Open the Node Group Bank window and select the WebLogic node group.
2 Open the Application Bank window.
3  Select WLSSPI - WLSSPI Admin and double-click Verify.

Configuring WIS SPI 49



50

Additional WLS SPI Configuration

Based on your WebLogic Server configuration and application needs, you must finish WLS
SPI configuration by setting additional configuration properties and installing and

configuring additional components.

Conditional Properties

You may have to set one or more of the following conditional properties (these properties are
not automatically discovered by the discovery process). For more information about the

properties, see Configuration Properties on page 168.

Table 1 Conditional Properties
Condition Property to Set
Running WebLogic Server version 7.x, 8.1 or 9.x. VERSION
WebLogic Servers on a system share the same name. The discovery ALIAS
process automatically sets the ALIAS property, but you may want to edit
this value as this is the name used in messages, reports, and graphs.
Start or stop a WebLogic Server using the Start WebLogic or Stop START_CMD,

WebLogic application from the OVO console.

STOP_CMD, and
USER

Start the WebLogic administration console using the Start WLS Console
application from the OVO console.

ADMIN_HOST and
ADMIN_PORTS

Utilize MBean information in the JMX Metric Builder application to
create UDMs.

COLLECT_META
DATA

Use the View Graphs application from the OVO console (OVPM must be| GRAPH_URL
installed).

A WebLogic Server is configured to a virtual IP address, is on a remote | ADDRESS
node, or is not using the primary IP address of that node.

The log file’s absolute pathname is not configured in WebLogic. LOGFILE
Absolute log file names are not configured in WebLogic Server version | LAUNCH_DIR

6.1 or the WebLogic Server’s installation and starting directories are in
different locations.

Setting Conditional Properties

1 In the OVO console, open the Node Bank window and select the node.

2 From the Window menu, select Application Bank. The Application Bank window opens.

3 Select WLSSPI - WLSSPI Admin - Configure WLSSPI. (If it does not appear as described,
select Map > Reload.) The Introduction window opens. This window contains basic

information about the Discovery application.

4 Click Next. A second Introduction window opens. This window contains information about

the properties required for the discovery process to work.

5 Click Next. The configuration editor opens.
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Set the properties using the configuration editor. For more information about using the
configuration editor see Appendix B, The Configuration.

Click Next. The Confirm Operation window opens.

Click OK to save the configuration changes on the selected managed nodes.

Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO 8.x

Only)

To run a non-root HTTPS agent on a UNIX managed node (OVO 8.x only), follow these steps:

) You must install the OS-dependent Sudo software package on the UNIX managed node. Sudo
is free software available from http:/www.sudo.ws. The OS-dependent software packages
are located at the bottom of the download page (http:/www.sudo.ws/sudo/
download.html). Refer to the release notes for more information about Sudo installation.

1
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Switch the HTTPS agent to a non-root user. For more information, refer to the HP
OpenView Operations HT'TPS Agent Concepts and Configuration Guide for the HP-UX
and Sun Solaris Management Server Operating Systems.

On the managed node, set the OV_SUDO variable and log on as root or OVO agent
user. Do the following:

a Run the following command to stop all OVO agents:
opcagt -kill

b  Run the following command to set the OV_SUDO variable:
ovconfchg -ns ctrl.sudo -set OV_SUDO <sudo_program>

where <sudo_program> is the location (including the absolute pathname) where sudo
is installed (for example, /usr/local/bin/sudo).

¢ Run the following command to start the OVO agents:
opcagt -start

d Run the following command to verify that OV_SUDO is set:
ovdeploy -cmd set | grep SUDO
The following line appears:
OV_SUDO=<sudo_program>

Configure the managed node. These steps must be completed to successfully run the SPI
in a non-root HTTPS agent environment.

a From the OVO management server, deploy actions, commands, and monitors to the
managed node.

b Select the node in the Node Bank window.

¢ From the Application Bank window, select WLSSPI - WLSSPI Admin —> Init Non-Root.
Edit the /etc/sudoers file using the visudo editor (installed with Sudo):

a On the managed node, log on as root.

b Open the /<SPI_Config_DIR>/wasspi wls_ sudoers file

where <SPI_Config_DIR> is the location of the SPI's configuration files on a managed
node. For more information see Managed Node File Locations on page 155.
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Run the visudo command in a seperate window (for example, type:
/usr/local/sbin/visudo).

Copy the following lines from the wasspi wls sudoers file and append the lines to
the sudoers file:

Cmnd Alias WLSSPI ADMN = /opt/OV/nonOV/perl/a/bin/perl -S
wasspi wls admin *

Cmnd Alias WLSSPI COLL = /opt/OV/nonOV/perl/a/bin/perl -S wasspi wls ca
*

Cmnd Alias WLSSPI DISC = /opt/OV/nonOV/perl/a/bin/perl
wasspi wls discovery.pl

Cmnd Alias WLSSPI LFEN = /opt/OV/nonOV/perl/a/bin/perl -S wasspi wls le
*

Cmnd Alias WLSSPI_SHSC = /opt/OV/nonOV/perl/a/bin/perl -S

shs collector.pl *

Cmnd Alias WLSSPI ADMNP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi wls admin *

Cmnd Alias WLSSPI COLLP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi wls ca *

Cmnd Alias WLSSPI DISCP = /opt/OV/nonOV/perl/a/bin/perl \
/var/opt/OV/bin/instrumentation/wasspi wls discovery.pl

Cmnd Alias WLSSPI LFENP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi wls le *

Cmnd Alias WLSSPI SHSCP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/shs collector.pl *

<OV_Agent username> <nodename> = NOPASSWD: WLSSPI ADMN, WLSSPI COLL, \
WLSSPI DISC, WLSSPI LFEN, WLSSPI SHSC, WLSSPI ADMNP, WLSSPI COLLP, \
WLSSPI DISCP, WLSSPI LFENP, WLSSPI SHSCP

where <OV_Agent username>is the OVO agent user account and
<nodename> is the name of the managed node.

Type wq to save the file and exit the visudo editor.

Repeat steps 3 and 4 every time the agent user is switched.
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WLS SPI in High Availability Environments

High availability is a general term used to characterize environments that are business
critical and therefore are protected against downtime through redundant resources. Very
often, cluster systems are used to reach high availability.

You can configure WLS SPI to accommodate cluster environments where failovers allow
uninterrupted WLS availability. WLS SPI monitoring, when synchronized with the cluster
environment, can switch off from the failed node to the active node.

Configuration Prerequisites

The prerequisites for using WLS SPI in high availability environments are:

e Management Server: HP-UX

e Node: HP-UX MCSG cluster

e (OVO 8.x HTTPS Agent version (for details, refer to the Agent cluster support matrix)

Configuring WLS SPI for High Availability Environments

To configure WLS SPI for use in high availability environments complete the following tasks:
e Task 1: Create the WLS SPI monitoring configuration file
e Task 2: Create the clustered application configuration file

e Task 3: Configure WLS SPI

Task 1: Create the WLS SPI monitoring configuration file
WLS SPI uses a monitoring configuration file <appl name>.apm.xml that works in
conjunction with the clustered application configuration file.

’ <appl_name> is the namespace_name. For more information, refer to HP OpenView
Operations for UNIX HTTPS Agent Concepts and Configuration Guide.

The <appl name>.apm.xml file lists all the WLS SPI templates on the managed node so
that you can disable or enable these templates as appropriate, for inactive and active
managed nodes.

To create this clustered application configuration file for your WLS environment, follow these
steps:

1 Use the following syntax to create the <appl name>.apm.xml file:
<?xml version="1.0"?>

<APMApplicationConfiguration>

<Application>
<Name> ... </Name>
<Template> ... </Template>

<StartCommand>wasspi wls perl -S wasspi wls clusterSvrApp -opt
startMonitor $instance</StartCommand>
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>»

<StopCommand>wasspi wls perl -S wasspi wls clusterSvrApp -opt
stopMonitor $instance</StopCommand>

</Rpplication>
</APMApplicationConfiguration>
2 Enter the namespace_name under the <Name></Name> tag.

3 After the file is created, save it in the SOvDataDir/bin/instrumentation/conf
directory.

If there is only one WLS server running on the node, you must mention "All" under the
<template> tag.

Sample <appl_name>.apm.xml file

<?xml version="1.0"?>
<APMApplicationConfiguration>
<Application>

<Name>namespace name</Name>
<Template>All</Template>

<StartCommand>wasspi wls perl -S wasspi wls clusterSvrApp -opt
startMonitor $instance</StartCommand>
<StopCommand>wasspi wls perl -S wasspi wls clusterSvrApp -opt
stopMonitor $instance</StopCommand>

</Application>

</APMApplicationConfiguration>

<appl name>.apm.xml is dependent on the application namespace. It is not dependent on
the instance level. Therefore, the start and stop actions are provided with the associated
instance name as their first parameter when they are executed at package switch time. The
environment variable $instanceName is set by C1Aw when start or stop tasks are performed.

Task 2: Create the clustered application configuration file

The clustered application configuration file apminfo.xml, working in conjunction with the
<appl name>.apn.xnl file of WLS SPI, allows you to associate WLS SPI monitored
instances with cluster resource groups. As a result, when you move a resource group from one
node to another, in the same cluster, monitoring stops on the failed node and starts on the new
node.

To create the clustered application configuration file apminfo.xml follow these steps:
1 Use a text editor to create the file. The syntax is:
<?xml version="1.0" ?>
<APMClusterConfiguration>
<Application>
<Name>namespace name</Name>
<Instance>

<Name><Instance Name></Name>
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2
3

<Package><Package Name></Package>
</Instance>
<Application>
</APMClusterConfiguration>
Enter namespace_name under the <Name></Name> tag.

Save the apminfo.xml file to the SOvDataDir/conf/conf directory.

Sample apminfo.xml file

<?xml version="1.0" 2>

<APMClusterConfiguration>

<Application>
<Name>namespace name</Name>
<Instance>
<Name>instance name</Name>
<Package>test</Package>
</Instance>

</RApplication>

</APMClusterConfiguration>

Task 3: Configure WLS SPI

To configure WLS SPI follow these steps:

1
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Launch the Discovery application with virtual node as the target. For details about

launching the discovery application, see Task 3: Launch Discover WebLogic on page 44.

Launch the Configure WLSSPI application with the virtual node as target. The
configuration editor opens.

Use the configuration editor to set the following properties (these properties are in
addition to the ones discovered by the Discovery application) :

e CLUSTERNAMESPACE
e CLUSTERINSTANCE

These properties should have the same value as defined in apminfo.xml file. For
example, CLUSTERNAMESPACE property must be set to namespace name and
CLUSTERINSTANCE must be set to instance name.

Copy the SiteConfig file from active node to passive node. The file is located in the
S$OvDataDir/conf/wasspi directory.

Set the value of ADMIN_HOST property to the name of the managed node that was
activated due to failover.
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Additional Discovery and Configuration Scenarios

This section provides information on how to run discovery under different setups. It includes
examples about some of the common scenarios.

Use Case 1: Administration Port Turned On (Weblogic Servers are Running in
HTTPS Mode)

If the Administration Port is enabled for the WebLogic Servers, there are two discovery
scenarios:

Scenario 1: The Weblogic admin server is running on 3s (HTTPS) and the Weblogic servers associated
with it are running on t3 (HTTP)

Discovery

1
2

Launch Discover WebLogic. See Task 3: Launch Discover WebLogic on page 44.

In the Set Access Info for Default Properties set the BEA WebLogic LOGIN and
PASSWORD properties (this window will appear only if you have not set the LOGIN and
PASSWORD earlier).

In the configuration editor, set the ADMIN_PORTS property. ADMIN_PORTS is the SSL
port on which the application server is listening.

) If the WebLogic Admin server is running on a virtual IP (in a non-clustered
environment), you must specify the virtual IP address when setting the
ADMIN_PORTS property. Set ADMIN_PORTS value to <ip address>:port. For
information about configuration in clustered environment see WLS SPI in High
Availability Environments on page 53

Set the PROTOCOL property to t3s (t3s is the default value for PROTOCOL).
PROTOCOL specifies if the application server port is using SSL or non-SSL.

If required, set the PASSPHRASE and KEYSTORE properties. Click Next to run discovery
on the selected nodes.

KEYSTORE is the path to the SSL trust keystore file.

PASSPHRASE is the password that you set for the KEYSTORE in the SSL environment
of the WebLogic Admin server.

For more information about setting the properties see Configuration Properties on
page 168.

) The properties KEYSTORE, PASSPHRASE, and PROTOCOL can be set at any
level (global, group, node, or server). PROTOCOL is required if you use SSL. You
must set KEYSTORE and PASSPHRASE only if you use a keystore and
passphrase in your SSL environment.

Configuration

After Discovery is successful:

1

56

Launch the Configure WLSSPI application (For instructions on launching this application
see Configure WLSSPI on page 186).
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2 In the configuration editor set the value of the PROTOCOL property to t3 for the
WebLogic servers.

’ If you do not change the value of PROTOCOL property for the WebLogic servers to
t3, PROTOCOL will take up the default value (t3s) set for the Admin Server. For
more information about configuration property precedence see Configuration
Properties on page 168.

3 Create a Monitor user in BEA under the active Security Realm.

4  Set the SERVER_LOGIN and SERVER_PASSWORD properties similar to the credentials
set for the Monitor user.

5 Repeat steps 1to 4 for every instance of WebLogic Server.

Scenario 2: The Weblogic admin server as well as the Weblogic servers associated with it are running

on t3s (HTTPS):

1 Run Discover WebLogic and set the properties as mentioned in Scenario 1.
2  After Discovery is successful.

a Launch the Configure WLSSPI application (For instructions on launching this
application see Configure WLSSPI on page 186).

b Set the PROTOCOL property to the default value t3s.
c¢ Create a Monitor user in BEA under the active Security Realm.

d Set the SERVER_LOGIN and SERVER_PASSWORD properties similar to the
credentials set for the Monitor user.

e Repeat steps a to d for every instance of WebLogic Server.

Use Case 2: Administration Port Not Turned On (Weblogic Application Server is
Running on a Virtual IP)

If the WebLogic Server is running on a virtual IP and the Administration Port is not turned
on, follow these steps to run discovery:

1 Launch Discover WebLogic. See Task 3: Launch Discover WebLogic on page 44.

2 In the Set Access Info for Default Properties set the BEA WebLogic LOGIN and
PASSWORD properties (this window will appear only if you have not set the LOGIN and
PASSWORD earlier).

3 In the configuration editor, set the NODE_NAMES and ADDRESS properties.
4 Click Next. The Confirm Operation window opens.

Click OK to run the discovery on the selected managed nodes.

’ For information about configuration in clustered environment see WLS SPI in High
Availability Environments on page 53
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4 Using and Customizing WLS SPI

Introduction

This chapter provides details about basic and advance template customizations. The following
topics are covered:

Basic Template Customizations

Advanced Template Customizations

Restoring default WLS SPI Templates

Viewing Text-based Reports

Monitoring WebLogic on Unsupported Platforms
Check WLS SPI Nodes for License Count

For information on creating user defined metrics (UDMs), refer to the HP OpenView Smart
Plug-in User Defined Metrics User Guide.

Basic Template Customizations

Based on the needs of your environment you may want to customize some of the default WLS
SPI templates. Basic customizations, such as changing a threshold (by modifying a metrics
template) or modifying alarm generation, are covered in this section.

) Make copies of the default templates before you start customizing the templates.

Modifying Metrics Templates

Many metric attributes can be modified for all monitored instances of WebLogic Server by
following these steps:

1
2

From the OVO console, open the Message Source Templates window.

Click SPI for WebLogic Server template group. A list of WLS SPI templates appears in the
right pane.

Double-click the WLSSPI-Metrics template group.
Select a metric and click Conditions. The Message and Suppress Conditions window opens.

Select the condition you want to modify (there is usually only one) and click Modify. The
Condition window opens.
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6 Modify the attributes. See Table 2 for a list of attributes that you can modify.
Click OK.

8 Deploy the modified template as described in Task 7: Deploy WLS SPI Templates on
page 49.

Table 2 Metric Attributes

Attributes Description

Threshold It is the value which when exceeded, signifies a problem either about
to occur or already occurring.

Duration It is the length of time for which the established threshold can be
exceeded by the incoming data values for a metric before an alarm is
generated.

Severity It is the level you may assign to a message based on its importance in

your environment. Click Severity in the Conditions window to select
the desired severity setting.
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Table 2 Metric Attributes

Attributes Description

Message Text It is a structured, readable piece of information about the status of a
managed object, an event related to a managed object, or a problem
with a managed object.

Note: Do not modify any of the parameters—surrounded by <>
brackets, beginning with $—in a message.

Actions Action is the response to a message. This response is assigned by a
message source template or condition and can be automatic or
operator-initiated. You need to set actions if you want to view reports,
view Performance Manager graphs, or add custom programs.

Automatic action This is an action triggered by an incoming event or message. No
operator intervention is involved. The automatic action delivered with
WLS SPI generates a snapshot report that shows the data values at
the time the action was triggered from an exceeded threshold. You can
view the report in the message Annotations.

Operator-initiated | This ia an action used to take corrective or preventive actions in
action response to a given message. Unlike automatic actions, these actions
are operator initiated. The operator-initiated action delivered with
WLS SPI allows you to view a graph of the metric whose exceeded
threshold generated the message along with other related metric
values (to view the graph, click Perform Action within a message’s
details window).

Figure 12 illustrates that a threshold value of 10 is set for metric WLSSPI-0026. Metric
WLSSPI-0026 monitors the total number of times (per minute) clients must wait for an
available EJB (enterprise java bean).

The severity level of this metric is Warning.

The threshold value set for this metric is 10. If the total number of times (per minute) that the
clients wait for an EJB increases over 10, an alarm is generated (a warning message).

Figure 12 Threshold value for WLSSPI-0026
Description

SSPI-C
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Modifying Alarm Generation

You can set the number of times an alarm is generated by modifying the Message Generation
setting in the Modify Threshold Monitor window.

To modify Message Generation, follow these steps:

1 Open the Message Source Templates window.

Select the SPI for WebLogic Server template group.

Select the WLSSPI-Metrics template group from the right pane.
Select a template.

Click Modify. The Modify Threshold Monitor window opens.

O A 0N

Monitor Name Description

t =

Monitor

External -

Threshold Type Message Generation

- = &= .=

Maximum Mirimum with Reset without Hesat Continuou

Message Defaults

Sewvarity Application Massage Group Object

lunknown

Servicea Name

Instructions... Message Correlation... |Advanced Options...

Cancel Hap

e e T TR RS

6 Select one of the following in the Message Generation settings:

e With Reset: Alarms are generated once when the threshold value is exceeded. At the
same time, a reset threshold value is activated. Only when the reset threshold value is
exceeded, does the original threshold value become active again. Then, when the
threshold value is again exceeded, another alarm is generated and the process starts
all over again.

e Without Reset: Alarms are generated once when the monitoring threshold value is
exceeded. Alarms reset automatically when metric values are no longer in violation of
the thresholds. Alarms are generated again when the threshold is exceeded.

e Continuously: Messages are sent or alerts are generated each time the metric values
are collected and the threshold is exceeded.

7  Click OK.
8 Deploy the modified templates as described in Task 7: Deploy WLS SPI Templates on
page 49.
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Advanced Template Customizations

The template modifications mentioned in this section include making copies of default
template groups in order to customize a few settings, deleting metric groups within a
template’s command line, and so on. All modifications described in this chapter require some
advanced knowledge of the WLS SPI metrics.

Choosing Metrics To Customize

Determine which metrics you want to customize and what templates within the group you
want to use. Then, do the following:

1 Open the Message Source Template window.

2  Select SPI for WebLogic Server from the Template Groups pane. A list of template appear
in the right pane.

3 Select the template group you want to use and click Copy...The Copy Template Group
window opens.

Rename the group and click OK to save.

Within the renamed template group, copy each original template and rename it.

4
5
6 Delete the original templates within the renamed template group.
7

Customize the renamed templates within the group as necessary.

Creating a new template group allows you to keep custom templates separate from the
original default templates.

Using the WLS SPI Collector/Analyzer Command with Parameters

The wasspi wls ca command is used in every collector template. The collector template is
named according to its collection interval. You can view the default command line parameters
within each collector template in the Command box of the Modify Schedule Action window.

Using the Weblogic Server Command Parameters

WLS SPI data collections are started with the wasspi wls ca command, to which you can
add other parameters, as identified in the following table.

Parameter

Function

Syntax

-e

(exclude)

Allows you to exclude specific
servers. This option may not be used
with the -i option.

—e <Server_name>

Example: -e server2, server4

-i

(include)

Allows you to list specific servers to
monitor. This option may not be used
with the -e option.

-1 <server_name>

Example: -i serverl, server3

-m

(metric)

Specifies the metric numbers or
number ranges on which to collect
data.

-m
<metric_number | metric_number_range>
Example: -m 1,3-5,9-11,15

Using and Customizing WIS SPI
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Parameter | Function Syntax
-matchver | Specifies the specific WebLogic -matchver <version_number>
(match Server version to monitor. This Example: -matchver 6.1
version) option may not be used with the
-minver nor -maxver options. If no
matching versions are found, the
command does not execute.
-maxver Specifies the highest WebLogic -maxver <version_number>
(maximum | Server version to monitor. Use with Example: -maxver 7
version) -minver to specify a range of
versions. If no versions are found,
the command does not execute.
-minver Specifies the lowest WebLogic Server| -minver <version_number>
(minimum | version to monitor. Use with -maxver| Example: -minver 7
version) to specify a range of versions. If no
versions are found, the command
does not execute.
-r Generates an ASCII report for the |-r
(report) specified metric(s).
-t Creates a new template group by -t <prefix>-
(tag) adding a prefix to an existing Example: wasspi wls ca -t DEV-
collector template and specifying the - -
metric number(s).
-x Allows you to specify a property/ -X <property>=<property_value>

value as follows:

alarm: when off, overrides any
alarming condition as set up in the
metric monitor template.

-X alarm=off

prefix: Default: JMXUDM_. Specify
the prefix of the metric ID.

-x prefix=SALES

print: when on, prints the metric
name, instance name, and metric
value to STDOUT in addition to any
configured alarming or logging.

-x print=on

graph: when off, prevents graphing
functions.

-x graph=off

report: when off, prevents reporting
functions.

-x report=off

Syntax Examples

To collect specific data on all configured servers:

wasspi wls ca -m 10-14,25,26

To collect data from specific servers only:

wasspi wls ca -m 245,246,26 -1 serverl, server2
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e To not collect data from specific servers:

wasspi wls ca -m 220-225 -e serverl,server2

Using the JMX Command Parameters

The command parameters described in this section are used to run JMX actions. JMX actions
are one or more JMX calls (invoke, get, set) performed on an MBean instance or type. A single
JMX call can be performed from the command line. Multiple JMX calls can be specified in an
XML file or as a Metric sub-element in a UDM file.

Table 3 JMX Command Parameters

Parameter Function Syntax

-a Indicates a JMX action is -a

(action) performed.

Required

-i Specifies servers on which | -1 <server_name>

(include) to perform the JMX actions. | Example: -i serverl, server3
If this parameter is not
specified, the JMX actions
are performed on all
configured servers.

-m Specifies the metric ID -m <metric_id>

(metric) containing the action to Example: -m TestUDM 1000

perform. This metric ID
must be defined in a UDM
file. This option may not be
used with the -mbean nor
-xml options.
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Table 3

JMX Command Parameters

Parameter

Function

Syntax

-mbean

Performs a JMX call on the
specified MBeans. This
option may not be used with
the -m nor -xm1 options.

-mbean <objectname> <action>

Example: -mbean *:*,
Type=JMSServerConfig -get
MessagesMaximum\

In the above syntax, <action> (a JMX call) is one of the following:

—-get

Returns the value of the a specified
attribute.

Syntax: -mbean <objectname> -get
<attribute>

Example: -get MessagesMaximum

—-invoke [-type]

Executes an MBean operation with the
specified parameters. An operation may not
require parameters (therefore, -type is not
specified). A type parameter must be
specified for operations which accept
parameters. -t ype supports operation
overloading.

Syntax: -mbean <objectname> -invoke
<operation>

[-type <parameter_type>
<parameter_value>] . ..

where <parameter_type> is one of the
following:

short, int, long, double, float, boolean,
java.lang.Short, java.lang.Integer,
java.lang.Long, java.lang.Double,
java.lang.Float, java.lang.Boolean, and
java.lang.String.

Example: -invoke stagingEnabled -type
java.lang.String examplesServer

-set

Assigns the specified value to the specified
attribute.

Syntax: -mbean <objectname> -set
<attribute> <value>

Example: -set MessagesMaximum 250000

(object) Specifies an MBean
instance.

Syntax: -o <mbean_instance>
Example: -0 examplesJMSServer

-xml

Specifies the XML file that
contains the JMX action(s)
to perform. This option may
not be used with the -m nor
-mbean options.

Syntax: -xml <filename>
Example: -xm1 myJMXActions.xml
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Table 3

JMX Command Parameters

Parameter

Function

Syntax

-mbean

Performs a JMX call on the
specified MBeans. This
option may not be used with
the -m nor -xm1 options.

-mbean <objectname> <action>

Example: -mbean *:*,
Type=JMSServerConfig -get
MessagesMaximum\

In the above syntax, <action> (a JMX call) is one of the following:

—-get

Returns the value of the a specified
attribute.

Syntax: -mbean <objectname> -get
<attribute>

Example: -get MessagesMaximum

—-invoke [-type]

Executes an MBean operation with the
specified parameters. An operation may not
require parameters (therefore, -type is not
specified). A type parameter must be
specified for operations which accept
parameters. -t ype supports operation
overloading.

Syntax: -mbean <objectname> -invoke
<operation>

[-type <parameter_type>
<parameter_value>] . ..

where <parameter_type> is one of the
following:

short, int, long, double, float, boolean,
java.lang.Short, java.lang.Integer,
java.lang.Long, java.lang.Double,
java.lang.Float, java.lang.Boolean, and
java.lang.String.

Example: -invoke stagingEnabled -type
java.lang.String examplesServer

-set

Assigns the specified value to the specified
attribute.

Syntax: -mbean <objectname> -set
<attribute> <value>

Example: -set MessagesMaximum 250000

(object) Specifies an MBean
instance.

Syntax: -o <mbean_instance>
Example: -0 examplesJMSServer

-xml

Specifies the XML file that
contains the JMX action(s)
to perform. This option may
not be used with the -m nor
-mbean options.

Syntax: -xml <filename>
Example: -xm1 myJMXActions.xml
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Examples

Set the maximum threads for an alarming WebLogic execute queue to 50 (where
<$OPTION(instancename)> specifies an alarming instance):

wasspi wls perl -S wasspi wls ca -a

-mbean “PetStore:*, Type=ExecuteQueueConfig”

-set ThreadsMaximum 50 -o <$OPTION (instancename) >

Set the MessagesMaximum attribute to 25000 on multiple MBean instances:

wasspi wls perl -S wasspi wls ca -a
-mbean *:*,Type=JMSServerConfig -set MessagesMaximum 250000 -i
examplesServer

Set the MessagesMaximum attribute to 25000 on a specific MBean instance:

wasspi wls perl -S wasspi wls ca -a

-mbean *:*,Type=JMSServerConfig -set MessagesMaximum 250000 -1i
examplesServer -o examplesJdMSServer

Invoke an operation on multiple MBean instances:

wasspi wls perl -S wasspi wls ca -a
-mbean *:*,Type=ApplicationConfig -invoke staged
-1 examplesServer

Get the MessagesMaximum attribute (after a set command, used to verify that the
attribute was set):

wasspi wls perl -S wasspi wls ca -a
-mbean *:*,Type=JMSServerConfig -get MessagesMaximum
-1 examplesServer

Use the sample UDM TestUDM_1000 in the wls UDMMetrics-sample.xml file:

wasspi wls perl -S wasspi wls ca -a -m TestUDM 1000 -i examplesServer

Changing the Collection Interval for All Scheduled Metrics

To change the collection interval for all scheduled metrics, change the Polling Interval in the
appropriate collector template. For example, to change the collection of default metrics from 5
minutes to 10 minutes for the WLSSPI-05min collector template, follow these steps:

1

o O A WN

Select the Message Source Templates window.

Select the template group SPI for WebLogic Server and open WLSSPI-Schedule.
Select the collector template WLSSPI-05min.

Click Modify.... The Modify Schedule Action window opens.

Change the Schedule Action Name to WLSSPI-10min.

In the Minute box, change the polling interval from 5 minute to 10 minutes. For example,
0, 10, 20...

Distribute the new templates (described in Task 7: Deploy WLS SPI Templates on
page 49).
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Changing the Collection Interval for Selected Metrics

To change the collection interval for selected metrics, copy the appropriate collector template
and rename with a name reflecting the new interval. Delete all but the metrics you are
changing. Set the new interval. Remove the metrics you have changed from the original
template.

For example, to change the collection interval to 10 minutes for metrics 70-81, follow these

steps:

BagENT_USER

Open the Message Source Templates window.
Select the template group SPI for WebLogic Server and open WLSSPI-Schedule.
Select the template WLSSPI-05min.

j—

Click Copy.... The Copy Schedule Action window opens.

Change Scheduled Action Name to WLSSPI-10min.

In the Command box (see figure above), delete all metrics after the -m except 70-81.
Change the Polling Interval to 10m.

Click OK.

In the WLSSPI-Schedule template group, select the WLSSPI-5min template.

Click Modify. The Modify Schedule Action window opens

Delete 70-81 from the Command box.

Re-distribute the modified templates as described in Task 7: Deploy WLS SPI Templates
on page 49.
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Cutomize Threshold Values for Different Applications/EJB/Servlet/JDBC

In your environment some applications may be more critical than others, also, within an
application some of the EJBs/Servlets/JDBC datasource may be critical, and others may not.
You can set threshold values per application or per EJB/Servlet/JDBC datasource depending
on their criticality.

To do so, you must copy the existing condition and modify it. Follow these steps:

1 Double-click to open the metric for customization (for example, WLSSPI-0012). The
Message and Suppress Conditions window opens.

2  Select the desired condition and press the Copy... button to make a copy of the condition.

3 In the Object Pattern field, enter the following details (enter only the necessary fields, see
Examples):

<ServerName>:<ServerPort>:<NodeName>:<ApplicationName>:<EJBName /
ServletName / JDBC DataSource>:<Instance Name>

4 In the Threshold column, change the threshold value.
Deploy the template to the corresponding node.
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Before customizing the threshold value, you may want to see the list of applications/EJBs/
Servlets/JDBC datasource running on a server. For this you can use the following WLS SPI
applications:

e View WebLogic Servers: This gives you details of all running application servers and the
corresponding ports.

e View Deployed Apps: Gives a list of all applications deployed on a particular server.

Examples

Here are a few examples that will help you in entering details in the Object Pattern field:

e Example 1: If you want to set threshold for the application MedrecEAR, and if the
application name is unique across all the nodes then, enter the following:

<*¥>:<*>:<*>:MedrecEAR:<*>:<*>

e Example 2: If you want to set the threshold for the application MedrecEAR that is
available on node 1 and node 2, then to set the threshold only on node 1, enter the
following:

<*>:<*>:nodel:MedrecEAR:<*>:<*>

e Example 3: If you want to set the threshold for the Servlet- FileServlet under the
application MedrecEAR, and FileServlet is unique across all the nodes, enter the
following:

<*>:<*>:<*>:MedrecEAR:FileServlet:<*>

Creating Custom, Tagged Templates

Another advanced customization option is to use the tag option (-t on the command line),
which allows the collector or analyzer to recognize customized templates that have a tag
attached to the name. This option provides you with the flexibility of using more than a single
set of templates to define conditions pertaining to specific installations of WebLogic Server.

When multiple nodes are managed by a number of groups, this option allows you to create
specially tagged templates that are obviously separate from your original setup. In such a
case, you would make copies of the templates, rename them with the tag and re-work the
collector template to pick up the tagged names, then assign them to the various groups.

For example, you might create a group of templates and change each template name to
include CLIENTO1 in it. A metric monitor template might be named
CLIENTO01-WLSSPI_0012 (retaining the metric number, which must be used). The collector
template would be named FIRST_CLIENT-05min. You could then set up another group for
SECOND_CLIENT and change all those templates to include the CLIENT02 in the name.

To create the new template group

1 Copy the original template group. In the Message Source Templates window, select the
group and click Copy....

2 Name the new group according to how you plan to identify the new monitor and collector
templates. For example, if you are including CLIENTO1 in the template names, include
CLIENTO1 within the new template group name as well.
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3 In the Message Source Template window expand the new template group to show all
templates and select each template you plan to use, click Copy..., and rename it according
to your naming scheme.

¢ The names you give the new metric monitor templates in the group would contain the
new name followed by the original metric number. For example, a copy of
WLSSPI-0001 could be called CLIENT01-WLSSPI_0001.

¢ The name you give the new collector monitor template would also contain the
identifying name. You would also modify the scheduled collection for the new group by
inserting the -t property on the command line. For example:

wasspi wls ca -m 16 -t CLIENTO01-

4 Delete all original templates from the new group.

Template Variables

The following variables are used by the WLS SPI templates. If you are creating your own
templates, you may use these variables.

Name Description

instancename The instance for which the metric is being reported for multi-instance
metrics.
Example: medRecServer MedRecServer wl management
internal2 com.bea.wli.bpm.runtime.JwfServlet 20

map port See port.

map_ servername

The application server name with spaces replaced with underscores (“_”).
Used for service map keys where spaces are prohibited.

Example: my server

node The node on which the application server is running.
Example: mool.hp.com

port The port on which the application server is listening. Corresponds to the
PORT configuration property.
Example: 9001

servername The application server name. Corresponds to the NAME configuration

property.
Example: my server

Restoring default WLS SPI Templates

When WLS SPI templates are installed in OVO, the commands given in the table below
automatically upload the templates when swinstall is run. Any customized template
settings you may have done for the previous installation are overwritten.

To restore the default SPI for BEA WebLogic Server template group you had originally
installed, delete all current templates first, then run one of the commands in the following
table (depending on the version of OVO):
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Scripts run by swinstall

ovo
Version | Scripts

>6.x /opt/OV/bin/OpC/opccfgupld -silent? -replace
-subentity /var/opt/OV/share/tmp/OpC appl/wasspi/wls_set

5.x /opt/0V/bin/0OpC/opccfgupld -silent -replace —-subentity -index
/var/opt/OV/share/tmp/OpC appl/wasspi/wls/wls ito5 set/C/wls_set.idx
/var/opt/OV/share/tmp/OpC appl/wasspi/wls/wls ito5 set

a. Alternatively, you can use the -verbose option instead of the -silent option.

Viewing Text-based Reports

Some templates have actions defined with threshold violations or error conditions that
automatically cause reports to appear in the message Annotations. These reports are
snapshots of data values collected form the server around the time that the alarm occurred.

Other templates have operator actions associated with them that allow you to generate a
graph.

’ The reports discussed in this section should not be confused with those generated by
OpenView Reporter, which show more consolidated, historical data generated as web pages in
management-ready presentation format.

e Toview message details double-click a message in the OVO message browser or right-click
the message and select Details.

e To view reports, open both the Node Bank and Application Bank windows. Continue to
open application windows WLSSPI - WLSSPI Admin - Reports. Select a node and drag it
onto the WLSSPI metric report you need. These reports show all server data on a node.

e To view graphs, open both the Node Bank and Application Bank windows. Continue to
open application windows WLSSPI - WLSSPI Admin. Drag a node onto the View Graphs
application to launch your Web browser, which displays the graphing feature available in
HP OpenView Performance Manager (which must be purchased separately).

Automatic Action Reports

Many metrics generate Automatic Action Reports. These reports are generated as soon as an
alarm is triggered in OVO. Automatic Action reports show the state of the system soon after
the alarm occurs.

When an Automatic Action report is executed from OVO, the server is queried for additional
data. If you set your message browser to display the SUTAONE column, you will notice the
letter “S” under the “A” column (see Figure 13) when a report is available in the Annotations
area of the Message Details.
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Figure 13 Message Browser
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To view Automatic Action Reports

You can view Automatic Action reports in the Annotations window. Do one of the following:

e Select the message for which a report is and click Annotations. The Annotations window
opens.

e Right-click a message and select Annotations. The Annotations window opens.

Automatic Action reports show data values on a single server. Column descriptions in the
window provide more information.

Application Bank Reports

You can use Application Bank Reports to manually generate a report similar to an Automatic
Action report. Application Bank reports run for all WebLogic Server instances configured on
the managed node, in contrast to Automatic Action Reports, which are generated for a single
WebLogic Server instance. The reports generated from the Application Bank reflect the
current state of WebLogic Server on the managed node.
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To manually generate a report

Follow these steps:
1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2  From the Window menu, select Application Bank. The OVO Application Bank window
opens.

Double-click WLSSPI. The Application Group: WLS SPI window opens.

4 Double-click WLS SPI Reports. The Application Group: WLS SPI Reports window opens. All
the WLS SPI Reports appear in this window.

5 Drag the managed node from the Node Bank window to the desired report in the
Application Bank window.

Sample Reports

Two samples, one each of Automatic Action report and manually generated report
(Application Bank report) are given below.
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Automatic Action Report

Figure 14 shows the format of an automatically generated WLS SPI report.

Figure 14 Report on metric B011
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Manually generated Report

Figure 15 shows the format of a manually generated WLS SPI report.
Figure 15 Manually Generated WLS SPI Report
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Monitoring Weblogic on Unsupported Platforms

The WLS SPI supports monitoring WebLogic Servers installed on systems running HP-UX,
Linux (Red Hat), Solaris, and Windows 2000. However, it is possible to configure the WLS SPI
to monitor a WebLogic Server installed on systems running on unsupported platforms—
systems referred to as “remote systems.”

The intent of this section is to help you determine if your environment is conducive to setting
up remote monitoring. If your environment meets the criteria described below, this section
offers an example to get you started.

Requirements for Monitoring Remote Nodes (running on Platforms not supported
by WLS SP)

For a WebLogic Server installation on a system running on a platform other than HP-UX,
Linux (Red Hat), Solaris, or Windows 2000, you can use WLS SPI to monitor that remote
system if the following conditions apply. The last condition is optional:

e The remote system is covered by a purchased license (using Tier 1 pricing).

e The WLS SPI runs on at least one managed node on a supported platform: HP-UX,
Solaris, or Windows 2000.

e (Optional, for logfile monitoring) The remote system runs on a platform supported by the
OVO agent software.

Overview

This section provides an overview of remote monitoring and shows how it is implemented.
This section also explains how to set up the WLS SPI to access WebLogic Server metrics and
logfiles on unsupported platforms by using both the WLS SPI and OVO agent software.

Remote Monitoring

In a standard configuration, WLS SPI programs and templates are deployed on the local,
managed node. In a non-standard configuration, the local system is used as a proxy through
which remote metric information becomes accessible.

Remote system data collection and interpretation relies on the local, managed node to act as
the proxy on which data collection is configured (See Figure 16).
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Figure 16 Remote System Data Collection

OpenView Operations OpenView Operations
Managed Node Management Server
Proxy System !

Configuration entries requirement: Within the configuration, entries for both local and
remote systems are included. You can include multiple remote system entries in a local
system’s section. See the example on page 79, that shows how the remote entry appears (with
system IP address).

Template deployment requirement: Templates must be deployed on the local node. If you
need a separate template group, you can copy and rename the existing templates and specify
the WebLogic Server name on the command line using the -i or -e options. For details on using
these command line parameters, see Using the WebLogic Server Command Parameters on
page 63.

OVO agent deployment requirement (optional logfile monitoring): To access remote
WebLogic log files, ensure that the OVO agent software is installed on the remote system.
Using standard OVO processes, you can modify the standard logfile templates included with
the WLS SPI to specify the correct logfile names, then deploy them to the remote system.

) Monitoring remote systems using logfile versioning is not supported.

Configure Remote System Monitoring

To monitor WebLogic Servers remotely on systems other than those running on HP-UX, Linux
(Red Hat), Solaris, or Windows 2000 platforms, complete these tasks:
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Task 1: Configure the Remote Weblogic Server

Use Configure WLS SPI application in the OVO WebLogic Application Bank, to configure each
local managed node that communicates with a remote WebLogic Server. In the configuration
add entries for remote WebLogic Servers.

1 Select the WebLogic managed node from which you want to monitor the remote WebLogic
Server.

2 In the configuration, include an entry for each remote WebLogic server:
SERVER<n> ADDRESS=<DNS server name or IP address>.

Be sure that the property NUM_SERVERS is set to the correct number of servers (<n>)
and that HOME and JAVA_HOME properties are set at the global level.

The illustration below shows how local and remote WebLogic servers are configured in the
same file. Notice, however, that for the remote servers the
SERVER<n> ADDRESS=<IP_address> line is added:

SERVER2 ADDRESS=15.75.27.109
or
SERVER2 ADDRESS=harley.rose.hp.com

If you are configuring one local (SERVER1) and one remote (SERVER2) WebLogic server,
your configuration may look like the following:

F Edit WebLogic SPI Configuration =]l

##############t#iltfﬂﬂ#ﬂ#ﬁhﬁmﬁhﬁmﬁm
HOME=/"opt leea Swlzery
JaT4_HOME=/opt bea, jdk

HUM_SERVERES

There are two WebLogic Servers configured in the preceding configuration. SERVER1 is the
local server, running on an HP-UX managed node. SERVER?2 is running on an
OVO-managed node, that is a non-Red Hat Linux system (a platform unsupported by
WLS SPI). The remote system is configured similar to that of the local system but
contains the new line SERVER2 ADDRESS=harley.rose.hp.com.

3 To verify that the SPI is monitoring the remote node, run the following command:

wasspi_wls_perl -S wasspi_wls_ca -m 5 -i <remote_server NAME |ALIAS> -x
print=on

You must use ALIAS if it is set for the remote server.
Task 2: Integrate OpenView Performance Agent (Optional)
The OpenView Performance Agent (also called MeasureWare Agent) collection occurs on the

managed node, not the remote system. If you use PerfView and would like to graph the remote
system data, you must ensure that OVPA integration is enabled on the local managed node.
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Task 3: Assign Local Node to Weblogic node group

Assign the local managed node to the WebLogic node group. Make sure you are deploying the
configuration on the same WebLogic Server version node as the remote system.

Configuring Remote Monitoring for Logfiles (Optional)

Monitoring remote system logfiles is supported, if the following critera are met
1 The remote system that has an OVO agent running on it.
2 The system does not re-version logfiles when they roll.

To set up logfile monitoring, at the OVO console, copy the WLS- SPI logfile template and then
configure, assign, and deploy the copied logfile template to the remote system.

Configure the Logfile Template for Remote Logfiles

To configure the Logfile templates for remote monitoring, follow these steps:
1 Open a copy of the WebLogic Log Template located under the WebLogic version Group.
For example, SPI for WebLogic Server > WLSSPI-Logfiles

2 In the Logfile text box, enter the location of the logfile on the remote system:
/<path>/<filename>.

3 Assign and deploy the logfile template to the remote OVO-managed node.

The Log File Template and the OVO Agent, both present on the remote system, make
WebLogic Server logfile monitoring possible.

OpenView Operations OpenView Operations
Managed Node Management Server

Proxy System
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Remote Monitoring Limitations

Remote monitoring has the following limitations:

e The WLS SPI and the OVO agent do not support access to logfiles that are re-versioned
each time the logs are rolled.

e  When no OVO agent is present on the remote system, monitoring of WebLogic logfiles on
the remote system cannot occur.

¢ In the OpenView Operations Application Bank, WLS SPI applications cannot be executed
on remote systems.

Check WLS SPI Nodes for License Count

You can use an OVO reporting utility to check the number of templates you have installed on
your managed nodes. In reviewing the number of templates per managed node, you can see if
you have consistently installed templates across your managed systems. In addition, by
running this report, you can also ensure that the number of licenses you have purchased is in
compliance with the report results.

To run the report:

1 At the OVO console, select the node or node group that you want to check.

2  From the Actions menu, select Utilities = Reports....

3 In the Reports window among the reports listed, select WLSSPI License Check.
4

Select an output destination and click OK.
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5 Integrating HP OpenView Reporting and
Graphing Products with WLS SPI

The Smart Plug-in for BEA WebLogic Server (WLS SPI) can be integrated with the following
HP OpenView reporting and graphing products (these products must be purchased
separately):

e HP OpenView Reporter (Reporter)

e HP OpenView Performance Agent (OVPA)

e HP OpenView Performance Insight (OVPI)

e HP OpenView Performance Manager (OVPM)

HP OpenView Reporter: Reporter produces management-ready, web page reports, showing
historical and trending information. This is not the version of Reporter that is included with
HP OpenView Operations.

Working in conjunction with Reporter, the WLS SPI produces a variety of reports showing
consolidated information on the WebLogic Application Server.

For more information on how to integrate WLS SPI with Reporter, see Integrating with HP
OpenView Reporter on page 84. After you integrate WLS SPI with Reporter, Reporter
generates reports, every night, that show the performance and availability of a WebLogic
Application Server on configured managed nodes.

HP OpenView Performance Agent (OVPA): OVPA collects, summarizes, time stamps, and
detects alarm conditions on current and historical resource data across your system. It
provides performance, resource, and end-to-end transaction response time measurements,
and supports network and database measurement information. Refer to the HP OpenView
Performance Agent for UNIX User’s Manual for more information about OVPA.

If you are using OVPA, WLS SPI automatically uses it. If you want to use the HP OpenView
Operations subagent, CODA, that is included with HP OpenView Operations (does not
support OVPA), you must configure your managed nodes to do so. Refer to Integrating with
CODA on page 84 for more information.

HP OpenView Performance Insight (OVPI): OVPI is a network management system that
collects, processes, and reports data. The data is used to generate reports. Refer to the HP
OpenView Performance Insight Administration Guide for more information about OVPI. Refer
to the Application Server Report Pack User Guide for more information about WLS SPI
reports and how to integrate WLS SPI with OVPL.

HP OpenView Performance Manager (OVPM): OVPM provides graphing capability of
WLS SPI metrics. This is not the version of OVPM that is included with HP OpenView
Operations.

For more information on how to integrate WLS SPI with OVPM, see Integrating with HP
OpenView Performance Manager on page 89. After integrating WLS SPI with OVPM, graphs
are available the following day.
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Integrating with CODA

The WLS SPI can detect if you are using OpenView Performance Agent (OVPA or
MeasureWare Agent). If you are using OVPA, the WLS SPI installation automatically uses it.

If you want to use the HP OpenView Operations subagent, CODA, included with OVO 7.x and

later, you must configure the managed nodes to do so. Note that this configuration does not
support OVPA.

To use CODA, set up an empty file named nocoda.opt and store it on the managed node:

1 On the managed node, create a nocoda. opt file in the following directory:

Operating System File Location

HP-UX, Linux, Solaris /var/opt/0OV/conf/dsi2ddf/

Windows \usr\ov\conf\dsi2ddf\

If the directory dsi2ddf does not exist, create it.
2 Save the empty file.

Integrating with HP OpenView Reporter

You must configure WLS SPI (see Chapter 3, Configuring WLS SPI) before it can be
integrated with Reporter.

If you are upgrading the WLS SPI report package, you must remove the old version before
installing the new version. Refer to Task 13: Install the New Report Package (Optional) on
page 33 for information on how to remove the WLS SPI report package.

You must install the WLS SPI report package on a Windows system running Reporter. To
install the report package, follow these steps:

1 On the Windows client system, insert the Smart Plug-ins DVD-ROM (that contains the
reporting packages) into the DVD-ROM drive, and in Windows Explorer, double-click:

\OV_REPORTER\WEBLOGIC_SPI_04.20.000\WLSSPI-Reporter.msi

2 Follow the instructions as they appear.

3 Check the Reporter status pane (see the illustration that follows) to note changes to the
Reporter configuration.

’ For Windows 2000 managed nodes, during the installation an error message may
appear that indicates the installer has detected an older version of the installer on
your system. You can safely ignore the message and continue.
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The status pane (at the bottom of the Reporter window) shows you information on the
programs running and any errors occurring. You can check the status pane to see that
Reporter has been updated with the WLS SPI reports.
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Reporker Service

You can find instructions in the Reporter Help for assigning WLS SPI reports to the
targeted nodes. To access Help, select Reports or Discovered Systems in the left panel of
the Reporter main window and right-click it. Select Report Help or Discovered Systems
Help from the submenu that appears. See the topic - To assign a report definition to a

Discovered Systems Group.

4 Add group and single system reports by assigning reports as desired. (See the Reporter
Help and the online Concepts Guide for complete information).

) Group and single system WLS SPI reports require that you identify systems by
their full name. For example, abc.xyz.com is acceptable while abc is not.
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WILS SPI Reporter Reports

The reports available through the integration of HP OpenView Reporter and WLS SPI show
consolidated data on server performance and availability on WebLogic Server systems. In
addition, other reports show data for single systems. These reports are available the day
following your installation of the WLS SPI report package on the Reporter Windows system.
(Refer to Integrating with HP OpenView Reporter on page 84, if you have not yet completed
the report package installation.)

The tables that follow show all pre-defined reports.

Table 4 Performance
WebLogic

Report Title Description Version Metric
TOP 20 Queue Shows the average throughput for the top 20| 6.1, 7.0, 8.1,| 10
Throughput execute queues of all servers. 9.x
TOP 20 Servlet Average | Shows the average execution time for the top| 6.1, 7.0, 8.1, | 240
Execution Times 20 requested servlets for all servers. 9.x

Along with the servlet name the associated

application name is also displayed.
TOP 20 Servlet Request | Shows the total servlet request rate being 6.1,7.0,8.1,| 242
Rates received by the top 20 servers 9.x

Along with the servlet name, the associated

application name is also displayed.
Execute Queue Thread | Shows the execute queue's thread utilization| 6.1, 7.0, 8.1,| 11
Utilization as a percent for the top 20 execute queues of | 9.x

all servers.
TOP 20 Average Shows the average transaction throughput |6.1,7.0,8.1,| 76
Transaction Throughput | for the top 20 servers. 9.x
TOP 20 EJB Free Pool | Shows the number of times per minute that a| 7.0, 8.1, 9.x | 25
Wait Rate request had to wait for an EJB to become

available for the top 20 servers.
TOP 20 EJB Timeout Shows the number of times per minute thata| 7.0, 8.1, 9.x | 26
Rate request timed out while waiting for an EJB

to become available for the top 20 servers.
TOP 20 EJB Transaction | Shows the average EJB transaction 6.1,7.0,8.1,| 35
Throughput throughput for the top 20 servers. 9.x

Table 5 Availability
WebLogic

Report Title Description Version Metric
Server Availability Contains a daily histogram showing the 6.1 2

percentages of uptime, downtime for all
servers.
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Table 6

Single System Reports

WebLogic

Report Title Description Version Metric
Server Availability Contains spectrum graphs showing minutes | 6.1 2
Details of uptime by day and hour for each WebLogic

Server.
JDBC Throughput And | Charts the throughput against the 6.1,7.0,8.1,| 260,
Connection Utilization | utilization for the JDBC connection pools for | 9.x 262

each WebLogic server. Shows the JDBC data

source and the associated application name

(if any).
Throughput And Charts the throughput against the queue 6.1,7.0,8.1,| 252,
Utilization Of JMS utilization by byte count for destinations on | 9.x 256
Server By Byte Count the JMS servers for each WebLogic Server.
Throughput And Charts the throughput against queue 6.1,7.0,8.1,| 251,
Utilization Of JMS utilization by message count on the JMS 9.x 255
Server By Message servers for each WebLogic server.
Count
Queue Utilization versus| Shows the throughput against the thread 6.1,7.0,8.1,| 10,11
Throughput On Server | utilization for each WebLogic server. 9.x
TOP 20 Servlet Request | Shows a stacked area chart with the request| 6.1, 7.0, 8.1, | 242
Rate On Server rate (requests per second) for the top 20 9.x

servlets for each day and a table with data of

the top 100 servlets for each WebLogic

Server.
Transaction Throughput | Shows the average transaction throughput |6.1,7.0,8.1,| 76
On Server for each WebLogic Server by day. 9.x
Transaction Rollback Shows the transaction rollbacks by error 6.1,7.0,8.1,| 72-75
Types type for each WebLogic Server. 9.x
TOP 20 Stateful and Shows the EJB cache utilization percent for | 7.0, 8.1, 9.x | 238
Entity EJB Cache the top 20 EJBs for each WebLogic Server.
Utilization Along with the EJB instance, the associated

application name also will be displayed
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OVPI Reports for WLS SPI

The reports available through the integration of HP OpenView Performance Insight and WLS
SPI show consolidated data on server performance and availability on WebLogic Server
systems. Refer to the Application Server Report Pack User Guide for more information about
WLS SPI reports and how to integrate WLS SPI with OVPI.

The table that follow shows all pre-defined reports.

Report Title Description Metric
Server Availability— The server availability chart plots the availability status |2, 76
Throughput of the application server on an hourly, daily, and monthly
basis. The transaction throughput chart displays the
number of transactions processed by the application
server per second.
EJB Pool Utilization The percentage of EJB pool utilization. 235
JDBC Throughput— The percentage of available JDBC connection in the 260,
Utilization connection pool and the number of clients serviced by the | 262
connection pool per second.
Near Real Time Server | The server status for the last six hours. 2,76
Availability
Servlet Request Rate— | The servlet request rate measures the number of requests | 240,
Response Time for a servlet per second. The servlet response time chart | 242
shows the average execution time for an individual
servlet.
EJB Cache Utilization | The percentage of EJBs in the cache in use. 238
EJB Transaction Reports| The EJB Free Pool Wait Rate measures the number of 25, 26,
times per minute that no stateless session beans were 35
available from the free pool. The EJB Load Timeout Rate
measures the number of times a client timed out waiting
for an EJB. The EJB Transaction Throughput measures
the number of EJB transactions per second.
Execute Queue The Execute Queue Throughput rate measures the 10,11
Throughput—Utilization| number of requests serviced by an execute queue per
second. The Queue Utilization chart shows the percentage
of threads used for a server’s execute queue.
JMS Throughput— The JMS Throughput report indicates the number of 251,
Utilization messages/bytes that have passed through the JMS per 252,
second. The JMS Utilization report indicates what 255,
percentage of a JMS queue is filled based on the number of | 256
messages or bytes.
Near Real TIme Execute | The throughput or utilization trend of execute queues for | 10, 11
Queue Throughput— the last six hours.
Utilization
Server Transaction The percentage of transactions that are rolled back due to| 72 - 75

Rollback

resource, application, timeout, or system error.
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Integrating with HP OpenView Performance Manager

To integrate WLS SPI with OVPM, do the following:

1 Install and configure WLS SPI. Verify that you have completed Task 1: Configure the
Management Server to Launch your Web Browser on page 36. Also, verify that you have
set the GRAPH_URL property. For more information about the GRAPH_URL property,
see Property Definitions on page 169.

2 Ifyou are upgrading the WLS SPI graph package, you must remove the old version before
installing the new version. For information on removing the WLS SPI graph package, see
Task 14: Install the New Graph Package (Optional) on page 33.

3 Install the graph package.
If OVPM is running on a Windows system, follow these steps:

a Insert the Smart Plug-ins DVD-ROM (that contains the reporting packages) into the
DVD-ROM drive, and in Windows Explorer, double-click:

\OV_PM\WEBLOGIC_SPI_04.20.000\WINDOWS\HPOvSpiWIsGc-04.20.000.msi
b  Follow the instructions as they appear.

If OVPM is running on a HP-UX system that is not the OVO management server, follow
these steps (if OVPM is installed on the OVO management server, the files are installed
automatically when you install the SPI software):
e Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and
type:
swinstall -s <mount_point>/OV_PM/WEBLOGIC_SPI 04.20.000/HPUX/
HPOvSpiWlsGc-04.20.000.sdtape WLSSPI-GRAPHS

If OVPM is running on a Solaris system that is not the OVO management server, follow
these steps (if OVPM is installed on the OVO management server, the files are
automatically installed when you install the SPI software):

e Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and
type:

/usr/sbin/pkgadd -d <mount_point>/OV_PM/WEBLOGIC_SPI 04.20.000/
SOLARIS/HPOVSpiWlsGc-04.20.000.sparc all

4 To graph any WebLogic server metric, use the data source name WLSSPI METRICS.

For information on how to view the graphs, refer to the OVPM documentation. You can view
the graphs one day after the integration.

’ To uninstall the Graph package, follow the steps given in Task 8: Remove the Graph Package
(Optional) on page 27

Viewing Graphs that Show Alarm Conditions

For graphing purposes, WLS SPI organizes metrics according to type. When a message is
generated for any metric appearing in a table in the section that follows, you can view a chart
of its and other metric values.
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To view a graph associated with an alarm condition (Operator-initiated action has been
defined with the WLS SPI monitor template), complete these steps:

1 In the OVO message browser, double-click the message. The Message Details window
opens.

2  Click Perform Action.

WLS SPI graph for the metric appears. The value of this metric is charted along with the
values of other metrics in the same group.

Viewing Graphs that Show Past or Current Conditions

You can manually generate any of the four available graphs using the View Graphs
application. Follow these steps:

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank opens in a
new window.

3 Double-click WLSSPIL. The Application Group:WLS SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All
the WLSSPI Admin applications appear in this window.

5 Select a node in the Node Bank window and double-click View Graphs to view the graphs.

WLS SPI Metrics Available for Graphs

The tables that follow show the graphs available for mapping collected metric values. You can
use the View Graphs application to view graphs of any of the metrics listed in the tables
below. The graph will appear in your Web browser.

Table 7 JVM

Metric Number and Name | Metric Description

B005_JVMMemUtilPct Percentage of heap space used in the JVM.

Table 8 Server Performance

Metric Number and Name | Metric Description

B010_ExQueThruRate Number of requests serviced by an execute queue per second.
B011_ExQThrdUtilPct Percentage of threads in use for a server’s execute queue.
B012_ExQueWaitCnt The number of client requests waiting to be serviced

B013_ SocketTrafficRt Number of socket connections opened per second.
B014_ActiveSocketCnt Number of socket connections opened.
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Table 9

Enterprise Java Beans (EJB)

Metric Number and Name

Metric Description

B025_EJBPoolWtRtSum

Number of times per minute that no EJB beans were
available from the free pool.

B026_EJBTimeoutRtSum

The number of times per minute a client timed out waiting
for an EJB bean.

B035_EJBTranThruRt

Number of EJB transactions per second.

B036_EJBTranRbRt

Number of EJB transactions rolled back per second.

Table 10 JDBC

Metric Number and Name

Metric Description

B061_JDBCConPIWtCnt

Number of clients waiting for a connection from connection
pools.

B063_JDBCConLkRtSum

Number of unclosed JDBC connections and JDBC
connections that have exceeded their maximum idle times in
the connection pool per minute.

Table 11 Connector Service

Metric Number and Name

Metric Description

B078_CnctrLeakRtSum

Number of unclosed connector connections and connector
connections that have exceeded their maximum idle times in
the connection pool per minute.

Table 12 Transaction

Metric Number and Name

Metric Description

B070_TranAveTime

Average commit time for transactions.

B071_TranRollbackPct

Percentage of transactions rolled back, based on the total.

B072_TranResErrRbPct

Percentage of the transactions rolled back due to resource
error.

B073_TranAppErrRbPct

Percentage of transactions rolled back due to application
error.

B074_TranTimErrRbPct

Percentage of transactions rolled back due to a timeout error.

B075_TranSysErrRbPct

Percentage of the transactions rolled back due to system
error.

B076_TranThruRate

Number of transactions processed per second.

B077_TranHeurCnt

Percentage of transactions returning a heuristic decision.

B079_TranCapUtil

Percentage utilization of transaction capacity.
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Table 13 Cluster

Metric Number and Name

Metric Description

B080_ClsOutMesFailRt

Number of multicast messages per minute to cluster re-sent.

B081_ClsInMesFailRt

Number of multicast messages per minute from cluster lost
by server.

Table 14 Security

Metric Number and Name

Metric Description

B085_InvLoginAttCnt

Number of invalid login attempts.

Table 15 WebLogic Time Service

Metric Number and Name

Metric Description

B091_TimeSerThruRt

Number of triggers executed per second.

Launching the Web Page Display with an Operator Action that Generate Graphs

Performance Manager graphs can be generated from most WLS SPI alarm messages by
clicking Perform Action from the message details, Properties, or the message browser. The
operator action launches your Web browser, which displays a graph of the metric that
generated the message, as well as other related metrics.

HP OpenView __ Help |

System wha myserver Status Metrics
100 grapn
95 -
a0
85 4 1 -
B0 - n ]
75 | ]
oo 1] :
B5 - M .
B0 - \ \ L
-
55
50 \ :
45 -
a0 - [ |
35 | ’ | l \
30 | |
257 [
20 | L
15+ -
10
BB e
001 07 1790 08/ 30T 1625 GaT301 1940 OBr301 2355 09N4i0T 0410
B 5005_svMiMensiPc [} 8013_SocketTraticht B 5014_tctveSocketCnt
[ eo&1_JDBCConPrACHt [[] 085 _irvlogindnCnt B B0o1_TimeSerThruRt

Automatically Refresh Eefresh Graph MNowr
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Specifying a Date Range

Within the web page display, you can specify a date range of one day, one week, one month, or
one year. Refer to the online help for instructions on changing display settings.

Example Integration

The following is an example of how to graph multi-instance data stored in a data source by
reporting each OBJECTNAME for the METRICID for each SERVERNAME. The result is all
data for all instances are reported in one graph. The data for each SERVERNAME can also be
displayed in a separate graph.

This example also uses the Java interface option of OVPM.

1 Start the Java Interface option of OVPM. The Performance Manager Java Interface
window opens.

| Display | Design | :
O) New g3 open... B Save [ Save As.. X Delete.. [& Preview T Hep [ AE R
General

Dalasource; i Metrics |

Default Selection: Moot Sources

Mote: The default selection 15 onky wsed during araph design to preview the graph and retriesa metric m
information. dnce you finish design and save the graph, you can then make mulliple selections to 2L

draw the graph. _ T-Filter_|

[~ Complex Graph Design using multiple sources

2  From the Performance Manager Java Interface window,
a Click the Display tab at the top of the window.
b In the Display pane click the Sources tab.

¢ Click - | button next to the Datasource box and select a data source.

d Click - | button next to the Default Selection box and select the node on which the
data source resides.
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3 Click the General tab at the right of the window.

Display Design | .
[ Mew i Open.. B Save | Save As. X Delete. [& Preview § Halp _
DILIE. I =
Sublitie: |
Type: Im
Description;
rDate Range Paints Every:

Duration: |3 [days =] | [Sminstes =]

Ending: T Mow = Last Lirnit Kurnber of Polnts to:

© Date: Time: E
[ - | [T |
Shift

[~ Cwerride Shift Defaults

gtart |00 00 = Stop

Days ¥ Sun F hon [F Tue F
Metric Display Order:
" mverage data value
i+ Label {alphabetical)

i lmmy MaEe s faa s blsdsla s be ey

::I |_f__i-.,- al

FFThu [ Fri ¥ Sat

General |

Metrics |

Sources |

Highlight |

T-Filter |

4 From the General pane,

a Select line from the Type drop-down list. This generates a line graph.

b Enter a Date Range.

¢ Enter an interval using the Points Every drop-down list.

d Select Label (alphabetical) option for the Metric Display Order, if you want the graph

key sorted alphabetically.
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5 Click the Metrics tab at the right of the window and click Add. The Metric Selection
window opens.

e 1

Metric Selection E

- [§# CPU =]
- 3 NETIF

_@ Fg

- [ DISK

- [§# WLSSPI_METRICSWLSSPI_METRICS

- [§# WLSSPI_RPT_METRICSWLSSPI_RPT_METRICS

----- I~ § INTERvAL

----- [~ § mETRICID

----- [~ § oBJECTMAME

----- [~ [§ SERVERMAME

----- [~ § sorTD
----- I~ [ waLuE &
----- I~ [ waLUEID

- B WRSEP] METRICSWHSSP METRICS d

Label: |
Type: IIine vI
Y AxiS: IIeﬂ vI

Colar: [ | Auto [

~Line Style

Style: [solid =l warker Jnone <] wign: 1
“Fill Style

swle: [soid 7]

Missing Data: Ihidden vI

Filter |

(0] Cancel Help

6 From the Metric Selection window,
a Click + to expand the WLSSPI RPT METRICS data source options tree.
b  Select the VALUE checkbox.
¢ Click OK.
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7 In the window with the Metrics tab selected, VALUE is displayed. Select the line on which

VALUE is displayed and click Properties. The Metric Properties window opens.

Metric Properties - WLSSPI_RPT_METRICS:WLSSPI_RPT_METRICS:V...
Label [@@SERVERNANE @e0BIECTHAME
Type: [table =]
¥ s [left =]
color [ Auto |

Line Style

Ste: [zoid =] marker | =] i |

Fill Stie

se: [soid ]
Mizsing Drata: Im Sum m
Instance; | a
Filter kSERVERMAME="G" &&0BJECTHAMES@ J

Qi Cancel | Help |

8 From the Metric Properties window,
a In the Label box, enter:

— @@SERVERNAME : @ROBJECTNAME if you are creating one graph with all
SERVERNAMEs

— @QOBJECTNAME if you are creating one graph with one SERVERNAME

b In the Marker drop-down list, select any marker other than none.

c¢ In the Missing Data drop-down list, select:

— previous to use the previous value if data is missing from the data source

— zero to use the value zero if data is missing from the data source
d Click - | next to the Filter box. The Metric Filter window opens.
(& Wetric Filter )
WETRICID = |z =] 1

0] 4 Cancel |

9  From the Metric Filter window,
a Select METRICID from the first drop-down list.
b  Select = from the second drop-down list (if it isn’t already selected).
¢ Enter a metric number (for example, 11) in the box.
d Click OK.
10 From the Metric Properties window,

a In the Filter box, append the following:
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— &&SERVERNAME=Q & &§OBJECTNAME=QQ if you want one graph to display all
SERVERNAME/OBJECTNAME combinations.

— &&SERVERNAME= “<server_name>"&&0BJECTNAME=Q if you want one graph to
display one SERVERNAME and all OBJECTNAMEs associated with the
multi-instance metric.

If you cannot edit the Filter box, you can edit this item in the graph template file.
Refer to step 13 on page 98 for more information.

b Click OK.
1 Click Save As at the top of the window. The Save As window opens.
rSave As -\
Farmily: | j
Catagony: | j
Marme: | j

Help

12 From the Save As window,

a Enter a family (for example, WLSSPI_Graphs) in the Family box. The family name
serves as a group to organize the graphs.

b Enter a name (for example, metric_11) in the Name box to uniquely identify the
graph.
¢ Entering text into the Category box is optional.

d Click OK. The information is saved in a graph template file named
VPI GraphsUser<family>.txt (for example,
VPI GraphsUserWLSSPI Graphs.txt).

For more information about this window, refer to the online help.
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13 Edit the graph template file. The file is located in the OpenView data directory on the
system of the OVPM instance on which you are working. The graph file may look similar
to the following:

#*************************k**k***************k***

#* OpenView Performance Manager
#* user Defined Graph Templates
#* Last Updated: 07/25/04 04:31_30 AM by [1.2.3.4] mool

#**********************************************

FAMILY: WLSSPI_Graphs

GRAPH: Metricll
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSEVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool

CLASS: WLSSPI_RPT_METRICS:WLSSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=@Q&&OBJECTNAME=@
LABEL: @QE@SERVERNAME :@QOBJECTNAME

COLOR: Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

GRAPH: Metricll_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool

CLASS: WLSSPI_RPT_METRICS:WLSSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11

LABEL: @QE@SERVERNAME :@QOBJECTNAME

COLOR:Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

There can be more than one set of data for a graph in the graph template file.

a Add SUMFROMRAW: at the end of the first section of each graph (in the example above,
add SUMFROMRAW: after SYSTEMNAME: mool). This allows OVPM to summarized data
from the data source and cannot be added using the GUI.

b  If you were unable to edit the Filter box in the Metrics Properties window in step 10
on page 96, edit the FILTER field.
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c¢ Save the file. The graph file now contains the following:

#*********************************************

#* OpenView Performance Manager

#* user Defined Graph Templates

#* Last Updated: 07/25/04 04:31_30 AM by [1.2.3.4] mool
#**********************************************
FAMILY: WLSSPI_Graphs

GRAPH: Metricll

GRAPHBACKGROUND: None

DATERANGE: 1 day

GRAPHMULTIPLEGRAPHS: Yes

POINTSEVERY: raw

DATASOURCE: mwa

SYSTEMNAME: mool

SUMFROMRAW :

CLASS: WLSSPI_RPT_METRICS:WLSSPI_RPT METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=@Q&&OBJECTNAME=@
LABEL: @E@SERVERNAME:@QOBJECTNAME

COLOR: Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

GRAPH: Metricll_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool
SUMFROMRAW :

CLASS: WLSSPI_RPT METRICS:WLSSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
LABEL: @@SERVERNAME:@EeOBJECTNAME

COLOR:Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:
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14 From the Performance Manager Java Interface window, click the Display tab.

Display | Design |
Select one or more sources to see a list of available araphs.
Sources: |indnidual Systems = | Graphs:
F 5 - &ImUsarMmkd
e | -5l UserPauline
- 83 HP-LK | | E-illi UserPauline Test
: [=-5ui WWebLogic SPI
Add. | Clear | Fird... | & Medric11
: Sor Wetric11_2 il
Systam Infarmation | -l test -
Duration; |1 fgays x| | |5minutes v
Ending: = How " Last [ Display graph in HTML

T Date: Time:
[ - foo: 004
Shift
[~ Cwerride Shift Defaults

gtart | 00: 004 Stop : 59 =] ™ Skio Holidays

Days W Sun W mon W Tue W0 W Thu W Fri B Sat

Helgp

15 In the Display tab window,

a Navigate to the server on which the data source resides (It is mentioned in the box

below the Sources box).

b In the Graphs box, navigate to the family of graphs and select the graph you created.

¢ Enter information into the Date Range dialog box and Points Every box.

d Click Draw. The graph opens. See Figure 17 on page 101.
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Figure 17 Graph
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) If you edit the graph from the Design tab, the SUMFROMRAW: entry is deleted from the graph
template file. You must edit the graph template file and re-enter this entry.

16 From the SPI, enable graphing

a From the OVO console, open the Node Bank window and select a node or groups of
nodes on which you want to enable graphing.

b From the Window menu, select Application Bank. The Application Bank window
opens.

c Select WLSSPI » WLSSPI Admin.
d Double-click UDM Graph Enable.
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6 Basic Troubleshooting and Error Messages

This chapter covers basic troubleshooting for the Smart Plug-in for BEA WebLogic Server and
error messages.

Using the Self-Healing Info Application

Preferred troubleshooting method: Troubleshooting information is enhanced with
cross-referencing capabilities available through the HP support site:
http:/support.openview.hp.com/self healing.jsp. To access this information and the
search capabilities available on the site, you must first download and configure the
Self-Healing Services client software. A link is then automatically set up to the self-healing
services web site, where your SPI problem can be matched to similar SPI problems and
solutions for increased troubleshooting effectiveness. For information on how to download,
configure, and use the software and its automatic link to the HP web site support service,
refer to the Self-Healing Services section in the HP OpenView Smart Plug-ins DVD
Installation Guide for UNIX.

Alternative troubleshooting method: If self-healing services is not installed or configured
on the node, you can use the Self-Healing Info application. This application also gathers SPI
troubleshooting data and stores it in a file that you submit to HP support for assistance. Refer
to Self-Healing Info on page 189 for more information about using this application.

) The file created by the Self-Healing Info application may be hidden on some Windows
managed nodes. If you do not see the file, open Windows Explorer and, from the Tools menu,
select Folder Options. Click the View tab. Under Hidden files and folders, select Show hidden
files and folders.
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Log and Trace Files

Management Server

The following log file is found on the management server (typically, /<%OQOuvInstallDir%>/ is

/var/opt/0V)

File Type

Filename

Description

UNIX Managed Nodes

Log

/<%O0vlInstallDir%>/wasspi/wls/log
<managed node> disc_ server.log

Records the updates done by the WLSSPI Discovery policy to the
management server’s configuration for each managed node. Log files
are overwritten each time the discovery policy is run on the managed
node. Logging to this file is always enabled.

The following log and trace files are found on the managed nodes running on UNIX (typically,
/<OvAgentDir>/ is /var/opt/0OV/ or /var/lpp/0OV/):

File Type
Filename

Description

File Type
Directory

Description

File Type
Directory

Description

Log
/<OvAgentDir>/1og/javaagent.log

OVO discovery agent log file containing the status of the OVO
discovery agent. By default, logging to this file is enabled at

LOG LEVEL 3. Set the LoG LEVEL variable in <OvAgentDir>/conf/
svcDisc/OvJavaAgent.cfg to 6 or higher (up to 9) to capture
troubleshooting information (the higher the number, the more
information is collected). To disable this log, set the LoG_LEVEL to 0.
Additional information can be configured in this file to define log file
size and the number of archived files kept. By default, the log file size
is 1MB and five archived versions are kept.

Log
/<OvAgentDir>/wasspi/wls/log/config.log
Records output from the WLS SPI configuration scripts.

Log
/<OvAgentDir>/wasspi/wls/log/errorlog

Records WLS SPI error messages. This log file is monitored by WLS
SPI policies.
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File Type
Directory

Description

File Type

Filename

Description

File Type

Directory

Description

File Type

Directory

Description

Basic Troubleshooting and Error Messages

Log
/<OvAgentDir>/wasspi/wls/log/wasspi wls discovery.log
Records output from the WLS SPI discovery process.

Trace

/<OvAgentDir>/wasspi/wls/log/wasspi wls discovery.trc
(archived files have a three digit number appended to the filename)

Discovery binary trace file used by your HP support representative.
By default, tracing to this file is enabled. To disable tracing, in
<OvAgentDir>/bin/instrumentation/

wasspi wls discovery.pl, set the $trace_on variable to 0. To
enable this trace, set the $trace_on to 1. When instrumentation is
deployed, the wasspi wls discovery.pl file is overwritten
(therefore, if you disable tracing, it becomes enabled when
instrumentation is deployed). Five archived versions are kept. A new
trace file is created when the discovery policy is run.

Trace

/<OvAgentDir>/wasspi/wls/log/trace.log (archived files have
a three digit number appended to the filename)

Trace file used by your HP support representative. This file gives
information about the CollectorServer, regardless of whether the
Collector is set to PERSISTANT or TRANSIENT mode in the
SPIConfig file. The default value of the Collector Mode is
'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.

Trace

/<OvAgentDir>/wasspi/wls/log/traceCollectorClient.log
(archived files have a three digit number appended to the filename)

Trace file used by your HP support representative. This file gives
information about the CollectorClient when the Collector is set to
'PERSISTENT' mode in the SPIConfig file. The default value of the
Collector Mode is 'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.
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Windows Managed Nodes

The following log and trace files are found on the managed nodes running on Windows
(typically, <OvAgentDir> is
\Program Files\HP OpenView\Installed Packages\{790...}\):

File Type
Filename

Description

File Type
Directory

Description

File Type
Directory

Description

File Type
Directory

Description

File Type

Filename

Description

Log
\<OvAgentDir>\1og\javaagent.log

OVO discovery agent log file containing the status of the OVO
discovery agent. By default, logging to this file is enabled at LoG LEVEL
3. Set the LoG LEVEL variable in
<OvlnstallDir>\conf\svcDisc\OvJavaAgent.cfg to 6 or higher
(up to 9) to capture troubleshooting information (the higher the
number, the more information is collected). To disable this log, set the
LOG_LEVEL to 0. Additional information can be configured in this file
to define log file size and the number of archived files kept. By default,
the log file size is 1MB and five archived versions are kept.

Log
\<QvAgentDir> \wasspi\wls\log\config.log

Records output from configuration scripts.

Log
\<OvAgentDir> \wasspi\wls\log\errorlog

Records WLS SPI error messages. This log file is monitored by WLS
SPI policies.

Log
\<OvAgentDir> \wasspi\wls\log\wasspi wls discovery.log
Records output from the WLS SPI discovery process.

Trace

\<OvAgentDir>\wasspi\wls\log\wasspi wls discovery.trc
(archived files have a three digit number appended to the filename)

Discovery binary trace file used by your HP support representative. By
default, tracing to this file is enabled. To disable tracing, in
\<%OvlInstallDir%>\bin\instrumentation)\

wasspi wls discovery.pl, set the $trace_on variable to 0. To
enable this trace, set the $trace_on to 1. When instrumentation is
deployed, the wasspi wls discovery.pl file is overwritten
(therefore, if you disable tracing, it becomes enabled when
instrumentation is deployed). Five archived versions are kept. A new
trace file is created when the discovery policy is run.
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File Type Trace

Directory \<OvAgentDir> \wasspi\wls\log\trace.log (archived files have a
three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives
information about the CollectorServer, regardless of whether the
Collector is set to PERSISTANT or TRANSIENT mode in the
SPIConfig file. The default value of the Collector Mode is
'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use the
Start Tracing application.

File Type Trace

Directory \<OvAgentDir>\wasspi\wls\log\traceCollectorClient.log
(archived files have a three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives
information about the CollectorClient when the Collector is set to
'PERSISTENT' mode in the SPIConfig file. The default value of the
Collector Mode is 'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.
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Troubleshooting the Discovery Process

Problem: The WLSSPI Discovery template does not automatically discover and update the
WLS SPI configuration.

Solutions:

1

10

Check for errors in the message browser of the managed nodes not being discovered.
Follow the instruction text of any error messages displayed.

Verify that a WebLogic application server is installed on the managed node. If an
application server is not installed, install an application server, and complete the
configuration tasks listed in Chapter 3, Configuring WLS SPI.

Verify the WebLogic application server status. The application server must be running.
See Task 1: Verify the Application Server Status on page 40 for more information.

Verify that the LOGIN and PASSWORD properties are set and that the WebLogic user
configured has the correct permissions. Refer to Chapter 3, Configuring WLS SPI for more
information.

On a Windows managed node, if the HKEY LOCAL MACHINE\\Software\\BEA
Systems\\BEAHOMELIST registry key does not exist, configure it, create the
file%SystemDrive%\BEA\beahomelist, or set the BEA_HOME_LIST property for that
managed node.

Verify the Java home directory (see Verifying the Java Home Directory on page 109).

If you are running WebLogic Server 7.0 or WebLogic Server 7.0 SP1 and did not save the
domain configuration file (for example, config.xml) in the default directory
(<BEA_Home_Dir>/user projects/<WebLogic_Domain_X>/, where
<BEA_Home_Dir> is the directory that contains the registry.xml file), then do one of
the following:

e Manually set the server using the Configure WLSSPI application.

e Manually configure ADMIN_PORTS, the port number(s) of the WebLogic Admin
server(s) listed in the domain configuration file, using the Configure WLSSPI
application. The global LOGIN and PASSWORD must be set for the node on which
these WebLogic Admin servers are running.

If you are running WebLogic Server 7.0 SP2 or higher and did not save the domain
configuration file (for example, config.xml) in the default directory (<BEA_Home_Dir>/
user projects/domains/<WebLogic_Domain_X>/, where <BEA_Home_Dir> is the
directory that contains the registry.xml file), then do one of the following:

e Manually set the server using the Configure WLSSPI application; or

e Manually set ADMIN_PORTS, the port number(s) of the WebLogic Admin server(s)
listed in the domain configuration file, using the Configure WLSSPI application. The
global LOGIN and PASSWORD must be set for the node on which these WebLogic
Admin servers are running.

If you are running WebLogic Server 6.1 and 8.1 on the same system, set the HOME
property.

On a UNIX managed node, verify that BEA_ HOME_LIST and HOME_LIST directory
path names do not include spaces. The discovery process currently does not support
spaces in directory names.
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N Verify that the Configure WLSSPI application is not running. Only one process can access
the configuration at a time. If Configure WLSSPI is running, other processes that must
access the configuration (like the discovery process) hang until the configuration becomes
available.

12 Check if the OVO management server is suppressing duplicate messages:

a From the OVO console, select Actions Server Configure. The Configure Management
Server window opens.

b  Look for the “Suppress and count duplicate messages” check box. If this box is
selected, clear it.

13 Restart the OVO management server:
a Stop all OVO GUIs that are running by selecting File = Exit.

b  Stop the OVO management server processes. Enter: /opt/OV/bin/ovstop opc
ovoacomm

¢ Delete all OVO temporary files. All pending messages (messages not saved in the
database) and all pending actions (automatic actions, operator-initiated actions,
scheduled actions, and command broadcast) are lost. Enter: rm -£f /var/opt/ov/
share/tmp/OpC/mgmt_sv/*

d Restart the OVO management server process. Enter: /opt/OV/bin/OpC/opcsv
-start/opt/OV/bin/OpC/opcsv -status

e Restart the OVO GUI. Enter: opc

¢ Problem: The WLSSPI Discover template is adding inaccurate information to the
configuration.

Solutions:

a Verify LOGIN and PASSWORD are correct. Refer to Task 2: Configure a WebLogic
Server User on page 40 for more information.

b Verify the Java home directory. Refer to Verifying the Java Home Directory on
page 109 for more information.

¢ Update the configuration and clear the AUTO_DISCOVER check box in the
configuration editor to prevent the WLSSPI-Discover template from overwriting the
configuration information.

Veritying the Java Home Directory

In order to successfully use the WLSSPI-Discover template, the Java home directory (on both
a Windows and UNIX managed node) must be configured correctly.

Although the WLSSPI-Discover template searches for this information, if they cannot find
this information or the information is not accurate, the WLSSPI-Discover template does not
function completely.

On each managed node on which you want to run the WLSSPI-Discover template, verify one
of the following (listed in the order of precedence used by the WLSSPI-Discover template):

e JAVA_HOME is correctly defined in the configuration. To edit or view the configuration,
launch the Configure WLSSPI application (for steps see Configure WLSSPI on page 186):

a In the configuration editor, set the JAVA_ HOME property. Refer to The Configuration
Editor on page 159 for more information about using the configuration editor.
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b  Click Save to save the changes made to the configuration. Once you save your changes,
you cannot automatically undo them.

c¢ Click Finish or Next to save any changes and exit the editor.

If you click Next, the Confirm Operation window opens. Click OK.

) If you click Cancel in the Confirm Operation window, the changes made to the
configuration remain in the configuration on the management server. To make the
changes to the selected managed nodes’ configuration, you must select those nodes
in the Node Bank window, launch the Discovery application, click Next in the
configuration editor, and then click OK in the Confirm Operation window.

d Launch the Discover WebLogic application on the managed nodes on which the
JAVA_HOME property was added or edited. Running the Discover WebLogic
application updates the service map.

e Java is installed in each of the BEA home directories (each directory listed in the file
beahomelist).

e The JAVA_HOME system variable is correctly defined.
On a Windows managed node, do the following:
a From the Start menu, select Settings = Control Panel.
b Double-click System.
c Select the Advanced tab.
d Select Environment Variables...

e Scroll through the System variables list. Verify the JAVA_HOME value. If
JAVA_HOME does not exist, it is not defined.

On a UNIX managed node, do the following:
a Type echo $JAVA HOME
b Verify the output. If no output is returned, JAVA_HOME is not defined.
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Troubleshooting the Configuration

e Problem: The WLS SPI configuration does not have complete or accurate information for
a WebLogic managed server.

Solution: Verify LOGIN and PASSWORD are correct. Refer to Task 2: Configure a
WebLogic Server User on page 40 for more information. This is the most common reason
for incorrect information for a WebLogic managed server running on a remote node (not
running on a OVO managed node).

e Problem: The WLSSPI-Discover template overwrites the configuration with inaccurate
information.

Solution: Update the configuration and clear the AUTO_DISCOVER check box in the
configuration editor to prevent the WLSSPI discover template from overwriting the
configuration information.

e Problem: The Server status is unknown (down) message appears in the message
browser, but the server is running.

Solution: Check that you have correctly set the PORT, PROTOCOL, and PASSPHRASE
(if required) properties:

— Verify that PROTOCOL is set to one of two values: t3 (for non-SSL) or t3s (for SSL).

— If the application server is using SSL, verify that the PORT is set to a valid SSL port
number and that PROTOCOL is set to t3s.

— If the application server is not using SSL, verify that the PORT is set to a valid
non-SSL port number and that PROTOCOL is set to t3.

— If the keystore has a password defined, re-set the PASSPHRASE in case it has been
typed wrong.
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Troubleshooting the Applications

Problem: Configuration variable SERVER<n> START CMD missing for server "Default
Server"

Solution: Before you can successfully launch the Start WebLogic application, you must
set the START_CMD and USER properties. Set these properties using the Configure
WLSSPI application. Refer to Configure WLSSPI on page 186 for more information about
this application.

Problem: Configuration variable SERVER<n> STOP CMD missing for server "Default
Server"

Solution: Before you can successfully launch the Stop WebLogic application, you must set
the STOP_CMD and USER properties. Set these properties using the Configure WLSSPI
application. Refer to Configure WLSSPI on page 186 for more information about this
application.

Problem: When launched, the Verify application gives improper output.

Solution: Before you launch the Verify tool ensure that you have installed the latest
version of Self-Healing Service (SHS) component (version 2.20) from the SPI CD. If you
upgrade WLS SPI without the SPI CD then you must upgrade the SHS component also.
You can download the SHS component from

http://support.openview.hp.com/self healing_downloads.jsp.

Problem: When launched, the Self-Healing Info application gives improper output.

Solution: Ensure that you have installed the latest version of Self-Healing Service (SHS)
component (version 2.20) from the SPI DVD. If you have upgraded WLS SPI without the
SPI DVD then you must upgrade the SHS component also. You can download the SHS
component from

http://support.openview.hp.com/self healing_downloads.jsp.

Problem: Check WebLogic tool shows a wrong status for a server instance or does not
give any output.

Solution: If a server is up and running but Check WebLogic application returns the
server status as NOT_RUNNING (or does not give any output), then turn ON the
monitoring for that particular server by using the Start Monitoring application.

Problem: When launching the applications, the applications hang or there is no output.

Solution: The tools will not work if the memory is low. Check the performance of the node
and the management server. The physical memory available must be more than 500 MB.

Problem: View WebLogic Log application lists duplicate (redundant) log file names.

Solution: This problem occurs if there are duplicate entries in the SiteConfig file.
Relaunch the Configure WLSSPI application to remove the duplicate entries.

Problem: Datasource not getting created on RHEL 4.0 platform.

Solution: Ensure that you have installed the latest version of DSI2DDF component
(02.22.000) from the SPI DVD. If you have upgraded WLS SPI without the SPI DVD, then
you must upgrade the DSI2DDF component also. You can get the latest DSI2DDF
component from:

ftp://ovrntfs.rose.hp.com/prelim/dsi2ddf/02.22/HPUX11.00/
DSI2DDF_A.02.22.00.sdtape
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Error Messages

This section provides detailed information on error messages resulting from conditions
detected in the operation of the Smart Plug-in for BEA WebLogic Server (WLS SPI) and not
the WebLogic Server. The error messages discussed in this section, therefore, belong to the
WLSSPI Message Group.

In the figure below, the last two messages are a result of errors in the operation of WLS SPI.
These errors are identified as belonging to the WLSSPI Message Group (see the MsgGroup
column in the illustration below).

o wctive Messages ® autoserall 0

GHN | Highlight | petatls.. . | perform acTien | | amwrations. .. | ackiowled

For any given problem, only the most recent error message is displayed (the older error
message is automatically acknowledged). This reduces the number of error messages
displayed in the message browser.

WASSPI-]

Description | Unable to create the lock file <filename>. File already exists.
Severity Critical
Help Text Probable Cause

Temporary lock files are used to avoid collisions when multiple WebLogic SPI data collector
processes attempt to access the same data file. This error occurs when the lock file could not
be created after several attempts because it already exists.

Suggested Action

If a file by the same name already exists, it may not have been deleted by a previous run of the
WebLogic SPI data collector. You should delete this file manually.
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WASSPI-2

Description |Cannot access the SPI configuration.

Severity Critical

Help Text Probable Cause

A WebLogic SPI configuration file could not be located or accessed. Either they do not exist or
there was a problem reading the files.

Suggested Action

1 Verify that the schedule template that runs the WebLogic SPI data collector specifies the
correct directory on the command line. The option
-Dwasspi.config.dir=<configDirectory> must be specified on command line invocation of
the data collector. <configDirectory> must be /var/opt/0V/wasspi/wls/conf on Unix
platforms or /usr/0OV/wasspi/wls/conf on NT platforms.

2 Verify that the WebLogic SPI has been configured correctly by running the Verify utility
from the Application Bank. If the configuration is not correct, run the WebLogic SPI
configuration utility from the Application Bank to reinstall the files.

3 Refer to the text following the error message in the WebLogic SPI error log to help identify
the underlying cause of the problem, e.g. an I/O exception. You can view the SPI error log
for a managed node by using the View Error File application in the Application Bank
window. You can view the SPI error log for a managed node by using the 'View Error File'
application in the Application Bank window. The error message can be identified by the
date/time stamp.

WASSPI-3

Description |Error parsing command line.

Severity Critical

Help Text Probable Cause
The WebLogic SPI data collector command line is incorrectly specified in a schedule template.
Suggested Action

1 Refer to the text following the error message in the WebLogic SPI error log to help identify
the data collector command line syntax error. You can view the SPI error log for a managed
node by using the View Error File application in the Application Bank window. The error
message can be identified by the date/time stamp.

2 Ifthe error occurred in a schedule template that shipped with the WebLogic SPI, reinstall
the SPI and run the WebLogic SPI configuration utility from the Application Bank

3 Ifthe error occurred in a schedule template not shipped with the WebLogic SPI, correct the
schedule template that contains the incorrect command line. Refer to the WebLogic SPI
User's Guide for more information on the WebLogic SPI data collector command line.
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WASSPI-4

Description | Error getting the metric definitions.
Severity Critical
Help Text Probable Cause

The WebLogic SPI data collector could not read the metric definitions XML document. This
error can be caused by a missing configuration property, an I/O error, an XML parsing error, a
missing file, or a corrupted serialized data file.

Suggested Action

1 Refer to the text following the error message in the WebLogic SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node by
using the View Error File application in the Application Bank window. The error message
can be identified by the date/time stamp.

2 Ifthe METRIC_DEFINITIONS_FILE property is missing from the WebLogic SPI
configuration file, reinstall the SPI and run the SPI configuration utility from the
Application Bank.

3 Ifthe problem is with the metric definitions file (MetricDefinitions.xml) that is shipped
with the WebLogic SPI, then reinstall the WebLogic SPI. Run the SPI configuration utility
from the Application Bank.

4 If the problem is with a user-defined metric definitions file that is not shipped with the
WebLogic SPI, verify that this XML file adheres to the MetricDefinitions.dtd specification.
Refer to the WebLogic SPI's User's Guide for more information on writing user-defined
metrics. Reinstall your user-defined metric definition file. Run the SPI configuration
utility and verify that the UDM_DEFINITIONS_FILE property in the SPI configuration
file, is specified correctly.

5 1If the underlying error is ClassNotFound, then this is an internal error. Report this to HP
support.

WASSPI-5

Description | Error processing metric <metric_number>.
Severity Major
Help Text Probable Cause

An error occurred while trying to collect data or perform calculations for the specified metric.
Suggested Action

Refer to the text following the error message in the WebLogic SPI error log to help identify the
underlying cause of the problem. The error messages previous to this one may also provide
more information about the problem. You can view the SPI error log for a managed node by
using the View Error File application in the Application Bank window. The error message can
be identified by the date/time stamp.
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WASSPI-6

Description |Required property <property_name> is missing from the WebLogic SPI configuration.
Severity Major
Help Text Probable Cause

1

The specified required property is missing from the WebLogic SPI configuration file.
Suggested Action

Run the WebLogic SPI configuration utility from the Application Bank. Verify that you
have specified the correct server information for the WebLogic servers on this managed
node.

Verify the property is specified correctly in the WebLogic SPI configuration file (/var/
opt/OV/wasspi/wls/confSiteConfig on Unix platforms or /usr/0OvV/wasspi/wls/
confSiteConfig on NT platforms) on the managed node in question.

WASSPI-7

Description | Unable to contact server <server_name> at url=<URL>, port=<port>.
Severity Critical
Help Text Probable Cause

The specified server is not running at the specified port.

Suggested Action

1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you
have specified the correct server name and port information for the WebLogic servers on
this managed node.

2 Verify that the properties, SERVERx_ NAME and SERVERx_PORT, are specified correctly
in the WebLogic SPI configuration file (/var/opt/0OV/wasspi/wls/conf SiteConfig
on Unix platforms or /usr/0vV/wasspi/wls/confSiteConfig on NT platforms) on the
managed node in question.

3 Verify that the WebLogic server is running on the managed node.
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WASSPI-8

Description | Error saving graphing or reporting data to file <file_name>.

Severity Critical

Help Text Probable Cause

If the error message specifies the reporting data file, the agent on the managed node may be
in an inconsistent state.

Suggested Action
Restart the agent on the managed node.
Probable Cause

The specified graphing or reporting data file could not be found or an I/O error occurred when
trying to access the file.

Suggested Action

1 Refer to the text following the error message in the WebLogic SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node by
using the View Error File application in the Application Bank window. The error message
can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

Turn on tracing and reproduce the problem. Refer to the WebLogic SPI User's Guide for
instructions on how to turn on tracing.

Run the Gather Info application.

5 Contact HP support with the information gathered in the previous steps.

WASSPI-9

Description | Unable to retrieve property <property_name>.

Severity Critical

Help Text Probable Cause
A required property is missing from one of the WebLogic SPI configuration files.
Suggested Action

1 Refer to the text following the error message in the WebLogic SPI error log to help identify
the missing property. You can view the SPI error log for a managed node by using the View
Error File application in the Application Bank window. The error message can be
identified by the date/time stamp.

2 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you
have specified the correct information for the WebLogic servers on the managed node in
question.

3 Verify that the missing property is now specified in the WebLogic SPI configuration file (/
var/opt/0OV/wasspi/wls/conf SiteConfig on Unix platforms or /usr/0V/wasspi/
wls/confSiteConfig on NT platforms) on the managed node in question.
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WASSPI-10

Description |Encountered problem accessing file <filename>.
Severity Critical
Help Text Probable Cause

The specified file could not be found, created, or accessed. This file could be a temporary file.
Suggested Action

1 Refer to the text following the error message in the WebLogic SPI error log to help identify
the file in question and the underlying cause of the problem. You can view the SPI error log
for a managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

2 Verify that you have enough disk space to create temporary files.

WASSPI-11

Description |No servers have been specified in the WebLogic SPI configuration file.
Severity Major
Help Text Probable Cause

The number of WebLogic servers specified in the WebLogic SPI configuration for the managed
node in question is 0.

Suggested Action

1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you
have specified the correct server name and port information for the WebLogic servers on
this managed node.

2 Verify that the property, NUM_SERVERS, in the WebLogic SPI configuration file (/var/
opt/OV/wasspi/wls/conf SiteConfig on Unix platforms or /usr/0V/wasspi/wls/
confSiteConfig on NT platforms) is set to the number of WebLogic servers on this
managed node.

WASSPI-12

Description

Command <command> returned error exit code <exit code>.

Severity

Critical

Help Text

Probable Cause

A command started by the WebLogic SPI collector has returned an error (non-zero) exit code.
Suggested Action

1 Identify the steps to reproduce the problem.

2 Turn on tracing and reproduce the problem. Refer to the WebLogic SPI User's Guide for
instructions on how to turn on tracing.

3 Run the Gather Info application.
Contact HP support with the information gathered in the previous steps.
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WASSPI-13

Description |Exception occurred while running an opcmon process.
Severity Critical
Help Text Probable Cause

The WebLogic SPI data collector attempted to run a process to execute an opcmon call. Either
the process could not be created or was interrupted.

Suggested Action

For UNIX systems, make sure the kernel configurable parameters NPROC and MAXUPRC
are set high enough to allow process creation.

WASSPI-14

Description | Unable to find file <filename>.

Severity Critical

Help Text Probable Cause
A file required by the WebLogic SPI data collector could not be found.
Suggested Action

1 Refer to the text following the error message in the WebLogic SPI error log to help identify
the file in question and the underlying cause of the problem.You can view the SPI error log
for a managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

Reinstall the WebLogic SPI on the managed node.

Run the WebLogic SPI configuration utility from the Application Bank.

WASSPI-15

Description |Error parsing XML document <filename>.
Severity Critical
Help Text Probable Cause

An error occurred while parsing the specified XML document.
Suggested Action

1 Refer to the text following the error message in the WebLogic SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node by
using the View Error File application in the Application Bank window. The error message
can be identified by the date/time stamp.

2 If the XML document was provided by the user, correct the document. Refer to WebLogic
SPI User's Guide for more information about the correct format for a user-defined metric
definition document.

3 Ifthe XML document is a document that is shipped with the WebLogic SPI, run the SPI
configuration utility from the Application Bank to reinstall the WebLogic SPI

configuration files.
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WASSPI-16

Description | A bad filter was specified for metric <metric_number>.
Severity Major
Help Text Probable Cause

A metric filter is incorrectly specified in the metric definitions XML document.
Suggested Action

1

If the metric is specified in an XML document that was provided by the user, correct the
document. Refer to WebLogic SPI User's Guide for more information about the correct
format for a user-defined metric definition document.

If the metric is a pre-defined metric that is shipped with the WebLogic SPI, run the SPI
configuration utility from the Application Bank to reinstall the WebLogic SPI
configuration files.

WASSPI-17

Description

Could not access MBean server on server <server_name> at url=<URL>,
port=<port_number>.

Severity

Critical

Help Text

Probable Cause

A problem occurred while the WebLogic SPI data collector was requesting access to the JMX
MBean server on the WebLogic server. This could be caused by:

1
2

3

The JNDI lookup to find the JMX MBean server in the application server failed.

The login name specified in the WLS SPI configuration does not have the correct
permissions in the application server.

The password specified in the WebLogic SPI configuration file is incorrect.

Suggested Action

1

Refer to the text following the error message in the WebLogic SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node by
using the View Error File application in the Application Bank window. The error message
can be identified by the date/time stamp.

Run the WebLogic SPI configuration utility from the Application Bank. Verify that the
login name and password are correct for the server in question.

In the WebLogic Administration Console, verify that the user is a valid WebLogic user and
has the correct permissions. To set the correct permissions, refer to the WebLogic SPI
User's Guide.

In the WebLogic Administration Console, verify that the MBean server
(weblogic.management .home.<server_name>) is in the JNDI tree of the server in
question. Right-click the server in the left pane to view the JNDI tree. If it is not there,
restart the WebLogic server.
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WASSPI-18

Description

Error logging to datasource <datasource_class_name>. Logging process returned exit code
<exit_code>.

Severity

Warning

Help Text

Probable Cause

The agent on the managed node may be in an inconsistent state.

Suggested Action

Restart the agent on the managed node.

Probable Cause

The ddflog process started by the WebLogic SPI data collector returned a non-zero error code.
Suggested Action

1 Identify the steps to reproduce the problem.

2 Turn on tracing and reproduce the problem. Refer to the WebLogic SPI User's Guide
Tracing for instructions on how to turn on tracing.

3 Run the 'Gather Info' application.

Contact HP support with the information gathered in the previous steps.

WASSPI-19

Description | Encountered problem instantiating XSLT transformer with <filename>.
Severity Major
Help Text Probable Cause

The XSL document that specifies the auto action report output contains errors.
Suggested Action

1 Reinstall the WebLogic SPI.

2 Run the WebLogic SPI configuration utility from the Application Bank.

WASSPI-20

Description | Encountered problem creating report for metric <metric_number>.
Severity Major
Help Text Probable Cause

An error occurred while producing a text report for the specified metric.
Suggested Action

1 Reinstall the WebLogic SPI.

2 Run the WebLogic SPI configuration utility from the Application Bank.
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WASSPI-21

Description | Encountered problem instantiating factory implementation '<class name>'.
Severity Critical
Help Text |Probable Cause

The java property specifying the class name is incorrect or the class does not implement the
AppServerFactory interface.

Suggested Action

Verify that the java property appserver.implementation is set to the fully qualified name of
the class which implements the AppServerFactory interface.

For example, if set on the java command-line:

-Dappserver.implementation=com.hp.openview.wasspi.WLSAppServerFactory

WASSPI-23

Description

Error initializing collector analyzer for server <server_name>.

Severity

Critical

Help Text

Probable Cause
An exception was encountered while preparing to monitor server <server_name>
Suggested Action

1 Refer to the text following the error message in the WebLogic SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node by
using the View Error File application in the Application Bank window. The error message
can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

3 Turn on tracing and reproduce the problem. Refer to the WebLogic SPI User's Guide for
instructions on how to turn on tracing.

Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.
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WASSPI-24

Description | Error logging in to server <server_name> with login <login>.
Severity Critical
Help Text Probable Cause

A security exception occurred while logging in to server <server_name>.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank.

2 Verify that you have specified the correct login and password on the managed node on
which the error occurred.

3 Verify the login has appropriate permissions.

WASSPI-26

Description | The data logging process for <server_name> timed-out.
Severity Major
Help Text Probable Cause

Depending on your configuration, either OVPA or CODA failed to exit before the time-out.

Suggested Action
1 Restart CODA using the command opcagt -start.
2 Restart OVPA using the command mwa restart.
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WASSPI-27

Description | RMI collector unable to process <command>.
Severity Warning
Help Text Probable Cause

An exception was encountered while performing an rmid related operation.
Suggested Action

1 Refer to the text following the error message in the WebLogic SPI error log to help identify
the underlying cause of the problem. You can view the SPI error log for a managed node by
using the View Error File application in the Application Bank window. The error message
can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

Turn on tracing and reproduce the problem. Refer to the WebLogic SPI User's Guide for
instructions on how to turn on tracing.

Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.

WASSPI-30

Description |Failed to start <rmid_path> on port <port>.
Severity Critical
Help Text Probable Cause

The specified path is already in use.
Suggested Action

Run the WebLogic SPI configuration utility from the Application Bank. Set the RMID_PORT
property to a port number which is not currently in use.

WASSPI-31

Description |Lost connection to RMI collector while processing <command>.
Severity Warning
Help Text N/A

WASSPI-32

Description | Unable to retrieve metadata for mbean <JMX-ObjectName>.

Severity Warning

Help Text N/A
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WASSPI-33

Description |No actions matched server <server name>, version <version>.
Severity Warning
Help Text Probable Cause

JMXAction element(s) define FromVersion and ToVersion tags which do not match the server
version.

Suggested Action

If the action is valid on the server, then either adjust the JMXAction definition's FromVersion/
ToVersion elements or the server's VERSION property.

WASSPI-34

Description | Metric <metric id> does not define any actions.
Severity Warning
Help Text Probable Cause

The metric ID specified with the action -m option does not define a JMXActions element.
Suggested Action

Correct the action -m option if an incorrect metric ID was specified. Otherwise, add a
JMXActions definition to the metric definition.

WASSPI-35

Description | Error executing action <action command-line>.
Severity Major
Help Text Probable Cause

An unexpected error occured while executing the action.
Suggested Action

View the managed node's errorlog to determine the root cause which is logged following the
error message.

WASSPI-36

Description

MBean <JMX objectname> on server <server name>, does not expose operation
<operation name>.

Severity

Warning

Help Text

Probable Cause

An action's JMXCalls element defines an operation not exposed by the specified MBean.
Suggested Action

Correct the JMXCalls element or remove the operation from the element.
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WASSPI-37

Description | MBean <JMX objectname> on server <server name>, does not expose attribute
<attribute name> for write.

Severity Warning

Help Text Probable Cause

An action's JMXCalls element defines a write attribute exposed by the specified MBean as
read-only.

Suggested Action

If it is a custom MBean, update the MBean's management interface so the attribute is
writable. Otherwise, remove the attribute definition from the JMXCalls element.

WASSPI-38

Description | MBean <JMX objectname> on server <server name>, does not expose attribute
<attribute name>.

Severity Warning

Help Text Probable Cause

An action's JMXCalls element defines an attribute not exposed by the specified MBean
ObjectName.

Suggested Action
Correct the JMXCalls element or remove the attribute from the element.

WASSPI-39

Description |Error invoking operation <operation name> on MBean <JMX objectname>.

Severity Major

Help Text Probable Cause

An unexpected error occurred while invoking an operation on the specified MBean. The
managed resource may have thrown an exception.

Suggested Action

View the managed node's errorlog to determine the root cause which is logged following the
error message.
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WASSPI-40

Description | Error setting attribute <attribute name> on MBean <JMX objectname>.
Severity Major
Help Text Probable Cause

An unexpected error occurred while setting an attribute on the specified MBean. The
managed resource may have thrown an exception.

Suggested Action

View the managed node's errorlog to determine the root cause which is logged following the
error message.

WASSPI-41

Description |Error getting attribute <attribute name> from MBean <JMX objectname>.
Severity Major
Help Text Probable Cause

An unexpected error occurred while getting an attribute from the specified MBean. The
managed resource may have thrown an exception.

Suggested Action

View the managed node's errorlog to determine the root cause which is logged following the
error message.

WASSPI-42

Description |Error running command <command>.
Severity Critical
Help Text Probable Cause

A command started by the WebLogic SPI collector reported an error.
Suggested Action
1 Identify the steps to reproduce the problem.

2 Turn on tracing and reproduce the problem. Refer to the WebLogic SPI User's Guide for
instructions on how to turn on tracing.

3 Run the Gather Info application.
4 Contact HP support with the information gathered in the previous steps.
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WASSPI-43

Description |Error publishing event <event-type>.
Severity Major
Help Text Probable Cause

An unexpected error occurred while a publisher was handling a metric or collect event.
Suggested Action

View the managed node's errorlog to determine the root cause which is logged following the
error message.

WASSPI-201

Description |File <filename> not found.
Severity Critical
Help Text Probable Cause

A configuration file could not be found.
Suggested Action

Run the WebLogic SPI configuration utility from the Application Bank. Verify that the correct
information has been specified for the WebLogic servers on the managed node on which the
error occurred.

WASSPI-202

Description

Cannot read file <filename>.

Severity

Critical

Help Text

Probable Cause

1 A file could not be opened or it could not be found.

2 Permissions may be incorrect or a directory may be corrupt.
Suggested Action

1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that the
correct information has been specified for the WebLogic servers on the managed node on
which the error occurred.

2 Verify that the permissions are correct for the ITO user to read this file.
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WASSPI-203

Description |Cannot write file <filename>.
Severity Critical
Help Text Probable Cause

Permissions may be incorrect, or a file or directory may be corrupt.
Suggested Action

1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that the
correct information has been specified for the WebLogic servers on the managed node on
which the error occurred.

2 Verify that the permissions are correct for the ITO user to write this file.

WASSPI-204

Description |Error sending opcmsg <message>.
Severity Critical
Help Text Probable Cause

There was a problem running opcmsg. opcmsg may be missing or not have permissions to
execute (ITO installation errors) or the system process table may be full.

Suggested Action
1 Confirm that ITO is properly installed and deployed to the managed node.

Ensure that the process table is not full. If it is, consider having the system administrator
increase it.
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WASSPI-205

Description |Error sending opcmon <command>.
Severity Critical
Help Text Probable Cause

There was a problem running opcmon. opcmon may be missing or not have permissions to
execute (ITO installation errors) or the system process table may be full.

Suggested Action
1 Confirm that ITO is properly installed and deployed to the managed node.

Ensure that the process table is not full. If it is, consider having the system administrator
increase it.

WASSPI-206

Description | Cannot read directory <directory>.
Severity Critical
Help Text Probable Cause

The permissions on the directory prevent the ITO user from reading it or the directory is
corrupt.

Suggested Action
Verify that the permissions are correct for the ITO user for this directory.

WASSPI-207

Description

Cannot move <filename> to <filename>.

Severity

Critical

Help Text

Probable Cause

1 Insufficient permissions.

2 Insufficient disk space.

3 File table problems.

Suggested Action

1 Verify that the permissions are correct for the ITO user.

2 Verify that there is enough disk space to create files.

3 Run the WebLogic SPI configuration utility from the Application Bank.
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WASSPI-208

Description | WebLogic SPI must be configured before it can be used.
Severity Critical
Help Text Probable Cause

The WebLogic SPI has not been configured on this node.
Suggested Action

1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you
have specified the correct information for the WebLogic servers on the managed node on
which the error occurred.

2 Run the Verify utility from the application band to confirm that the SPI has been
successfully configured.

WASSPI-209

Description | Cannot contact WebLogic Server.
Severity Critical
Help Text Probable Cause

1 The server could be down or not responding.

2 The WebLogic SPI may be configured incorrectly.
Suggested Action

1 Verify that the WebLogic Server is up and running properly.

2 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you
have specified the correct information for the WebLogic servers on the managed node on
which the error occurred.

WASSPI-210

Description | Cannot configure the SPI.
Severity Critical
Help Text Probable Cause

The SPI configuration process failed.
Suggested Action

1 Refer to the text following the error message in the WebLogic SPI error log to help identify
the underlying cause of the problem. The error messages previous to this one will provide
more information about the problem. You can view the SPI error log for a managed node by
using the View Error File application in the Application Bank window. The error message
can be identified by the date/time stamp.

2 Reinstall the WebLogic SPI and run the WebLogic SPI configuration utility from the
Application Bank.
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WASSPI-211

Description | Cannot create directory <directory>.
Severity Critical
Help Text Probable Cause

There are insufficient permissions for the ITO user to create the directory or there is
insufficient disk space.

Suggested Action

Verify that the permissions are correct for the ITO user for this directory. Verify that there is
enough disk space.

WASSPI-212

Description | WLS-5 monitor running on this node but no WLS-5 servers configured
Severity Critical
Help Text Probable Cause

The ITO template for WebLogic 5 is assigned to a node but the SPI configuration does not
indicate that any WebLogic 5 servers are located on this node.

Suggested Action
1 If there are no WebLogic 5 server located on this node, unassign the WebLogic 5 templates
from this node and redeploy ITO to the managed node.

2 Ifthere is a WebLogic 5 server located on this node, run the WebLogic SPI configuration
utility from the Application Bank and specify the correct information in the configuration.

WASSPI-213

Description | Improper parameters to program <name>. Usage: <usage>.
Severity Critical
Help Text Probable Cause
The parameters to the program are incorrect.
Suggested Action
Correct the parameters.
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WASSPI-214

Description | Cannot run program <program_name>.
Severity Critical
Help Text Probable Cause

The program failed to run. It may be missing, permissions may be incorrect, or the process
table may be full.

Suggested Action

1 Verify that the file exists. If it is a SPI program and the file is missing, reinstall the
WebLogic SPI and run the WebLogic SPI configuration utility from the Application Bank.

2 Verify that the permissions are correct for the ITO user.

WASSPI-215

Description | A WebLogic Server was not found in <directory>.
Severity Critical
Help Text Probable Cause

The directory specified as WL_HOME in the WebLogic SPI configuration does not exist on the
managed node.

Suggested Action
1 Verify that a WebLogic Server is installed on the managed node.

2 Run the WebLogic SPI configuration utility from the Application Bank. Verify that the
correct information has been specified for WL_HOME on the managed node on which the

error occurred.

WASSPI-216

Description | Configuration variable <name> missing for server <server_name>.
Severity Critical
Help Text Probable Cause

A required SPI configuration property was not found.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank.

2 Verify that the correct information has been specified in the configuration for the managed
node on which the error occurred.
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WASSPI-218

Description | WebLogic monitoring has been turned OFF for <server_name>.
Severity Warning
Help Text Probable Cause

Collection has been turned off for the specified server.

Suggested Action

If desired, collection can be turned on by setting COLLECT = ONin the SiteConfig file in the
WebLogic SPI configuration directory on the managed node. The configuration directory is

/var/opt/0V/wasspi/wls/conf/ or /var/opt/0OV/conf/wls/ on UNIX platforms or
\usr\OV\wasspi\wls\conf\ on Windows platforms.

WASSPI-219

Description

WebLogic monitoring has been turned ON for <server_name>.

Severity

Warning

Help Text

Probable Cause

Collection has been turned on for the specified server.

Suggested Action

If desired, collection can be turned off by setting COLLECT = OFF in the SiteConfig file in
the WebLogic SPI configuration directory on the managed node. The configuration directory is

/var/opt/OV/wasspi/wls/conf/ or /var/opt/0OV/conf/wls/ on UNIX platforms or
\usr\OV\wasspi\wls\conf\ on Windows platforms.
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WASSPI-220

Description | This feature only applies to WebLogic 5.1.
Severity Warning
Help Text Probable Cause

User attempted to perform a function on a WebLogic 6 server that only applies to WebLogic 5
servers.

Suggested Action

This function can only be performed on a WebLogic Server version 6.0 and above.

WASSPI-221

Description |<filename> does not exist.
Severity Critical
Help Text Probable Cause

The specified file does not exist. If it is a log file, no entries have ever been logged to it. If it is
a property file, then it has not been configured.

Suggested Action

e Log files - If there have never been any entries written to the file, no action is necessary.
Otherwise, run the WebLogic SPI configuration utility from the Application Bank.

e Property files - Run the WebLogic SPI configuration utility from the Application Bank.

WASSPI-222

Description |<filename> is empty.
Severity Critical
Help Text Probable Cause

The specified file is empty. If it is a log file, no entries have ever been logged to it, or the
entries have been cleaned out. If it is a property file, then it is not properly configured.

Suggested Action

If the file is a configuration file, run the WebLogic SPI configuration utility from the
Application Bank.
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WASSPI-223

Description |Cannot read <filename>.
Severity Critical
Help Text Probable Cause

1 A file could not be opened or it could not be found.
2 Permissions may be incorrect or a directory may be corrupt.
Suggested Action

1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you
have specified the correct information for the WebLogic servers on the managed node on
which the error occurred.

2 Verify that the permissions are correct for the ITO user to read this file.

WASSPI-224

Description | ddfcomp returned an error configuring <name>.
Severity Warning
Help Text Probable Cause

ddfcomp returned an error. This could be because neither MeasureWare nor CODA is
installed on the system or because an error occurred while configuring the performance agent.

Suggested Action
1 If the performance agent is not installed, this error can be ignored.
2 Otherwise, identify the steps to reproduce the problem.

3 Turn on tracing and reproduce the problem. Refer to the WebLogic SPI User's Guide for
instructions on how to turn on tracing.

Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.

WASSPI-225

Description | No logfiles were found. Did you run Configure WLSSPI?
Severity Critical
Help Text Probable Cause
The logfile list is empty.
Suggested Action
Reinstall the SPI and run the WebLogic SPI configuration utility from the Application Bank.
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WASSPI-226

Description |Cannot read file <filename>.
Severity Critical
Help Text Probable Cause

1 A file could not be opened or it could not be found.

2 Permissions may be incorrect or a directory may be corrupt.
Suggested Action

1 Run the WebLogic SPI configuration utility from the Application Bank.

2 Verify that you have specified the correct information for the WebLogic Servers on the
managed node on which the error occurred.

3 Verify that the permissions are correct for the ITO user to read this file.

WASSPI-227

Description | No OpenView performance agent is installed. Data source will not be configured.
Severity Warning
Help Text Probable Cause

If an OpenView performance tool is available, the SPI will integrate with it. This warning
indicates that none is available.

Suggested Action

If you should have a performance agent installed, verify that it is installed correctly and is
running; reinstall it if necessary. Otherwise, this message can be ignored.

WASSPI-228

Description |ddflog returned an error logging <logfile-name>: <system-error-msg>
Severity Critical
Help Text Probable Cause

The agent on the managed node may be in an inconsistent state.
Suggested Action

Restart the agent on the managed node.

Probable Cause

ddflog returned an error. This could be because the SPI was not properly configured to
support logging performance data.

Suggested Action
1 Try reconfiguring WLS SPI on the node having the problem.
2 Otherwise, examine the system error message, if any, for clues to the problem.

3 Turn on tracing and reproduce the problem. Refer to the WebLogic SPI User's Guide for
instructions on how to turn on tracing.

4 Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.
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WASSPI-229

Description | Cannot connect to directory <directory_name>
Severity Critical
Help Text Probable Cause

The directory does not exist or the user, the agent is running under, does not have appropriate
permissions to the directory.

Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank.
2 Reinstall the SPI and run the WebLogic SPI configuration.

WASSPI-230

Description | Cannot get lock <filename> after <time-interval>
Severity Critical
Help Text Probable Cause

The lock file <file> was not cleared in the <time> indicated. This could be due to a very slow
running or hung SPI process. Also could be a SPI process that had a lock was killed before the
lock it had open had been cleared.

Suggested Action
Make sure no SPI processes are running. Manually remove the lock file.

WASSPI-23]

Description |Error starting JRE <JVM_file>: <message>

Severity Critical

Help Text Probable Cause
Some error occurred starting Java. This could be that the specified JVM does not exist, has
bad permissions, or that there are system resource limitations such as process table entries or
memory, or that the JAVA_HOME variable in the SPI SiteConfig file is not set correctly.
Suggested Action
Check your JAVA_HOME or HOME variables in the SPI configuration file. Check for other
errors generated at the same time, they may indicate the real cause.
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WASSPI-232

Description |Server <name> specified on command line, but not in configuration.
Severity Critical
Help Text Probable Cause

There was a -i or —e specified on the collector command line which specified a server name
that was not listed in the SPI configuration file. The collector only knows about servers listed
in the configuration file.

Suggested Action
1 Specify a correct server name on the command line.

2 Run the WebLogic SPI configuration utility from the Application Bank. Verify the
WebLogic server names are correctly listed and spelled in the SPI configuration file.

WASSPI-233

Description | Cannot get advanced monitoring for WLS 5.x server <name>
Severity Critical
Help Text Probable Cause

An attempt was made to get metrics from a WebLogic Server version 5 instance. Metrics and
advanced monitoring are not supported with WLS version 5.

Suggested Action
1 Do not specify a WLS version 5 server on the command line of wasspi wls ca.

2 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you
have specified the correct server versions.

3 Upgrade WebLogic Server to version 6.0 or greater.

WASSPI-234

Description | Error running program <file>, return value: <n>
Severity Critical
Help Text Probable Cause

The SPI attempted to run some tool or auxiliary program and encountered an error doing so.
The tool or program is shown in the message as <file> and the return code from attempting to
run it is shown as <n>.

Suggested Action

If the tool is a SPI tool, make sure the SPI has been installed and configured correctly. If not,
reinstall or reconfigure. If it is a system tool, make sure there are no system problems that
prevent the tool from running.
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WASSPI-235

Description |Restart of MeasureWare agent failed
Severity Warning
Help Text Probable Cause

The SPI attempted to automatically restart the MeasureWare agents and the automatic
attempt failed.

Suggested Action

Restart the MeasureWare agents manually with the mwa restart server command.

WASSPI-236

Description |Failure when running XSLT on <xm!l> with stylesheet <xsl>: <message>
Severity Critical
Help Text Probable Cause

As part of setting up graphing for user defined metrics, a translation of the UDM XML is
done. This message indicated that translation failed for some reason.

Suggested Action
Review the message shown. It is most likely that there is an error in the XML.

WASSPI-237

Description |Setting up Data Source <datasource>
Severity Normal
Help Text This is an informational message that indicates that a OVPM or MeasureWare datasource

was set up.

WASSPI-238

Description | No User Defined Metrics found

Severity Warning

Help Text Probable Cause
The UDM Graph Enable application was run, but no UDM metrics had been defined.
Suggested Action
Check that the UDM XML file has been named correctly.
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WASSPI-241

Description | Cannot delete file <file>
Severity Critical
Help Text Probable Cause

The SPI attempted to delete a file, but was unable to do so. It may be that the protection of the
file is set so that the ITO user cannot delete it, or that there is some system problem
preventing the file from being deleted.

Suggested Action
Make sure the protection of the file is correct.

WASSPI-244

Description | Configuration for node <node> is invalid
Severity Critical
Help Text Probable Cause

The configuration for the node is not in the expected format.
Suggested Action

Launch the WLSSPI Discover Tool from the HP OpenView Operations console and select the
node from the list. Verify that the properties configured for the node is valid. Re-initiate the
Discovery process by selecting the OK button on the Confirm Operation window.

WASSPI-245

Description | Unrecognized variable <var> is configured for node <node>
Severity Critical
Help Text Probable Cause
An unexpected variable was configured for the node.
Suggested Action

Launch the Discover WebLogic Tool from the HP OpenView Operations console and select the
node from the list. Look for the variable <var> included in the message and make sure that it
is valid. Re-initiate the Discovery process by selecting the OK button on the 'Confirm
Operation' window.
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WASSPI-247

Description |Failed to update the <product> configuration for node <node> in OVO server.
Severity Critical
Help Text Probable Cause

The configuration for the node is not in the expected format.
Suggested Action

Launch the Discover WebLogic Tool from the HP OpenView Operations console and select the
node from the list. Verify that the properties configured for the node is valid. Re-initiate the
Discovery process by selecting the OK button on the Confirm Operation window.

If the problem still persists, call HP Support and provide the support representative with the
following:

1 The steps and other information on reproducing the problem.

2 The trace files which are located in
$0vInstallDir%\install\WASSPI\WLSSPI\English\Discovery\log directory

WASSPI-248

Description | Cannot deploy <policy> policy group to <node>
Severity Warning
Help Text Suggested Action

Please refer to the section Deployment Troubleshooting in the HP OpenView Operations for
Windows online help. If the problem still persists, call HP Support.

WASSPI-249

Description

Cannot get the agent installation directory for <node>

Severity

Critical

Help Text

Suggested Action

Redeploy the WLSSPI discovery policy on the managed node. Make sure to uncheck the
Deploy policy only if version is newer checkbox if selected.

If the problem still persists, call HP Support and provide the support representative with the
following:

1 The steps and other information on reproducing the problem
2 The trace files which are located in
%0OvInstallDir%\install\WASSPI\WLSSPI\English\Discovery\log directory
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WASSPI-254

Description |Java exited with an error
Severity Critical
Help Text Probable Cause

While running the collector or other java application, either Java encountered an error of
some kind, or the Java application exited with an error exit.

Suggested Action
Check for other errors generated at the same time, they may indicate the real cause.

Review the SPI's error log, it may give some other clues.

WASSPI-302

Description

Updating WLS SPI configuration in OVO server

Help Text

This is a normal operation performed by the WebLogic discovery process. If the operation is
successful, the entry in the "A" (Action) column for this message should change from R
(running) to S (success).

However, if the entry in this column changes to F (fail), the operation was not completed
successfully. Select this node and launch the Discover WebLogic application again.

If problem persists, refer the WebLogic SPI User's Guide. The chapter called Configuring the

WLS SPI provides instructions on how to to manually configure the WLS SPI.

WASSPI-303

Description

Updated WebLogic SPI configuration in OVO server

Help Text

WebLogic discovery has discovered some WebLogic servers on the managed node. It has
updated the WLS SPI configuration in the OVO server.
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WASSPI-304

Description | No WebLogic servers were found

Help Text Probable Cause: WebLogic server was not installed on the node.
Suggested Action: Verify that WebLogic server is not installed on the node.

Probable Cause: There are no WebLogic servers running in this node.

Suggested Action: Make sure that all the WebLogic servers you want this SPI to monitor are
up and running before the Discover WebLogic application is run on this node. Only those
servers that are running when the Discover WebLogic runs will be automatically configured.

You can verify that a WebLogic Server is running by checking its status from its WebLogic
administrator console. After starting the WebLogic servers, launch the Discover WebLogic
application again. Make sure to select this node before the application is launched.

Probable Cause: Discovery needs some more information to find all the WebLogic servers
running on this node.

Suggested Action: Configure the following properties for this node using the Configure
WLSSPI application. Make sure to select this node before launching the application.

e JAVA_HOME - The java installation directory used by the WebLogic Servers running on
this node. If there are more than one WebLogic installation, select one java installation.
For example, JAVA HOME=/opt/bea/jdk1.3.1

e HOME_LIST - A list seperated by semicolon, containing the installation directories of all
the WebLogic servers in this node. For example, HOME LIST=/opt/weblogic6.1l;/opt/
weblogic7
Verify you enter the correct values. For example, if HOME LIST=<home dirl>;<home dir2>
and <home_dirl>is a WebLogic 6.0 or 6.1 home, then verify that the file
<home dirl>/lib/weblogic.jar exists. If <home_dirl>is a WebLogic 7 or 8 home,
then verify that the file <home dirl>/server/lib/weblogic.jar exists.

e ADMIN_PORTS - A list, seperated by semicolons, containing the ports where the WebLogic
Admin servers are listening. If the WebLogic Server is listening on a virtual IP address, the
address should also be specified as shown below. For example :

ADMIN PORTS=15.8.155.197:7001; 7045 where 15.8.155.197 is the virtual IP address on
w hich the server is listening.

e LOGIN=<weblogic user id> and PASSWORD=<weblogic user password>- where
<weblogic_user_id> is the WebLogic user you want this SPI to use for monitoring the
server and <weblogic_user_password> is the password for that user.

Note: If there is more than one WebLogic admin server on this node and if they do not
share the same login and password, then set the LOGIN and PASSWORD to the most
commonly used WebLogic login and password in the Set Access Info for Default Properties
window. Select Customize to start the configuration editor and set the LOGIN,
PASSWORD, NAME and PORT properties at the server-specific level, where NAME is the
name of the WebLogic admin server and PORT is where this admin server is listening.

Select the node and launch the Discover WebLogic application.
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Help Text Probable Cause: An incorrect value was entered for LOGIN, PASSWORD, NAME,
(cont.) HOME_LIST or ADMIN_PORTS.

Suggested Action: From the OVO console, select the node and launch the Configure
WLSSPI application. Verify that the login and password are correct. Verify that the values
assigned to HOME_LIST is correct.

For example if HOME LIST=<home dirl>;<home dir2> and if <home_dirl> is a WebLogic 6.0
or 6.1 home, then verify that the file <home dirl>/lib/weblogic.jar exists. If
<home_dirl> is a WebLogic 7 or 8 home, then verify that the file

<home dirl>/server/lib/weblogic.jar exists.

Verify that the ports given in the ADMIN_PORTS property are those of WebLogic admin
server's and they are running. Select the node and launch the Discover WebLogic application.

If problem persists, refer the HP OpenView Smart Plug-in for BEA WebLogic Server
Configuration Guide. The chapter called "Configuring the WLS SPI" provides instructions on
how to to manually configure the WLS SPI.

If manual configuration fails, do the following:

1 Select the node and launch the Gather Info Info application from the WLSSPI Admin
application group

2 Contact your HP OpenView representative for assistance.

WASSPI-321

Description |Invalid BEA home directory: <directory>

Help Text |Probable Cause

The BEA_HOME_LIST property was set for the node and the directory (which appears in the
message) is not a valid BEA home directory.

Suggested Action
Select the node and launch the Configure WLSSPI application.

Verify that BEA_ HOME_LIST is set for the node and it contains the directory which was
found to be invalid by discovery.

On the managed node, verify that the directory exists and it contains the f1icense.bea and
registry.xml files.

If the directory does not exist or does not contain the mentioned files, find the correct BEA
home directories in the managed node and use the Configure WLSSPI application to correct
the value set for the BEA_HOME_LIST property.

Select the managed node and launch the Discover WebLogic application.
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WASSPI-322

Description

Could not find BEA home directory: <directory>

Help Text

Probable Cause

The BEA_HOME_LIST property was set for the node and the directory (which appears in the
message) does not exist.

Suggested Action
Select the node and launch the Configure WLSSPI application.

Verify that BEA_ HOME_LIST is set for the node and it contains the directory which was
found to be invalid by discovery.

On the managed node, verify that the directory exists and it contains the f1icense.bea and
registry.xml files.

If the directory does not exist or does not contain the mentioned files, find the correct BEA
home directories in the managed node and use the Configure WLSSPI application to correct
the value set for the BEA_ HOME_LIST property.

Select the managed node and launch the Discover WebLogic application.
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WASSPI-323

Description | Could not find BEA home directories

Help Text |Probable Cause

The list of BEA home directories was not found. WebLogic Server was not installed on the
node.

Suggested Action
Verify that WebLogic Server is not installed on the node.

Probable Cause
The WebLogic discovery script did not find the BEA home directories on the node.
Suggested Action

Configure the following properties for this node using the Configure WLSSPI application.
Make sure to select the node before launching the application.

e JAVA_HOME - The java installation directory used by the WebLogic Servers running on
this node. If there are more than one WebLogic installation, select one java installation.
For example, JAVA HOME=/opt/bea/jdk1.3.1

e HOME_LIST - A list seperated by semicolon, containing the installation directories of all
the WebLogic servers in this node. For example, HOME LIST=/opt/weblogic6.1;/opt/
weblogic7
Verify you enter the correct values. For example, if HOME LIST=<home dirl>;<home dir2>
and <home_dirl> is a WebLogic 6.0 or 6.1 home, then verify that the file
<home dirl>/lib/weblogic.jar exists. If <home_dirl>is a WebLogic 7 or 8 home,
then verify that the file <home dirl>/server/lib/weblogic.jar exists.

e ADMIN_PORTS - A list, seperated by semicolons, containing the ports where the WebLogic
Admin servers are listening. If the WebLogic Server is listening on a virtual IP address, the
address should also be specified as shown below. For example :

ADMIN PORTS=15.8.155.197:7001;7045 where 15.8.155.197 is the virtual IP address on
w hich the server is listening.

®* LOGIN=<weblogic user id>and PASSWORD=<weblogic user password>- where
<weblogic_user_id> is the WebLogic user you want this SPI to use for monitoring the
server and <weblogic_user_password> is the password for that user.
Note: If there is more than one WebLogic admin server on this node and if they do not
share the same login and password, then set the LOGIN and PASSWORD to the most
commonly used WebLogic login and password in the Set Access Info for Default Properties
window. Select Customize to start the configuration editor and set the LOGIN,
PASSWORD, NAME and PORT properties at the server-specific level, where NAME is the
name of the WebLogic admin server and PORT is where this admin server is listening.

Select the node and launch the Discover WebLogic application.
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WASSPI-324

Description |Could not read WebLogic registry file <filename>

Help Text |Probable Cause
The WebLogic registry file does not exist.
Suggested Actions

On the node, check if the file exists. If the file does not exist, the file was manually deleted.
The registry.xml file is created by the WebLogic installation in the BEA home directory
and should not be deleted. Refer to the WebLogic installation document for more information
about this file.

Probable Cause

The directory which contains the file is one of the values assigned to the BEA_ HOME_LIST
property for the node and is not a BEA home directory.

Suggested Action

Select the node and launch the Configure WLSSPI application.

Verify that the BEA_HOME_LIST is configured for the node and its value includes the
directory containing the registry file. Verify that the directory exists in the node and it
contains the 1icense.bea and registry.xml files.

If the directory does not exist or does not contain the files, find the correct BEA home
directories in the node. Use the Configure WLSSPI application to correct the value specified
for the BEA_ HOME_LIST property.

Select the node and launch the Discover WebLogic application.

WASSPI-325

Description |Security access failure. The LOGIN property is missing for WebLogic Server <server> on port
<port_number>

Help Text Probable Cause
The LOGIN property was not set for a WebLogic server
Suggested Action

1 If a WebLogic user is not already configured for this server, then using the WebLogic
administrator console, create a user that you want this SPI to use for monitoring this
server.

2 Select the node and launch the Configure WLSSPI application. Set the correct LOGIN/
PASSWORD properties for this server (overwrite the existing encrypted data).

3 Select the node and launch the Discover WebLogic application.
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WASSPI-326

Description |Security access failure. The PASSWORD property is missing for WebLogic Server <server> on
port <port_number>
Help Text |Probable Cause

The PASSWORD property was not set for the WebLogic Server.
Suggested Action

1 If a WebLogic user is not already configured for this server, then using the WebLogic
administrator console, create a user that you want this SPI to use for monitoring this
server.

2 Select the node and launch the Configure WLSSPI application. Set the correct LOGIN/
PASSWORD properties for this server (overwrite the existing encrypted data).

3 Select the node and launch the Discover WebLogic application.

WASSPI-327

Description |Security access failure. The LOGIN and PASSWORD properties are missing for WebLogic
Server <server> on port <port_number>
Help Text |Probable Cause

The LOGIN and PASSWORD properties were not set for a WebLogic server.
Suggested Action

1 If a WebLogic user is not already configured for this server, then using the WebLogic
administrator console, create a user that you want this SPI to use for monitoring this
server.

2 Select the node and launch the Configure WLSSPI application. Set the correct LOGIN/
PASSWORD properties for this server (overwrite the existing encrypted data).

3 Select the node and launch the Discover WebLogic application.

WASSPI-328

Description |Security access failure. Invalid LOGIN and/or PASSWORD for WebLogic Server <server> on
port <port_number>
Help Text Probable Cause

An invalid LOGIN and/or PASSWORD was set for a WebLogic server.
Suggested Action

1 If a WebLogic user is not already configured for this server, then using the WebLogic
administrator console, create a user that you want this SPI to use for monitoring this
server.

2 Select the node and launch the Configure WLSSPI application. Set the correct LOGIN/
PASSWORD properties for this server (overwrite the existing encrypted data).

3 Select the node and launch the Discover WebLogic application.
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WASSPI-329

Description

A global login and password is required when ADMIN_PORTS property is configured

Help Text

Probable Cause

The ADMIN_PORTS property was set but a global LOGIN and/or PASSWORD property was
not set for a managed node.

Suggested Action

1 From the OVO console, use the Configure WLSSPI application to view the value assigned
to the ADMIN_PORTS property.

2 From the WebLogic administrator console, create a WebLogic user (if it does not already
exist) that you want the WLS SPI to use for monitoring the server.

3 From the OVO console, use the Configure WLSSPI application to set the LOGIN and
PASSWORD properties for the node.
Note: If the ADMIN_PORTS property contains the ports of more than one WebLogic
administrator server, then verify that the same user ID is configured for those WebLogic

administrator servers. If this is not possible, then you must manually set the NAME,
PORT, LOGIN, and PASSWORD properties for the administrator server.

4 Select the node and launch the Discover WebLogic application.

WASSPI-330

Description

A global login and/or passwod is not configured

Help Text

Probable Cause

The global LOGIN and PASSWORD property was not set. A global login and password is not
required if the login and password for individual WebLogic admin servers was configured. But
if all the WebLogic admin servers share the same login and password, then you may set the
global LOGIN and PASSWORD properties as described below.

Suggested Action

1 From the OVO console, use the Configure WLSSPI application to add the LOGIN and
PASSWORD properties for the node if it does not already exist.

2 Select the node and launch the Discover WebLogic application.

WASSPI-381

Description | Could not find WebLogic SPI instrumentation
Help Text Probable Cause
WebLogic Discovery could not find some files that it needs to function correctly.
Suggested Action
Distribute actions, commands and monitors to the node.
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WASSPI-402

Description | Could not get local host

Help Text |Probable Cause

Could not find the host name of the managed node because the IP address for the host could
not be found or there was a security violation.

Suggested Action

Contact your system administrator.

WASSPI-403

Description | Could not find WebLogic java installation

Help Text |Probable Cause

The Java installation directory was manually deleted from each of the BEA home directories
in the managed node or it was never installed by the WebLogic installation script.

Suggested Action
1 Find the Java installation used by the WebLogic server running on the node.

2 Select the node and launch the Configure WLSSPI application. Add the JAVA_ HOME
property for that node.

3 Select the node and launch the Discover WebLogic application.

WASSPI-404

Description | Could not find weblogic.jar file

Help Text |Probable Cause

WebLogic server was not installed on the node.

Suggested Action

Verify that WebLogic server is installed on the managed node.

Probable Cause
Discovery could not find the installation directory foWebLogic Server.
Suggested Action

1 From the OVO console, select the node and launch the Configure WLSSPI application. Set
the HOME_LIST property for this node.

2 Select the node and launch the Discover WebLogic application.

Basic Troubleshooting and Error Messages 151



WASSPI-405

Description | An error occured while reading SiteConfig file

Help Text |Probable Cause
Permissions may be incorrect or a file or directory may be corrupt.
Suggested Action

1 Verify that the permissions are correct for the OVO agent user to write to the file
$0OvAgentDir%/wasspi/wls/conf/SiteConfig. Contact your system administrator to
correct this.

Select the node and launch the Discover WebLogic application.

If the problem still persists, launch the Gather Info application and call HP Support.
Provide the support representative with the following:

— The steps and other information on reproducing the problem.
— The file generated by the Gather Info application.
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WASSPI-406

Description |Retrieve WLSSPI configuratin for node timed out

Help Text |Probable Cause
Communication failed between the management server and managed node.
Suggested Action

Select the node and launch the Discover WebLogic application. If it fails, contact your system
administrator.

Probable Cause

It took more than 2 minutes for the WLSSPI configuration to reach the managed node from
the management server.

Suggested Action
Select the node and launch the Discover WebLogic application.

Probable Cause

The Configure WLSSPI application was being executed when WebLogic discovery was run on
the node.

Suggested Action

Make sure that the Configure WLSSPI application is not running on the management server.
Select the node and launch the Discover WebLogic Discovery application.

Probable Cause
The discovery script in the management server failed.
Suggested Action

On the management server, open the trace file:
$0vInstallDir%/install/WASSPI/WLSSPI/English/Discovery/log.

The trace file is <node_name> disc_server.log where <node_name> is the primary node
name of the managed node. If any error messages are reported in the trace file, then do the
following.

1 Select the node and launch the Gather Info application from the WLSSPI Admin
application group.

2 Call HP Support and provide the support representative with the following:
— The steps and other information on reproducing the problem
— The file generated by the Gather Info application.
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All Other Errors

Description

An unknown error appears in the WLS SPI error log.

Severity

Warning

Help Text

Suggested Action

1

Refer to the text following the error message in the WebLogic SPI error log to help identify
the problem. You can view the SPI error log for a managed node by using the View Error
File application in the Application Bank window. The error message can be identified by
the date/time stamp.

Identify the steps to reproduce the problem.

Turn on tracing and reproduce the problem. Refer to the WebLogic SPI User's Guide for
instructions on how to turn on tracing.

Run the Gather Info application.
Contact HP support with the information gathered in the previous steps.
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A File Locations

You can find WLS SPI configuration files and error logs in specific directories.

OVO Management Server File Locations

Operating System File File Location
HP-UX Configuration /opt/OV/wasspi/wls/conf
Solaris Configuration /opt/OV/wasspi/wls/conf

Managed Node File Locations

On DCE-based managed nodes or UNIX managed nodes that were already running the WLS
SPI and are being switched to a non-root HTTPS agent environment (UNIX only: if these
directories do not exist, refer to the next table for file locations):

Operating System File File Location

HP-UX, Solaris, Linux | Configuration | /var/opt/0OV/wasspi/wls/conf

HP-UX, Solaris, Linux | Error Logs /var/opt/0V/wasspi/wls/log

AIX Configuration | /var/lpp/0V/wasspi/wls/conf

AIX Error Logs /var/lpp/OV/wasspi/wls/log

Windows (DCE) Configuration | \usr\ov\wasspil\wls\conf

Windows (DCE) Error Logs \usr\ov\wasspil\wls\log

Windows (HTTPS) Configuration | \Program Files\HP OpenView\data\
wasspi\wls\conf

Windows (HTTPS) Error Logs \Program Files\HP OpenView\data\
wasspi\wls\log
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On newly configured WLS SPI managed nodes in the non-root HTTPS agent environment

(UNIX only):

Operating System File File Location

HP-UX, Solaris, Linux | Configuration |/var/opt/OV/conf/wlsspi
HP-UX, Solaris, Linux | Error Logs /var/opt/0OV/log/wlsspi
AIX Configuration | /var/lpp/OV/conf/wlsspi
AIX Error Logs /var/lpp/OV/log/wlsspi
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B The Configuration

This appendix contains information about the configuration structure, how to use the

configuration editor, descriptions of the configuration properties, and samples of the
configuration.

Structure

See Sample Configurations on page 181 for examples of the configuration. The basic structure

of the configuration is given below. Lines preceded by # are treated as comments and are
ignored.

# Global Properties
property=<value> ...

# GROUP Block
GROUP <group_ name>
{

<node name> ...

}

# NODE Block

NODE <node name | group name>
{

property=<value> ...

}

Global Properties

# Global Properties
<property>=<value> ...

Properties defined at the global level apply to all nodes. The global properties can be
overridden by properties set within a GROUP or NODE block or by server-specific properties.

GROUP Block

# GROUP Block
GROUP <group name>
{

<node name> ...

}
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You can use GROUP blocks to group together nodes having common properties.
<group_ name> denotes a group of nodes with common properties. If you repeat a GROUP
block <group name> within the configuration file, then the last definition takes precedence.

<nodename> lists the nodes in the group and is the primary node name configured in OVO.
You can set the common properties using the NODE block.

) The node name specified in a GROUP block matches the value returned by the OVO variable
$OPC_NODES, which is the primary node name configured in OVO.

To view, set, or edit GROUP block properties, in the configuration editor, select the Default
Properties item under the <Group Name> folder.

NODE Block

# NODE Block
NODE <node name | group name>

{

<property>=<value> ...

}

Properties set in a NODE block apply to nodes belonging to the group defined by
<group name> (to set common properties for a group) or to the specified <nodename> (to set
properties for a single node).

To set properties for a group, enter the <group name> defined by the GROUP block and define
the common properties.

To set properties for a single node, enter the <nodename> and define the properties.
<nodename> is the primary node name configured in OVO.

If you repeat a property definition within the NODE block, the last definition takes
precedence.

To view, set, or edit NODE block properties, in the configuration editor, select the Default
Properties item under the <Node Name> folder.

Server-Specific Properties

Apart from the high level properties, you can also view, set, or edit properties specific to a
server. Each property specified as SERVER<n> config property refers to a specific WebLogic
server instance. When more than one WebLogic servers are running on a given managed node,
the number <n> differentiates the servers. Numbering begins at 1 and each WebLogic server
instance is assigned a unique number.

Property Precedence

The order of precedence (highest to lowest) of properties defined in the configuration are:
1 SERVER<n>_property (server-specific)

2 NODE <node_name> {<property>} (property defined for a node)

3 NODE <group_name> {<property>} (property defined for a group)

4 Global <property>
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The Configuration Editor

You can use the configuration editor to view and edit the configuration. You must update the
configuration using the configuration editor only.

The main components of the configuration editor are:
e Tree
¢ Buttons

e Actions

Configure WLSSPI - Tree

The Configure WLSSPI tree that appears in the left pane of the WLSSPI Configure Tool:
Configuration Editor window, shows the WLS SPI configuration in a tree structure.

The following is an example of the tree:

’ If no application servers or groups are configured, the Application Servers and Groups folders
do not appear. If you launch the Configure WLSSPI application for the first time without
selecting any node, the Nodes folder does not appear in the tree.

=F ] Configuration
=k 7 Defaults
I— Default Properties
=k T fpplication Servers
|— <App_Serverl_Name:
=F 7 Groups
.:l- 7 <Group_Mame:
I— Default Properties
=k T fpplication Servers
|— <App_Server?_Name:
=F ] Nodes
=k 7 <Mode_Name>
I— Default Properties
=k T fpplication Servers
|— <App_Server3_Name:

Here, the icons are defined as follows:
| The configuration properties can be viewed.

The configuration properties can be viewed and set.
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The following table lists each item in the tree and a brief description of the item.

Item Name

Description

Application Servers

This folder contains a list of all the application servers. This
folder can appear under Defaults (global properties),
Group_Name (GROUP block), or Node_Name (NODE block).

<Application_Server_Name>

The server name as defined in the WebLogic Server.

Configuration

A folder that contains all WLS SPI configuration information
for the WebLogic environment.

Default Properties

A list of the configuration properties that have been set. This
item appears under Defaults (global properties),
Group_Name (GROUP block), or Node_Name (NODE block).

Defaults

This folder represents the global properties. Default
properties set at this level apply to all nodes. However, these
properties can be overridden by properties set under the
Group_Name and Node_Name folders (for more information
see Property Precedence on page 158).

Groups

This folder represents the GROUP block.

<Group_Name>

This folder identifies the name of a group of nodes with
common properties. Default properties set at this level apply
to all nodes that belong to the specified group. These
properties can be overridden by properties set under the
Node_Name folders (for more information see Property
Precedence on page 158).

Nodes

This folder represents the NODE block.

<Node_Name>

This folder represents a single node whose name matches the
value returned by the OVO variable $OPC_NODES. This
value is the primary node name configured in OVO. Default
properties set at this level apply to the specified node only (for
more information see Property Precedence on page 158).
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Configure WLSSPI - Buttons

You can use the buttons available in the WLS SPI configuration editor to perform several
functions. The following table lists the buttons and their description:

Button

Description

Cancel

Exit the configuration editor.

If you click Cancel (without saving the changes) after adding or removing an
application server, node, or group or modifying a configuration property, the
Confirm Cancel window opens. Click Save and Exit to save the changes before
exiting, click Exit without Save to exit without saving the changes, or click Return to
Editing to continue editing the configuration (changes are not saved).

Next

Exit the configuration editor.

When you click Next the Confirm Operation window opens. This window contains
a list of the nodes you selected before launching Configure WLSSPI. The selected
managed nodes’ configurations are updated with your changes. Changes made to
the non-selected node (not displayed in the Confirm Operation window) are saved
to the OVO management server’s configuration. To save changes on those
managed node’s configuration, you must select those managed nodes from the
node bank, re-launch Configure WLSSPI, and then exit.

Finish

Exit the configuration editor.

This button appears instead of the Next button if you launch Configure WLSSPI
without selecting any nodes.

Save

Save changes to the OVO management server’s configuration and continue
editing the configuration.

You may also click File - Save to save your changes.

Configure WLSSPI - Actions

Actions that you can perform depend upon the item that is selected in the tree and from where
you access the action. You can access the following Actions from the Actions menu, File menu,
or by right-clicking on an item in the tree.

Action Description Selected Tree Item

Add Application To add an application server. For -3Application Servers

Server more information, see Add “Defaults
Application Server on page 162. 9<Group Name>

O<Node_Name>

Add Group To create a group to which you can 3Any item in the tree
assign nodes that have common Any item in the tree
properties. For more information, see
Add Group on page 163.

Add Node To add a managed node to the Nodes | :3Any item in the tree
folder. For more information, see Add | & Any item in the tree
Node on page 163.

The Configuration
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Action

Description

Selected Tree Item

Exit

To exit the configuration editor. This
action is available from the File

3Any item in the tree
' Any item in the tree

menu. If any changes have not been
saved, the Confirm Cancel window
opens.

To remove one or all application
servers listed. For more information,
see Remove Application Server/
Remove ALL App Servers on

page 164.

Remove Application
Server/Remove ALL
App Servers

3Application Servers
B <Application_Server_Name>

Remove Group/ To remove one or all WLS SPI groups
Remove ALL Groups listed. For more information, see
Remove Group/Remove ALL Groups

:3Groups
O<Group_Name>

on page 164.

Remove Node/ To remove one or all managed nodes | :3Nodes

Remove ALL Nodes | listed. For more information, see “A<Node Name>
Remove Node/Remove ALL Nodes on -
page 165.

Save To save changes to the configuration.| :3Any item in the tree
This action is available from the File | & Any item in the tree

menu only if you make changes to the
configuration.

Set Configuration | You can click Set Configuration <Application_Server_Name>

Properties Properties tab to set WLS SPI e Default Properties
configuration properties. For more
information, see Set Configuration
Properties Tab on page 165.
View Current You can click View Configuration -3Any item in the tree
Configuration Settings tab to view WLS SPI & Any item in the tree

configuration properties. For more
information, see Set Configuration
Properties Tab on page 165.

Add Application Server

You can add a WebLogic Server instance at the global properties, GROUP, or NODE level in
the WLS SPI configuration.

If a node contains duplicate server names (the NAME property is set to the same value), you
are prompted to set the ALIAS property (to uniquely identify each server). For more
information about the ALIAS property, see Property Definitions on page 169.

To add an application server, follow these steps:

1 In the WLSSPI Configure Tool: Configuration Editor window, right-click one of the
following items in the tree: Defaults (global properties level), Application Servers (global
properties level), <Group_Name> (GROUP level), or <Node_Name> (NODE level) and
select Add Application Server.

The WLSSPI Configure Tool: Configuration Editor: Add App Server window opens.

162 Appendix B



Enter the server name in the Application Server Name box. This is the name of the
application server as defined in WebLogic Server and is case-sensitive. The WebLogic
administration console displays the server names of all configured application servers in a
domain. Use these names for the Application Server Name.

Enter the port name in the Application Server Port box. This is the port the WebLogic
Server listens on. The WebLogic administration console displays the port numbers of all
configured application servers in a domain. Use these for the Application Server Port.

Click OK.
The NAME and PORT properties are set.

The application server is added and you can view its properties. You may also set
additional configuration properties for this server. For more information, see Set
Configuration Properties Tab on page 165.

Click Save to save your changes.

If you do not want to add this application server, right-click the application server name,
select Remove Application Server, and click Save.

Add Group

You can assign nodes with common properties to a group in the WLS SPI configuration.

To add a group, follow these steps:

1

In the WLSSPI Configure Tool: Configuration Editor window, right-click any item in the
tree and select Add Group.

The WLSSPI Configure Tool: Configuration Editor: Add Group window opens.

2 Enter the group name in the Group Name box. The group name identifies the group of
nodes with common properties and is not case-sensitive.

3 Click OK.
The group is added and the Set Configuration Properties tab for the group is active.

4 Click Add Node to Group, select one node from the list to add to the group, and click OK.
Repeat this step until all nodes are added to the group.

5 Set the configuration properties for this group using the Select a Property to Set dropdown
list. For more information, see Set Configuration Properties Tab on page 165.

6 Click Save to save your changes.
If you do not want to add the group, right-click the group name, select Remove Group, and
select Save.

Add Node

To add a managed node to the WLS SPI configuration, follow these steps:

1

The Configuration

In the WLSSPI Configure Tool: Configuration Editor window, right-click any item in the
tree and select Add Node. The WLSSPI Configure Tool: Configuration Editor: Add Node
window opens.

163



164

’ If no additional managed nodes are available to add to the configuration, the
following message appears:

All available managed nodes have been added to the configuration.
Click OK to exit this action.

From the dropdown list, select a node to add.

Click OK.

The node is added and the Set Configuration Properties tab for the node is active.

Set the configuration properties for this node using the Select a Property to Set...
dropdown list. For more information, see Set Configuration Properties Tab on page 165.

Click Save to save your changes.

If you do not want to add the node, right-click the node name, select Remove Node, and
select Save.

Remove Application Server/Remove ALL App Servers

To remove one WebLogic Servers listed from the WLS SPI configuration, follow these steps:

1

Right-click the application server name and select Remove Application Server.

The selected application server name is removed from the list and its configuration
properties are removed from the configuration.

Click Save to permanently remove the application server from the configuration.

Click Cancel to cancel the removal of the application server (the application server name
appears the next time you launch Configure WLSSPI). In the Confirm Cancel window,
click Exit without Save.

To remove ALL application servers, follow these steps:

1

Right-click the Application Servers folder and select Remove ALL App Servers.

The selected Application Servers folder and all application servers listed in the selected
folder are removed (all configuration properties for the listed application servers are
removed from the configuration).

Click Save to permanently remove the application servers.

Select Cancel to cancel the removal of all application servers (the Application Servers
folder and all application server names listed in the folder appear the next time you
launch Configure WLSSPI). In the Confirm Cancel window, click Exit without Save.

Remove Group/Remove ALL Groups

To remove one WLS SPI groups listed from the WLS SPI configuration, follow these steps:

1

Right-click the group server name and select Remove Group.

The selected group is removed from the list and its configuration properties are removed
from the configuration.

Click Save to permanently remove the group.

Click Cancel to cancel the removal of the group (the group name appears the next time you
launch Configure WLSSPI). In the Confirm Cancel window, click Exit without Save.
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Remove Node/Remove ALL Nodes

To remove one managed node listed from the WLS SPI configuration, follow these steps:
1 Right-click the node name and select Remove Node.

The selected node is removed from the list and its configuration properties are removed
from the configuration.

2 Click Save to permanently remove the node.

Select Cancel to cancel the removal of the node (the node name appears the next time you
launch Configure WLSSPI). In the Confirm Cancel window, click Exit without Save.

To remove ALL nodes, follow these steps:
1 Right-click the Nodes folder and select Remove ALL Nodes.

The selected Nodes folder and all nodes listed in the selected folder are removed (all
configuration properties for the listed nodes are removed from the configuration).

2 Click Save to permanently remove the nodes.

Click Cancel to cancel the removal of all nodes (the Nodes folder and all node names listed
in the folder appear the next time you launch Configure WLSSPI). In the Confirm Cancel
window, click Exit without Save.

Set Configuration Properties Tab

The Configuration

You can use this tab to set WLS SPI configuration properties at the global properties level or
for the selected application servers, groups (GROUP level), or nodes (NODE level).

Items with the & icon are the only items for which you can set configuration properties
(Default Properties and <Application_Server_Name>).

To set the configuration properties of an item, in the configuration editor select the item and
click the Set Configuration Properties tab in the right pane.

Setting a Property

To set a property in the configuration, follow these steps:

1 In the configuration editor, select a property from the Select a Property to Set... dropdown
list.

Click Set Property. The property and an empty value filed appear in the table.
Click the empty value field and enter a value.

Repeat steps 1 - 3 for each property to set.

Click Save.

For the LOGIN and PASSWORD properties, when you click Set Property, a separate window
opens. Enter the login and password values in this window.

O A W N

For more information about individual properties, see Configuration Properties on page 168.

Modifying a Property
To modify a property (except LOGIN) in the configuration, follow these steps:
1 In the configuration editor, select the property you want to modify.

2 Double-click the value field.
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3 Edit the value.

If a node contains duplicate server names (the NAME property is set to the same value),
you are prompted to set the ALIAS property (to uniquely identify each server). For more
information about the ALIAS property, see Property Definitions on page 169.

4  Repeat steps 1 - 3 for each property to modify.

5 Click Save.

To modify the LOGIN property in the configuration, follow these steps:

1 Select LOGIN/PASSWORD from the Select a Property to add... dropdown list.
2  Click Set Property. The Set Access Info for Default Properties window opens.

3 Enter the new password and verify password. Click OK.

4 Click Save.

For more information about individual properties, see Configuration Properties on page 168.

Removing a Property

To remove a property from the configuration, do the following:

1 In the configuration editor, select the property you want to remove.
2 Click Remove Property.

3 Repeat steps 1 - 2 for each property to remove.

4 Click Save.

AUTO_DISCOVER

The AUTO_DISCOVER check box that appears near the bottom of the window sets the
AUTO_DISCOVER property. You can set this property only by selecting or clearing the check
box.

Selecting the check box (default) causes the discovery templates (if distributed) to
automatically update the WLS SPI configuration information in the service map and
configuration. If the discovery templates are not distributed, the service map is created but
not updated.

View Current Configuration Tab

You can use this tab to view all WLS SPI configuration properties set in the configuration on
the OVO management server or the WLS SPI configuration properties for the selected
application servers, groups, or nodes.

To view the configuration properties of an item, in the configuration editor select the item and
click the View Configuration Settings tab in the right pane.
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The Configuration

The following table describes the view when the specified item is selected.

Item Name Description of View

Application Servers View all configuration properties set for all the listed
application servers.

<Application_Server_Name>| View all configuration properties set for the application server
(these properties can be modified by selecting the Set
Configuration Properties tab).

Configurations View all configuration properties saved in the configuration on
the OVO management server.

Default Properties View all configuration properties that are set (these properties
can be modified by selecting the Set Configuration Properties
tab).

Defaults View all configuration properties set at the global properties
level.

Groups View all configuration properties set for all the listed groups.

<Group_Name> View all configuration properties set for the specific group.

Nodes View all configuration properties set for the listed nodes.

<Node_Name> View all configuration properties set for the specific node.

View Inherited Properties

A View Inherited Properties check box appears near the bottom of the window. If you select
this check box, the view of the configuration properties changes to show all inherited

properties (those properties defined at a global properties level or GROUP level) that affect
the selected item. Inherited properties are denoted by “<*>” that appears after the property.

If you clear the View Inherited Properties check box, the view shows only the configuration
properties set at that level for the selected item.

Inherited properties can only be modified at the level they are set. If “<*>” appears after a
property, the property cannot be modified at that level. For example, if the property HOME is
set at the global properties level (under the Defaults folder), it can only be modified in the
Default Properties listed under the Defaults folder. Although HOME appears (with “<*>” after
it) in a <Group_Name>’s Default Properties view, HOME cannot be modified at this level.

Properties set lower in the tree take precedence over those properties set higher in the tree.
For example, if the property HOME is set at the global properties level (under the Defaults

folder) and the property HOME is set at the GROUP level, the GROUP level property value
takes precedence.

Configuration property precedence is as follows (listed from highest to lowest):
1 Server-specific

2 NODE level

3 GROUP level

4 Global properties level
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Configuration Properties

The Smart Plug-in for WebLogic Server (WLS SPI) maintains a configuration that consists of
property values that are discovered by the discovery process or are user defined.

Table 16 on page 169 lists all properties by WLS SPI requirements, where:

Property Name of the property.

Requirements Lists the property requirements for specific components where:
R - Required: the property must be set.
C- Conditional: the property may need to be set if

certain conditions are met.

O - Optional: the property is not required for the
component to work.

blank - Not Applicable: the property does not affect this

component.
WLS SPI The configuration requirements for the WLS SPI to work.
Discovery Process The requirements for the discover process to work.
Auto-Discovered The property is automatically set by the discover process.

Level of Configuration The level at which this property can be set within the
configuration structure.

Default Properties The global, group, or node level within the configuration
structure.
Application Server The server-specific level within the configuration structure.

For a description of the property, see Table 17 on page 170.
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Property Definitions

Table 16 Properties Listed by WLS SPI Requirements

Requirements Level of Configuration

Discovery Default Application
Property WLS SPI |Process |Auto-Discovered | Properties Server
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<

JAVA_HOME C v v

LOGIN R v

NAME

PASSWORD

PORT

ADDRESS

ADMIN_HOST

NEVNENENENENEYRY

ADMIN_PORTS

ADMIN_PORTS

ALIAS

<

AUTO_DISCOVER

<

BEA_HOME_LIST

COLLECT_METADATA

GRAPH_URL

HOME_LIST

JMB_JAVA_HOME

JMX_CLASSPATH

NENENENENENENES

KEYSTORE

LOGFILE

NODE_NAMES

PASSPHRASE

NENENEVNEVNEYRS

PROTOCOL

RMID_PORT

NEN RN N

RMID_START_TIME

START_CMD

STOP_CMD

USER

URL_PATH

VERSION

clNeolNolNolNolNeolNeolNelNeolNolNolNolNeolNeolNelNolNolNolNol el Nel el el eI RGN -- 1IN --1 - 1N-- -1 -

NENENEVNENEN

EXCLUDE_SAMPLES

The Configuration 169



Table 16 Properties Listed by WLS SPI Requirements (cont’d)

Requirements Level of Configuration
Discovery Default Application

Property WLS SPI | Process Auto-Discovered | Properties Server
MAX_ERROR_LOG_SIZE |O v
TIMEOUT (0) v v
TYPE O v v
UDM_DEFINITIONS_ O v v
SOURCE

a. If a WebLogic Admin server is managing a remote WebLogic Server that is listening on a virtual IP address, you
must configure the managed node on which the remote WebLogic Server is running with an alias in OVO, for
ADDRESS to be automatically discovered. To configure the virtual IP address in OVO, refer to the Description
section of the ADDRESS property.

>»

Table 17 Configuration Properties

In Table 17 Application Server A is mentioned repeatedly. Application Server A represents
the WebLogic Application Server for which you are setting the properties.

Applicable| Required/
WebLogic |Conditional/
Property Version Optional Description
ADDRESS 6.1,7.0,8.1, | Conditional The domain name or IP address where
9.x Required if the server is the server is listening. If ADDRESS is
running on a virtual IP not set, WLS SPI connects to the server
address, is on a remote using the node’s primary address.
node, or is not using the |Example:
primary IP address of SERVER1 ADDRESS = product.hp.com
that node.
ADMIN_HOST 6.1,7.0,8.1, | Conditional Name of the node on which the
9.x Required if you want to WebLogic administration server, which
start and stop the is managing Application Server A is
WebLogic console using running. This property must be set to
the Start WebLogic start the WebLogic Server Console
Console application application.
Example:
SERVER1 ADMIN HOST=localhost
ADMIN_PORTS 6.1,7.0,8.1, | Conditional The port of the WebLogic
9.x administration server managing

Required if you want to
start and stop the
WebLogic console using
the Start WebLogic
Console application

Application Server A. Must be set in
order to start the WebLogic Server
Console application.

Example: SERVER]1 ADMIN PORT=7005

170

Appendix B



Table 17 Configuration Properties (cont’d)

Applicable | Required/
WebLogic |Conditional/

Property Version Optional Description

ADMIN_PORTS 6.1,7.0,8.1, | Conditional The port numbers of WebLogic Admin
9.x servers whose domain configuration file,

Required if the domain
configuration file of the
WebLogic Admin servers
is not located in the
default directory.

config.xml, is not located in the
default directory listed below:

e For WebLogic 6.x:
<WebLogic_Install_Dir>/
config/<WebLogic_Domain>/

e  For WebLogic 7 or 8
<BEA_Home_Dir>/
user projects/
<WebLogic_Domain>/

e For WebLogic 9.x

<BEA_Home_Dir>/
user projects/domains/
<domain_name>

where, <WebLogic_Install_Dir> is the
directory where the WebLogic Server is
installed, <BEA_Home_Dir> is the
directory that contains the
registry.xml file, and
<WebLogic_Domain> is the WebLogic
domain name.

If the WebLogic Admin server is
listening on a virtual IP address,
include this virtual IP address before
the port number, separated by a colon.
For example, <virtual_ip_address>:
<port_number>.

The LOGIN and PASSWORD for the
WebLogic Admin servers must be set at
the NODE block level. The LOGIN and
PASSWORD must be the same for all
WebLogic Admin servers running on the
same node. The port numbers set by
this property are the ports used by the
WebLogic Admin servers.
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Table 17 Configuration Properties (cont’d)

Applicable | Required/
WebLogic |Conditional/
Property Version Optional Description
ALIAS 6.1,7.0,8.1, | Conditional Unique name assigned to an application
9.x Required if more than | Server on a managed node if more than
one application server on | 0ne application server on a node share
a system share the same | the same server name. The alias, if set,
Server name. is the name used in messages, reports,
and graphs (otherwise, NAME is used).
If you modify the ALIAS, the data for
the old alias is saved, but is not mapped
to the new alias.
Example:
NODE petstore.hp.com {
SERVERl_NAME=dog
SERVERI_AL IAS=beagle
SERVERZ_NAME=dOg
SERVERZ_ALIAS=daChShund
}
NODE flying ace.hp.com {
SERVER1 NAME=snoopy
SERVER1 ALIAS=beagle
SERVERZ2 NAME=snoopy
SERVER2 ALIAS=red baron
}
AUTO_DISCOVER 6.1,7.0,8.1, | Conditional Select the AUTO_DISCOVER check box
9.x Required if you do not in the configuration editor to
want the discovery policy automatically update the WebLogic
to automatically Server configuration information in the
overwrite the service map and configuration.
configuration Clear the AUTO_DISCOVER check box
information. in the configuration editor if you want
to manually configure the WebLogic
Server configuration and do not want
the discovery policy to automatically
overwrite the configuration
information.
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Table 17 Configuration Properties (cont’d)

Applicable | Required/
WebLogic |Conditional/

Property Version Optional Description

BEA_HOME_LIST 6.1,7.0,8.1, | Conditional This is the software registry used by all
9.x Required if the WebLogic WebLogic products. It contains

Server software registry
does not exist on a
managed node.

information about all WebLogic
products installed on the system.

If you do not use BEA's installation
scripts to install the WebLogic Server,
the software registry is not created.

On a UNIX managed node, the software
registry is created in the file

SHOME /bea/beahomelist, where
$SHOME is the home directory of the user
who installed the WebLogic Server. On
a Windows managed node, the software
registry is created in the file
beahomelist or is defined by the
BEAHOMELIST registry.

On a UNIX managed node, directory
names with spaces are not supported.

If the software registry does not exist
and this property is not set, the
Discovery templates generate an error
message.

COLLECT_METADATA

6.1,7.0,8.1,
9.x

Conditional

Required if you want to
use the MBean Explorer
in the JMX Metric
Builder application.

Set the value of
COLLECT_METADATA to ON to collect
metadata (MBean information)
displayed by the JMX Metric Builder
application. This metadata is used to
create UDMs (user defined metrics).

Metadata for each MBean server is
saved in the following file: /var/opt/
OV/wasspi/wls/metadata/
<managed_node>/

<NAME |ALIAS> . xm1,
/var/opt/0OV/metadata/wls/
<managed_node>/

<NAME |ALIAS>. xml, or
\<%0vAgentDir%>\wasspi\wls\
metadata\<managed_node>\
<NAME |ALIAS>.xml where NAME
and ALIAS are the properties set for the
managed node and ALIAS is always
used if it is set.

Default: OFF.
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Table 17 Configuration Properties (cont’d)

Applicable | Required/
WebLogic |Conditional/
Property Version Optional Description
EXCLUDE_SAMPLES 6.1,7.0,8.1, | Optional Set the value to true to not discover
9.x WebLogic Server sample programs. This
reduces the time taken by the discovery
process. Sample programs are located in
the following directories:
WebLogic 6.1
<WL Install Dir>/config/examples
<WL Install Dir>/config/petstore
WebLogic 7, 8, and 9.x
<WL_Install_Dir>/samples/
domains/medrec
Default: false.
Example: EXCLUDE SAMPLES = true
GRAPH_URL 6.1,7.0,8.1, | Conditional The URL used to launch HP Open View
9.x Required if you want to Performance Manager (OVPM). Set the
use the View Graphs GRAPH_URL property at the global
application (HP Open level only.
View Performance Examples: GRAPH URL = http://
Manager must be systeml.hp.com/HPOV Reports/
installed). ovpm.htm (OVPM 4 on Windows)
GRAPH URL = http://
system?.hp.com:8080/0VPM/
index.html (OVPM 5 on UNIX and
Windows)
HOME 6.1,7.0,8.1, | Required The directory where the WebLogic
9.x Server is installed.
Example: HOME = /opt/bea/
wlserver6.0spl
HOME_LIST 6.1,7.0,8.1, | Conditional List of directories where the WebLogic
9.x Required if the BEA Server is installed. Each directory is
registry.xml file is not | Separated by a semicolon. This list is
accurate or cannot be used by discovery.
found. You can face this |On a UNIX managed node, directory
problem if you do not use | names with spaces are not supported.
BEA's installation
scripts to install the
WebLogic Server
software and Service
Packs.
JAVA_HOME 6.1,7.0,8.1, | Required The directory where Java, that is used
9.x Required by the by the collector, is installed . The java
discovery process if there | engine is expected to be $JAVA_HOME/
is more than one bin/java.
directory where Javais |Example: JAVA HOME = /opt/bea/
installed. 3dk130
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Table 17 Configuration Properties (cont’d)

Applicable | Required/
WebLogic |Conditional/
Property Version Optional Description
JMB_JAVA_HOME N/A Conditional The directory where Java (JDK 1.4.1 or

Required if you are using
the JMX Metric Builder.

higher) is installed. This is the java that
is used by the JMX Metric Builder on
the OVO management server. The JDK
must be version 1.4.1 or higher.

JMX_CLASSPATH N/A Conditional The location of the jar file(s)
Required if you are using | implementing JMX.
the JMX connector to Example: JMX CLASSPATH = /opt/
monitor a non-WebLogic | JMX/Sun/lib/jmxri.jar
MBean server.
KEYSTORE 8.1,9.x Conditional The fully-qualified path to the SSL
Required if using SSL. | trust keystore file.
Default: WebLogic’s demo keystore
LAUNCH_DIR 6.1 Conditional The name of the directory from which
Required only under the WebLogic Server is started. This is
certain WebLogic necessary only when absolute logfile
configurations. See names are not configured in the
Description. WebLogic Server configuration and
when the WebLogic Server is not
started from HOME.
Example: SERVER1 LAUNCH DIR=
/opt/wlsapphome
LOGFILE 6.1,7.0,8.1, | Conditional A comma-separated list of fully
9.x Required only if the qualified file names of WebLogic Server
logfile names returned | log files.
by WebLogic Server are |Setting this property overrides any
not those desired to be |logfiles that the SPI would otherwise be
monitored. monitoring for this server.
Default: <home>/<NAME>/
weblogic.log
LOGIN 6.1 Required The admin user name (typically
system), unless another user has been
defined with appropriate permissions.
For more information, see Task 2:
Configure a WebLogic Server User on
page 40.
Default: guest.
Example: SERVERI LOGIN = janedoe
LOGIN 7.0, 8.1, 9.x | Required The WebLogic Server admin user

configured at installation.
Example: SERVERI LOGIN = johndoe

The Configuration

175



Table 17 Configuration Properties (cont’d)

Applicable | Required/
WebLogic |Conditional/
Property Version Optional Description
MAX_ERROR_LOG_SIZE |6.1,7.0,8.1, | Conditional The maximum size allowed for the error
9.x log file. When the error log file reaches

Required if you want an
error log file larger than
2MB

the maximum size, it is renamed as a
backup file and logging resumes. When
a new backup file replaces an old
backup file, the old backup is deleted.
Default: 2MB

Example:

MAX_ERROR LOG SIZE = 20

NAME?

6.1,7.0,8.1,
9.x

Required

The server name as defined in the
WebLogic Server. Use the WebLogic
administration console to obtain this
information. If a system shares the
same server name (the value of NAME
is the same within a NODE block), use
ALIAS to uniquely identify each server.
This name is used in messages, reports,
and graphs unless ALTAS is set.

Example: SERVER] NAME =
exampleServer

NODE_NAMES

6.1,7.0,8.1,
9.x

Conditional

Required if a remote
WebLogic Server is
running on a virtual IP
address.

The virtual IP address where the server
is listening. If NODE_NAME is not set
for the remote WebLogic Server, it is not
automatically discovered.

Example: SERVER] NODE NAMES =
15.19.20.21

NUM_SERVERS

6.1,7.0,8.1,
9.x

Optional

The number of WebLogic servers on the
managed node.

Example: NUM_SERVERS = 3

PASSPHRASE

8.1, 9.x

Conditional

Required if the
configured keystore
requires a passphrase
for read operations.

The passphrase defined when the
keystore was created on your WebLogic
Server. If a keystore was not defined
with a password, do not set this
property.

When you type in the PASSPHRASE, it
displays as plain text in the GUI. When
you save the properties or change the
view in the GUI, the PASSPHRASE is
encrypted.

A PASSPHRASE must contain at least
two characters.
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Table 17 Configuration Properties (cont’d)

Applicable | Required/
WebLogic |Conditional/
Property Version Optional Description
PASSWORD 6.1 Required The password for the LOGIN. If LOGIN
is not specified, the Guest login for
USER is used.
Example:
SERVER1 PASSWORD = janedoel23
PASSWORD 7.0, 8.1, 9.x | Required The password for the LOGIN. If LOGIN
is configured, a password must be
defined.
Example:
SERVER1 PASSWORD = johndoel23
PORT 6.1,7.0,8.1, | Required The port the WebLogic Server listens
9.x on. Use the WebLogic administration
console to get the port number.
Example: SERVER1 PORT = 7001
PROTOCOL 8.1,9.x Conditional Specifies if the application server port is
Required if using SSL on | using SSL or non-SSL. Valid values are:

the application server

port.

e t3 for non-SSL
e t3s for SSL

If PROTOCOL is not set, it takes the
default, which is t3. If PROTOCOL is
set and you click Set Property, the
default value becomes t3s.

If an invalid PROTOCOL is set or it
does not match the application port,
OVO reports the application server as
down.
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Table 17 Configuration Properties (cont’d)

Applicable | Required/
WebLogic |Conditional/
Property Version Optional Description
RMID_PORT 8.1,9.x Conditional The port on which rmid listens.
Required if the default |By default, if an OVO managed node is

port on which rmid

listens is already in use.

monitoring application servers and
MBean servers using the JMX
connector, the SPI uses two ports - one
for the application servers and one for
the MBean servers. For example, if you
are monitoring a WebLogic Server and
an MBean server, the SPI uses ports
9240 and 9241 respectively.

But, if RMID_PORT is set, the SPI uses
this one port for all servers. For
example, if you are monitoring a
WebLogic Server and an MBean server
and set RMID_PORT to 9250, the SPI
uses port 9250 only for both the servers.

You cannot set this property at the
application server level.

Default: WebLogic Server: 9240; JMX
connector: 9241

Examples: RMID PORT = 9250

RMID_START_TIME 8.1,9x Conditional The amount of time, in seconds, to wait
Required if rmid takes for rmid to start before timing out.
longer than 30 seconds |Default: 30 (seconds)
to start. Examples: RMID START TIME = 60

START_CMD 6.1,7.0,8.1, | Conditional This system command is run when the

9.x Required if you want to Start WebLogic application is used. This
start the WebLogic command is run by USER, which must
Server from the OVO be set for the Start WebLogic
console application to work.

Note: This command must exit. That is,
the WebLogic Server process must run
in the background or as a service and it
must be protected from its parent
process dying.

Example: SERVERI START CMD = /
sbin/init.d/weblogic start

STOP_CMD 6.1,7.0,8.1, | Conditional This system command is run when the

9.x Required if you want to | Stop WebLogic application is used. This
stop the WebLogic command is run by USER, which must
Server from the OVO be set for the Start WebLogic
console application to work.

Example: SERVER1 STOP CMD = /
sbin/init.d/weblogic stop
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Table 17 Configuration Properties (cont’d)

Property

Applicable
WebLogic
Version

Required/
Conditional/
Optional

Description

TIMEOUT

6.1,7.0,8.1,
9.x

Optional

The maximum amount of time (in
seconds) that WLS SPI can take to
connect to the WebLogic Server. When
the specified time is exceeded, WLS SPI
sends an alarm to the message browser
indicating that the WebLogic Server is
unavailable. If metric
B002_ServerStatusRep is being
collected, the unavailability of the
server is logged.

If you do not want a time limit, set this
property to -1.
Default: 120 (seconds).

TYPE

6.1,7.0,8.1,
9.x

Optional

Required if you are
configuring a JMX
connector

The type of JMX connector. Set TYPE to
ovrmi if you are configuring a JMX
connector.

Do not change the default value of
TYPE if you are using WebLogic’s
MBean server.

Default: weblogic.

Example: SERVER]1 TYPE=weblogic

UDM_DEFINITIONS_SO

URCE

6.1,7.0,8.1,
9.x

Optional

The path name to or file name of the
metric definitions XML file on the OVO
management server. If a path name is
set, the
wasspi_wls_udmDefinitions.xml file
is the assumed file name of the UDM
file.

Default: /opt/0OV/wasspi/wls/conf/
wasspi wls udmDefinitions.xml.

Example:
SERVER1_UDM_DEFINITIONS_SOURCE =
/opt/0OV/wasspi/wls/conf/udm.xml

URL_PATH

Conditional

The path part of the JSR-160 connector
server URL.

Example: SERVER] URL PATH=jndi/
weblogic.management.mbeanserve
rs.domainruntime

USER

6.1,7.0,8.1,
9.x

Conditional

Required if you want to
start and/or stop the
WebLogic Server from
the OVO console

The system username for starting and
stopping the WebLogic Server from the
OVO Console.

Default: the username under which the
OVO agent runs.

Example: USER = weblogic
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Table 17 Configuration Properties (cont’d)

Property

Applicable | Required/
WebLogic |Conditional/
Version Optional

Description

VERSION

9.x

6.1,7.0,8.1, | Conditional

Required for WebLogic
Versions 7 and 8

The version number of the WebLogic
Server in the format Major# [Minor#]
where:

Major# - The primary version number
(for example, 6.1 or 7.0)

Minor# - The service pack installed (for
example, 1 for SP1). If Minor# is not
specified, then the default value 0 is
taken (no service pack installed). A
service pack must be installed for
version 6.1 (refer to the release note for
a list of supported service packs).

Example: SERVER1 VERSION = 6.1 3

a. The WebLogic administration console displays the server names and port numbers of all configured application
servers in a domain. Use these names and numbers when defining NAME and PORT.
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Sample Configurations

The sample WLS SPI configurations with entries given in this appendix show various
features and utilization methods.

Example 1: Single Node/Two Servers

The following example is of two servers, an administration server and a managed server,
running on a single node. The properties HOME and JAVA_HOME are global defaults that apply
to all servers and nodes. When the configuration is saved, passwords are encrypted.

HOME = /opt/bea/wlserver6.1l
JAVA HOME=/opt/bea/jdkl31
NODE main.rose.hp.com
{
SERVER]1 NAME= adminserver
SERVER1 PORT= 7001
SERVERI LOGIN= system
SERVER1 PASSWORD = password
SERVER2 NAME= managedserver
SERVER2 PORT= 7005
SERVER2 LOGIN= system
SERVER2 PASSWORD= password
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Example 2: Multiple Nodes/Repeated Properties

The example that follows shows how you can configure a group of related systems that have
numerous properties in common. Some nodes, however, may have one or two properties that
you need to set differently. You can address these kinds of situations in three steps:

1 Use the Add Group action in the configuration editor to name the group, specify the nodes
in it, and set the configuration properties. For more information, see Add Group on
page 163.

2 Use the Add Node action in the configuration editor to define individual node properties
(either for nodes not in the group or for nodes in the group that have some unique/
separate properties). For more information, see Add Node on page 163.

’ Properties set for a node take precedence over the same properties set for a group.
For the complete order of property precedence, see Property Precedence on
page 158.

In the example, the global default properties HOME and JAVA_HOME are overridden for
node europa.rose.hp.com. Since the start command uses the system init command —/sbin/
init.d/weblogic start which runs when the system starts and starts all of the WebLogic
servers, you must set USER to root. In this environment, this command takes care of starting
the servers with the correct user, such as weblogic.

HOME = /opt/bea/wlserver6.1l
JAVA HOME = /opt/bea/jdk131
USER = root

GROUP production
{
mercury.rose.hp.com
venus.rose.hp.com
mars.rose.hp.com
jupiter.rose.hp.com
}
NODE production
{
SERVER]1 NAME= partsserver
SERVER1 PORT= 7001
SERVER]1 LOGIN= system
SERVER]1 PASSWORD= password
SERVER1 ADMIN HOST= earth.rose.hp.com
SERVER1 ADMIN PORT= 7001
SERVER1 START CMD /sbin/init.d/weblogic start
SERVER2 NAME= orderserver
SERVER2 PORT= 7010
SERVER2 LOGIN= system
SERVER2 PASSWORD= moresecret
SERVER2 START CMD /sbin/init.d/weblogic start
}
NODE jupiter.rose.hp.com
{
SERVER]1 PASSWORD= differentlpassword
SERVER2 PASSWORD= different2password
}
NODE europa.hp.com

{
SERVER1 HOME = /opt/bea/wls

Appendix B



Example 3: Multiple Weblogic Server Versions

The Configuration

SERVERL JAVA HOME = /opt/bea/jdk132

SERVER]1 NAME= testserver
SERVER1 PORT= 7100

SERVER]1 LOGIN= system
SERVER1 PASSWORD= mypssword

This example shows how to set up an environment with two different versions of WebLogic

Server running on a single managed node. Note that SERVER1_HOME and
SERVER2_HOME are set to different directories for the different versions of WebLogic

Server.

NODE callisto.rose.hp.com

{

SERVER1 HOME = /opt/bea/wlserver6.0
SERVER1 JAVA HOME = /opt/bea/jdk131

SERVER]1 NAME= prodserver
SERVER1 PORT= 7001

SERVER]1 LOGIN= system
SERVER1 PASSWORD= mypssword

SERVER1 HOME = /opt/bea/wlserver6.l
SERVER1 JAVA HOME = /opt/bea/jdk131

SERVER]1 NAME= testserver
SERVER1 PORT= 7100

SERVER1 LOGIN= system
SERVER1 PASSWORD= mypssword
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Example 4: Weblogic Servers with Virtual IP Addresses

This example shows how to configure WebLogic Servers that have virtual IP addresses.
ADDRESS is set to the name or IP address where the server is listening.

NODE saturn.rose.hp.com

{
SERVER1 HOME = /opt/bea/wlserver6.l
SERVER1_JAVA HOME = /opt/bea/jdk131
SERVER]1 NAME= partsserver
SERVER1 PORT= 7001
SERVER1 ADDRESS= juno.rose.hp.com
SERVER]1 LOGIN= system
SERVER1 PASSWORD= mypssword
SERVER2 HOME = /opt/bea/wlserver6.l
SERVER2_JAVA HOME = /opt/bea/jdk131
SERVER2 NAME= orderserver
SERVERZ2 PORT= 7001
SERVERZ ADDRESS= 15.15.1.1
SERVERZ LOGIN= system
SERVERZ PASSWORD= mypssword

Example 5: Non-default Weblogic Server Startup Location

This example addresses the case where the command that starts WebLogic Server does not cd
to the HOME directory before it starts. The WLS SPI may not be able to locate the WebLogic
Server log files in order to monitor them. To ensure that WLS SPI can monitor the log files,
either set LAUNCH_DIR to the directory the server was run from as on neptune (in the
example), or set LOGFILES as on pluto (in the example).

NODE neptune.rose.hp.com
{
SERVER1 HOME = /opt/bea/wlserver6.l
SERVER1 JAVA HOME = /opt/bea/jdkl131
SERVER]1 NAME= exampleServer
SERVER1 PORT= 7001
SERVER]1 LOGIN= system
SERVER1 PASSWORD= mypssword
SERVER1 LAUNCH DIR = /home/weblogic
}
NODE pluto.rose.hp.com
{
SERVER1 HOME = /opt/bea/wlserver6.l
SERVERL JAVA HOME = /opt/bea/jdk131
SERVER]1 NAME= exampleServer
SERVER1 PORT= 7001
SERVER]1 LOGIN= system
SERVER1 PASSWORD= mypssword
SERVER]1 LOGFILES =
/opt/bea/wlserver6.1l/config/mydomain/logs/weblogic.log,
/opt/bea/wlserver6.1l/config/mydomain/logs/wl-domain. log
}
) The SERVER1_LOGFILES are set on a single long line separated by commas.
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C Applications

The Smart Plug-in for BEA WebLogic Server (WLS SPI) applications include configuration
and troubleshooting utilities.

WLSSPI Admin group includes the following applications:
e Configure WLSSPI

e Discover WebLogic

¢ Init Non-Root

e Self-Healing Info

e Start/Stop Monitoring

e Start/Stop Tracing

e Verify

e View Error File

e View Graphs

WebLogic group includes the following applications:
e Check WebLogic

e Start WLS Console

e Start/Stop WebLogic

e View Deployed Apps

e View WebLogic Log

e View WebLogic Servers

e View Application Activation Status

e View Application Timeout

Additional WLSSPI Admin applications for user defined metrics (UDMs) are available with
the WASSPI-UDM-BIdr software bundle. Refer to the HP OpenView Smart Plug-in User
Defined Metrics User Guide for more information about how to install the software bundle and
the additional applications.
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The WLSSPI Admin application group contains the following applications. These applications
require the “root” user permission, therefore it is recommended that this group be assigned to
the OVO administrator.

Configure WLSSPI

Configure WLS SPI application launches the configuration editor. You can use the
configuration editor to maintain the WLS SPI configuration by viewing, editing, or setting
configuration properties.

If you are configuring WLS SPI for the first time, use the Discover WebLogic application to
automatically set basic configuration properties. For more information, see Chapter 3,
Configuring WLS SPI.

Function

Configure WLSSPI application performs the following functions:

e Updates the configuration on the OVO management server and managed nodes.

e Creates the directories and files required by WLS SPI on the selected managed nodes.
e Sets up data sources for reporting and graphing

e Sets up the WebLogic Server log files and WLS SPI error log file for monitoring

Configuration information about the all the WebLogic Servers running on all managed nodes
is maintained on the management server. In addition, every managed node maintains
information about WebLogic Servers running on that node.

When you make changes using the configuration editor, the changes are saved on the OVO
management server. However, when launching the Configure WLSSPI application if you
select a node, then the changes affecting the selected node are saved on that node itself.

To save any changes on a managed node, you must select that node before launching the
Configure WLS SPI application otherwise the changes are saved on the management server
by default.

To Launch Configure WLS SPI

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window
opens.

3 Double-click WLSSPI. The Application Group: WLS SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All
the WLSSPI Admin applications appear in this window.

5 Select a node from the OVO Node Bank window and double-click Configure WLSSPI (If the
items do not appear as mentioned, select Map = Reload). The Introduction window opens.

6  Click Next. The configuration editor opens. For more information about using
configuration editor, see The Configuration Editor on page 159.
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7 Click Save to save any changes made to the configuration. After you save your changes,
you cannot automatically undo them.

8 Select Finish or Next to save changes and exit the editor.

If you select Next, the Confirm Operation window opens. Click OK to save the changes.

’ If you click Cancel in the Confirm Operations window, the changes made by you are
not saved to the selected managed nodes’ configuration and remain in the
configuration on the management server. To make the changes to the selected
managed nodes’ configuration, you must select those nodes in the Node Bank
window, launch the Discovery application, click Next in the configuration editor, and
then click OK in the Confirm Operation window.

9 During configuration, if you have added an application server or added/edited the
ADMIN_PORTS, HOME, HOME_LIST, and/or JAVA_HOME properties on the nodes on
which the application server/properties were added or edited, then you must launch the
Discover WebLogic Application. Running the Discover application updates the service
map.

Discover Weblogic

Applications

The Discover WebLogic application sets basic configuration properties needed for discovery. It
also launches the configuration editor through which you can configure WLS SPI by setting
initial configuration properties.

Function

Discover WebLogic updates the configuration on the OVO management server and selected
managed nodes.

Configuration information about the all the WebLogic Servers running on all managed nodes
is maintained on the management server. In addition, every managed node maintains
information about WebLogic Servers running on that node.

When you make changes using the configuration editor, the changes are saved on the OVO
management server. However, when launching the Configure WLSSPI application if you
select a node, then the changes affecting the selected node are saved on that node itself.

To save any changes on a managed node, you must select that node before launching the
Configure WLS SPI application otherwise the changes are saved on the management server
by default.

To Launch Discover Weblogic

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window
opens.

Double-click WLSSPI. The Application Group: WLS SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All
the WLSSPI Admin applications appear in this window.
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5 Select a node from the OVO Node Bank window and double-click Discover WebLogic (If the
above does not appear as described, select Map = Reload.) The Introduction window opens.
This window contains brief information about the Discovery application.

6  Click Next. A second Introduction window opens. This window displays information about
which properties may be required in order for the discovery process to work.

7  Click Next. If you have not set the WLS SPI LOGIN and PASSWORD properties, the Set
Access Info for Default Properties window opens.

’ If you have already configured the LOGIN and PASSWORD properties, the
configuration editor appears. Skip this step and go to step 8.

Set the LOGIN and PASSWORD properties same as the WebLogic Server login and
password configured in Task 2: Configure a WebLogic Server User on page 40.

’ The LOGIN and PASSWORD properties set in this window are used as the default
WebLogic Server login and password (they are set at the global properties level). If
no NODE level or server-specific LOGIN and PASSWORD properties are set, WLS
SPI uses this WebLogic login and password to access all WebLogic Servers. For
more information about the configuration structure, see Structure on page 157.

If the WebLogic Server login and password are the same for all WebLogic Servers on all
OVO managed nodes, do the following:

a In the Set Access Info for Default Properties window, set the LOGIN and PASSWORD
properties.

b Click Next.
¢ Go tostep 9.

If the WebLogic Server login and password are different for different instances of
WebLogic, you must customize the WLS SPI configuration by setting the LOGIN and
PASSWORD properties at the NODE or server-specific level (for more information about
the configuration structure, see Structure on page 157):

a In the Set Access Info for Default Properties window set the LOGIN and PASSWORD
properties to the most commonly used WebLogic login and password.

b  Select Customize to open the configuration editor.

8 In the configuration editor, set the configuration properties. For more information about
using the configuration editor, see The Configuration Editor on page 159.

9  Click Next to save changes and exit the editor. The Confirm Operation window opens.

10 Click OK.

’ If you click Cancel in the Confirm Operations window, the changes made by you
are not saved to the selected managed nodes’ configuration and remain in the
configuration on the management server. To make the changes to the selected
managed nodes’ configuration, you must select those nodes in the Node Bank
window, launch the Discovery application, click Next in the configuration editor,
and then click OK in the Confirm Operation window
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Init Non-Root

Init Non-Root application simplifies the configuration of a non-root HTTPS agent on a UNIX
managed node (OVO 8.x only). For information about configuring a non-root HTTPS agent on
a UNIX managed node, see Configuring a Non-Root HTTPS Agent on a UNIX Managed Node
(OVO 8.x Only) on page 51

Function

Init Non-Root performs the following functions on the selected managed nodes:

1 Runs the wasspi wls perl -S wasspi wls makePlatdef -force command to set the
proper SPI path configuration and updates the
/var/opt/OV/bin/instrumentation/wasspi wls platdef.pmand
wasspil wls platdef.prop files.

2 Generates the wasspi wls sudoers configuration file.

To Launch Init Non-Root

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window
opens.

Double-click WLSSPI. The Application Group: WLS SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All
the WLSSPI Admin applications appear in this window.

5 Select a node from the OVO Node Bank window and double-click Init Non-Root.

Selt-Healing Info

You can launch this application to collect data that can be sent to the HP support
representative.

) Your HP support contract entitles you to access cross-referenced information through the HP
OpenView self-healing services web site (http:/support.openview.hp.com/
self healing.jsp), linking you to a database where similar information and subsequent
problem solutions increase troubleshooting effectiveness. For more information, refer to the

section covering Self-Healing Services in HP OpenView Smart Plug-ins DVD Installation
Guide for UNIX.

Required Setup

If you are collecting data for a reproducible problem, do the following before launching the
Self-Healing Info application:

1 Launch the Start Tracing application. For more information see Start/Stop Tracing on
page 193.

2 Reproduce the problem.
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Function

Self-Healing Info performs the following functions
e  For all managed nodes:

¢ Runs and saves data using the Verify application (for more information see Verify on
page 193 for more information.)

¢ Recursively lists all files in the following directories:
— <OV_AGT_DIR>/bin/0OpC/actions/
— <OV_AGT_DIR>/bin/0pC/cmds/
— <OV_AGT_DIR>/bin/0OpC/monitor/
— <OV_AGT _DIR>/wasspi/wls/
e Displays the contents of the following files:
— <OV_AGT_DIR>/conf/0pC/nodeinfo
— <OV_AGT_DIR>/wasspi/wls/conf/SiteConfig
— <OV_AGT_DIR>/wasspi/wls/conf/SPIConfigCfgFiles
— <OV_AGT_DIR>/wasspi/wls/conf/SPIConfigLogFiles
— <OV_AGT _DIR>/wasspi/wls/conf/version
¢ Runs the following commands:
— opcagt -status
— codautil -obj
— <OV_AGT_DIR>/bin/OpC/monitor/wasspi wls ca -m 5 -x print=on
— <OV_AGT_DIR>/bin/OpC/monitor/wasspi wls ca -m 5 -x print=on -debug
e Copies all files in the following directories:
— <OV_AGT_DIR>/wasspi/wls/log/
— <OV_AGT_DIR>/wasspi/wls/tmp/
e Copies the following files:
— <OV_AGT _DIR>/conf/0pC/le
— <OV_AGT_DIR>/conf/0pC/msgi
— <OV_AGT_DIR>/conf/0OpC/monitor
— <OV_AGT _DIR>/wasspi/wls/conf/version
¢ For management server:
e verifies whether the following directories exist:
— /opt/0OV/wasspi/wls/bin/
— /opt/OV/wasspi/wls/conf/
e verifies whether the following files exist:
— /opt/0OV/wasspi/wls/bin/parseDefs.pl
— /opt/OV/wasspi/wls/bin/startWLSConsole.pl

— /opt/OV/wasspi/wls/bin/wasspi wls app graphs
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— /opt/OV/wasspi/wls/bin/wasspi wls editcfg
— /opt/OV/wasspi/wls/bin/wasspi wls lib.pl
— /opt/OV/wasspi/wls/bin/wasspi wls optaction graphs
— /opt/OV/wasspi/wls/bin/wasspi xterm
— /opt/OV/wasspi/wls/conf/SiteConfig
e copies the following file
— /opt/ov/wasspi/wls/conf/SiteConfig
e For Windows managed nodes:
e Displays the contents of the following files:
— <OV_AGT DIR>/bin/OpC/install/opcinfo
— <OV_AGT DIR>/conf/dsi2ddf/ddflbd.mwc
e For UNIX managed nodes:
e Displays the contents of the following files:
— /opt/0V/bin/OpC/install/opcinfo
— <OV_AGT _DIR>/conf/dsi2ddf/ddflbd.rc
¢  Runs the following commands:
— ps -ef
— <OV_AGT_DIR>/bin/OpC/cmds/wasspi wls osinfo

— df -k
— uname -a
— hostname

e Collects the following information:
— Up time
— Detailed OS version
— ulimit values

— Installed Patches

) Where <OV_AGT DIR> is:
¢ on a UNIX managed node: /var/opt/OvV
¢ on a Windows managed node: depends on the installation of the product
The data is saved in the following file:
e on a UNIX managed node: /tmp/wasspi wls support.tar

* on a Windows managed node: wasspi wls support.zip in one of the following
directories (the exact location is displayed):

— S%TEMPS

— %SystemDrive$\temp\
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— C:\temp\
— S%temp% if JAVA HOME or SERVER<n> JAVA HOME is defined

— Stemp%\wasspi wls_ support\

) On some Windows managed nodes, this file may be hidden. If you do not see the
file, open Windows Explorer and from the Tools menu, select Folder Options. Click
the View tab. Under Hidden files and folders, select Show hidden files and folders.

To Launch Self-Healing Info

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window
opens.

Double-click WLSSPI. The Application Group: WLS SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All
the WLSSPI Admin applications appear in this window.

5 Select a node in the Node Bank window and double-click Self-Healing Info.

Start/Stop Monitoring

You can launch this application to start/stop WLS SPI from collecting metrics from an
application server.

WLS SPI collects metrics to get performance or availability related data. Metrics are also used
to create reports (automatically or manually generated) and graphs. These reports and graphs
are used to analyze trends in server usage, availability, and performance.

Typically, you would stop monitoring on a managed node if the node is not running for a
known reason. For example, the node is down for maintenance. Stopping the monitoring
prevents unnecessary alarms from being generated.

Launch the Verify application to determine if monitoring is started or stopped. By default,
monitoring is on.

Function

Start Monitoring application starts the collection of metrics for one or all application servers
on a managed node.

Stop Monitoring application stops the collection of metrics for one or all application servers on
a managed node.
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To Launch Start/Stop Monitoring

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2  From the Window menu, select Application Bank. The OVO Application Bank window
opens.

3 Double-click WLSSPI. The Application Group: WLS SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All
the WLSSPI Admin applications appear in this window.

5 Select a node in the Node Bank window and double-click Start Monitoring or Stop
Monitoring.

Start/Stop Tracing

You can launch this application to starts/stop tracing the collection of metrics. You must
launch this application only when instructed by your HP support representative.

Launch the Self-Healing Info application to collect the files created by Start Tracing. These
files contain data that the HP support representative will use.

Function

Start Tracing saves information about the collection of metrics into a file.

Stop Tracing stops saving information about the collection of metrics.

To Launch Start/Stop Tracing

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window
opens.

Double-click WLSSPI. The Application Group: WLS SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All
the WLSSPI Admin applications appear in this window.

5 Select a node in the Node Bank window and double-click Start Tracing or Stop Tracing.

Verify

You can launch this application to verify whether WLS SPI is properly installed on the server
and managed node.

Function

Verify application performs the following functions:
e For all managed nodes:
¢ Checks that the following directories exist:
— <OV_AGT_DIR>/wasspi/wls/conf/
— <OV_AGT_DIR>/wasspi/wls/datalog/
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<OV_AGT_DIR>/wasspi/wls/history/
<OV_AGT_DIR>/wasspi/wls/1ib/
<OV_AGT_DIR>/wasspi/wls/log/
<OV_AGT_DIR>/wasspi/wls/tmp/

Checks that the following files exist:

<OV_AGT_DIR>/wasspi/wls/conf/MBeanReports.dtd
<OV_AGT_DIR>/wasspi/wls/conf/MBeanReports.xsl
<OV_AGT_DIR>/wasspi/wls/conf/MetricDefinitions.ser
<OV_AGT_DIR>/wasspi/wls/conf/MetricDefinitions.dtd
<OV_AGT_DIR>/wasspi/wls/conf/MetricMap
<OV_AGT_DIR>/wasspi/wls/conf/OVTrace.sample
<OV_AGT_DIR>/wasspi/wls/conf/ReportsHeader.xsl
<OV_AGT_DIR>/wasspi/wls/conf/SiteConfig
<OV_AGT_DIR>/wasspi/wls/conf/SPIConfig
<OV_AGT_DIR>/wasspi/wls/conf/SPIConfigLogFiles
<OV_AGT _DIR>/wasspi/wls/conf/SPIConfigCfgFiles
<OV_AGT _DIR>/wasspi/wls/conf/trigger

<OV_AGT _DIR>/wasspi/wls/conf/ReportsUtil.xsl
<OV_AGT_DIR>/wasspi/wls/1lib/GraphSP.xsl
<OV_AGT_DIR>/wasspi/wls/1ib/JspiCola.jar

<OV_AGT _DIR>/wasspi/wls/lib/MetricMap.xsl
<OV_AGT_DIR>/wasspi/wls/lib/xalan.jar
<OV_AGT_DIR>/wasspi/wls/lib/xerces.jar

e For Windows managed nodes:

Checks that the following files exist:

Checks that the following files exist and the version is higher than A.01:

<OV_AGT_DIR>/bin/OpC/cmds/wasspi wls admin.exe
<OV_AGT_DIR>/bin/0OpC/cmds/wasspi wls debug.exe
<OV_AGT_DIR>/bin/0OpC/cmds/wasspi wls spiapps.exe
<OV_AGT_DIR>/bin/OpC/cmds/wasspi wls udmgraphs.exe
<OV_AGT_DIR>/bin/OpC/cmds/wasspi wls verify.exe
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls ca.exe
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls config.exe
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls files.exe
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls le.exe
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls logdata.exe
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls setpath.exe
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<OV_AGT_DIR>/bin/0pC/monitor/ddfcomp.exe
<OV_AGT_DIR>/bin/OpC/monitor/ddfcomp coda.exe
<OV_AGT_DIR>/bin/0OpC/monitor/ddflog.exe
<OV_AGT_DIR>/bin/0OpC/monitor/ddflog coda.exe
<OV_AGT_DIR>/bin/0OpC/monitor/ddfutil.exe
<OV_AGT_DIR>/bin/OpC/monitor/ddfutil coda.exe

For UNIX managed nodes:
¢ Checks that the following files exist:

e Checks that the following files exist and the version is higher than A.01:

<OV_AGT_DIR>/bin/0OpC/cmds/wasspi wls admin
<OV_AGT_DIR>/bin/OpC/cmds/wasspi wls debug
<OV_AGT_DIR>/bin/OpC/cmds/wasspi wls spiapps
<OV_AGT_DIR>/bin/0pC/cmds/wasspi_wls udmgraphs
<OV_AGT_DIR>/bin/0OpC/cmds/wasspi wls verify
<OV_AGT_DIR>/bin/OpC/monitor/wasspi_setpath
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls ca
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls config
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls config.pl
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls files
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls le
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls lib.pl
<OV_AGT_DIR>/bin/OpC/monitor/wasspi wls logdata
<OV_AGT_DIR>/bin/OpC/monitor/wasspi xterm

<OV_AGT_DIR>/bin/0OpC/monitor/ddfcomp
<OV_AGT_DIR>/bin/OpC/monitor/ddfcomp coda
<OV_AGT_DIR>/bin/0OpC/monitor/ddflog
<OV_AGT_DIR>/bin/OpC/monitor/ddflog coda
<OV_AGT_DIR>/bin/OpC/monitor/ddfutil
<OV_AGT_DIR>/bin/OpC/monitor/ddfutil coda

Where <OV_AGT DIR> is:

on a UNIX managed node: /var/opt/OvV
on a Windows managed node: depends on the installation of the product

To Launch Verify

1

At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.
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From the Window menu, select Application Bank. The OVO Application Bank window
opens.

Double-click WLSSPI. The Application Group:WLS SPI window opens.

Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All
the WLSSPI Admin applications appear in this window.

Select a node in the Node Bank window and double-click Verify.
If the application is successful the following message appears:

Installation is clean

View Error File

You can launch the Verify Error File application to view the contents of the WLS SPI error log

file.

Functio

n

View Error File application displays the contents of the WLS SPI error log file
<OV_AGT_DIR>/wasspi/wls/log/errorlog, where <OV_AGT _DIR> typically is:

e /var/opt/0vV on UNIX managed nodes

e \Program Files\HP OpenView\Installed Packages\{790 ...} on Windows
managed nodes

To Launch View Error File

At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

From the Window menu, select Application Bank. The OVO Application Bank window
opens.

Double-click WLSSPI. The Application Group:WLS SPI window opens.

Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All
the WLSSPI Admin applications appear in this window.

Select a node in the Node Bank window and double-click View Error File to view the error
logs.
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View Graphs

You can launch View Graphs application to view OpenView Performance Manager (OVPM)
graphs in a web browser.

Required Setup

Before running the View Graphs application:
1 Install OVPM

2 edit the ovweb. conf file (for more information see Task 1: Configure the Management
Server to Launch your Web Browser on page 36.)

If you are using Netscape Navigator, use version 6.0 or higher. Do not use Netscape Navigator
4.79 with this application.

Function

View Graphs application launches a web browser to display OVPM graphs generated by WLS
SPI metric data.

To Launch View Graphs

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window
opens.

3 Double-click WLSSPI. The Application Group:WLS SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All
the WLSSPI Admin applications appear in this window.

5 Select a node in the Node Bank window and double-click View Graphs to view the graphs.
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Weblogic

The WLSSPI Admin application group contains the following applications:

Check Weblogic

You can use this application to check the status of each WebLogic server running on a selected
managed node.

Function

Check WebLogic displays the following information for each WLS server on the selected

nodes:
Information Description
Server Name The server name as defined in the WebLogic Server.
State The status of the WebLogic Server.
Listen Address The name and IP address used to listen for incoming connections.
Health State Numerical representation of the current state of the WebLogic Server.
Health State String | What the WebLogic Server is reporting using self-health monitoring.

If the WLS SPI is configured to not collect metrics for the WebLogic Server, the following
message appears:

Collection is temporarily OFF for <server_name>

To Launch Check Weblogic

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window
opens.

3 Double-click WLSSPI. The Application Group:WLS SPI window opens.

4 Double-click WebLogic Admin. The Application Group: WebLogic window opens. All the
WebLogic applications appear in this window.

5 Select a node in the Node Bank window and double-click Check WebLogic to check the
status.
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Start WLS Console

You can use Start WLS Console to launch the WebLogic Administration Server console from
the OVO console. You can bring up the console for one instance or more instances of
application servers on the selected managed nodes.

Required Setup

The ADMIN_HOST and ADMIN_PORTS configuration properties must be set before this
application can run successfully.

Function

Start WLS Console launches the WebLogic Administration Server console, in a web browser,
for one or more instances of application servers on the selected nodes.

To Launch Start WLS Console

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window
opens.

3 Double-click WLSSPI. The Application Group:WLS SPI window opens.

4 Double-click WebLogic Admin. The Application Group: WebLogic window opens. All the
WebLogic applications appear in this window.

5 Select a node in the Node Bank window and double-click Start WLS Console to launch the
WebLogic Administration Server console.

Start/Stop Weblogic

You can use the Start WebLogic or Stop WebLogic application to start and stop WebLogic
Servers from the OVO console. You can start and stop one or more instances of application
servers running on the selected managed nodes without logging on to each WebLogic
Administration Server.

Required Setup

The START _CMD, STOP_CMD, and USER configuration properties must be set before
launching this application.

Function

Start WebLogic application starts one or more instances of application servers on the selected
managed nodes.

Stop WebLogic application stops one or more instances of application servers on the selected
managed nodes.
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To Launch Start/Stop Weblogic

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window

opens.

3 Double-click WLSSPI. The Application Group:WLS SPI window opens.

4 Double-click WebLogic Admin. The Application Group: WebLogic window opens. All the
WebLogic applications appear in this window.

5 Select a node in the Node Bank window and double-click Start WebLogic or Stop WebLogic.

View Deployed Apps

You can use the View Deployed Apps application to view applications running on a WebLogic
Server instance without logging on to the system on which the WebLogic Server is running.

Function

View Deployed Apps displays the following information for each WebLogic Server instance on
the selected managed node (the WLS Version column denotes the information that is
displayed based on the WebLogic Server version):

Information WLS Version |Description

Application 6.1, 7.0, 8.1, 9.x | The application instance.

Name 6.1, 7.0, 8.1, 9.x | The name of the application.

Version 9.x The application version (if the application is not
versioned, “null” is displayed).

Module Type 9.x The J2EE module type such as CAR, EAR, EJB, RAR, or

WAR.

To Launch View Deployed Apps

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window

opens.

3 Double-click WLSSPI. The Application Group:WLS SPI window opens.

4 Double-click WebLogic Admin. The Application Group: WebLogic window opens. All the
WebLogic applications appear in this window.

5 Select a node in the Node Bank window and double-click View Deployed Apps.

Appendix C



View Weblogic Log

Applications

You can use the View WebLogic Log application to view WebLogic Server log files without
logging on to the system on which the WebLogic Server is running.

Function

View WebLogic Log application displays the following information:

If you launch View WebLogic Log without a parameter: a numbered list of available log
files for the managed node.

If you launch View WebLogic Log with a non-valid parameter (a non-numeric value or a
number not corresponding to the list of available log files): a numbered list of available log
files for the managed node.

If you launch View WebLogic Log with a valid parameter: the contents of the
corresponding log file for the managed node.

You can enter only one numeric value in the parameter field. You will be able to view (for all
selected managed nodes) the log file designated to this number. Each time you launch this
application select one log file per managed node to view.

To Launch View Weblogic Log

1
2

At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

From the Window menu, select Application Bank. The OVO Application Bank window
opens.

Double-click WLSSPI. The Application Group: WLSSPI window opens.

Double-click WebLogic. The Application Group: WebLogic window opens. All the WebLogic
applications appear in this window.

Select a node in the Node Bank window and double-click View WebLogic Log. The WLS
LOGS window opens.

The WLS LOGS window contains the node name and a list of options. Enter the option of
your choice and press Enter.

Scroll through the WLS SPI window to view the log file data.

Enter q to exit the window.
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View Weblogic Servers

You can use the View WebLogic Severs application to view the WebLogic domain
configuration, cluster information, and physical machines without logging on to the system on
which the WebLogic Server is running.

Function

View WebLogic Servers displays the following information for each WebLogic Server instance
on the selected managed node (the WLS Version column denotes the information that is
displayed based on the WebLogic Server version):

Information WLS Version |Description

Domain 6.1, 7.0, 8.1, 9.x | The WebLogic domain instance.

Admin Server 9.x The name of the WebLogic administration server
instance.

Version 9.x The release identifier for the configuration.

Server 6.1, 7.0, 8.1, 9.x | The WebLogic Server instance.

Name 6.1, 7.0, 8.1, 9.x | The name of the server instance. This is the name

displayed in the Administration Console and is used to
identify the server.

Listen Port 6.1, 7.0, 8.1, 9.x | The default TCP port that the WebLogic Server instance
uses to listen for regular (non-SSL) incoming
connections.

Listen Address 6.1, 7.0, 8.1, 9.x | The IP address or DNS name the WebLogic Server
instance uses to listen for incoming connections.

Cluster 6.1, 7.0, 8.1, 9.x | The cluster instance.
Name 6.1, 7.0, 8.1, 9.x | The user-specified name of the cluster instance.
Type 9.x How clustered servers send data for optimization of

cross-cluster replication such as man (metro area
network), wan, or none.

Address 6.1, 7.0, 8.1, 9.x | The address used by clients to connect to the cluster and
what is used for generating EJB handles and entity EJB
failover addresses.

Multicast Address| 6.1, 7.0, 8.1, 9.x | The address used by cluster members to communicate

with each other.
Machine 6.1, 7.0, 8.1, 9.x | The machine instance.
Name 6.1, 7.0, 8.1, 9.x | The user-specified name of the machine instance.
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To Launch View Weblogic Severs

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window
opens.

3 Double-click WLSSPI. The Application Group: WLSSPI window opens.

4 Double-click WebLogic. The Application Group: WebLogic window opens. All the WebLogic
applications appear in this window.

5 Select a node in the Node Bank window and double-click View WebLogic Servers.

View Application Activation Status

You can use View Application Activation Status application to view the activation status of
the applications, deployed and running on a WebLogic Server instance, without logging in to
the system on which the WebLogic Server is running.

Required Setup

Before launching View Application Activation Status application, set the following value for
the configuration property URL_PATH (for information on configuration properties see
Configuration Properties on page 168):

/jndi/weblogic.management .mbeanservers.domainruntime

Function

View Application Activation Status application gives the following information for each
WebLogic Server instance on the selected managed node. The information given in the
Description column is dependent on the WebLogic Server version.

Table 18
Information WLS Version Description
AppRuntimeStateRuntime 9.x AppRuntimeStateRuntime MBean
Application ID 9.x Serial Number for the Application ID
(generated by the SPI)
Application-ID 9.x The name of the application
Is Active? 9.x If "true" is displayed in this field, then
the application is active. If "false" is
displayed, then the application is
inactive
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To Launch View Application Activation Status

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window

opens.

3 Double-click WLSSPI. The Application Group: WLSSPI window opens.

4 Double-click WebLogic. The Application Group: WebLogic window opens. All the WebLogic
applications appear in this window.

5 Select a node in the Node Bank window and double-click View Application Activation Status.

View Application Timeout

View Application Timeout application allows you to view the time left before retiring
applications, deployed and running on a WebLogic Server instance, will timeout. You can view
the time left without logging in to the system on which the WebLogic Server is running.

Required Setup

Before launching View Application Timeout application, set the following value for the
configuration property URL_PATH (for information on configuration properties see

Configuration Properties on page 168):
/jndi/weblogic.management .mbeanservers.domainruntime

Function

You can use the View Application Timeout application to get the following information for
each WebLogic Server instance on the selected managed node. The information given in the
Description column is dependent on the WebLogic Server version.

Table 19
Information WLS Version Description
AppRuntimeStateRuntime 9.x AppRuntimeStateRuntime MBean
Application ID 9.x Serial Number for the Application ID
(generated by the SPI)
Application-ID 9.x The name of the application
Time Left to Retire 9.x The amount of time the application is

given to retire (This returns the value
"—1" if only one version of the
application exists on the server and no
timeout is set for the applications).
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To Launch View Application Timeout

1 At the OVO console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window
opens.

3 Double-click WLSSPI. The Application Group: WLSSPI window opens.

4 Double-click WebLogic. The Application Group: WebLogic window opens. All the WebLogic
applications appear in this window.

5 Select a node in the Node Bank window and double-click View Application Timeout.
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Glossary

agent

A program or process running on a remote device or computer system that responds to
management requests, performs management operations, or sends performance and event
notification. An agent can provide access to managed objects and MIB variables, interpret
policy for resources and do configuration of resources.

application

Packaged software that provides functionality that is designed to accomplish a set of related
tasks. An application is generally more complex than a tool.

ASCII

American Standard Code for Information Interchange.

assigned policy

A policy that has been assigned to one or more resources in the computing environment but
which has not yet been deployed or installed on those resources.

automatic action

A pre-configured program or script that is executed in response to an event, message, or a
change in information in the management database. without operator intervention.

client

When the context is network systems, a computer system on a network that accesses a service
from another computer (server). When the context is software, a program or executable
process that requests a service from a server.

client console

An instance of the user interface that appears on the client system while the application runs
on a server.

command

An instruction to a computer program that causes a specified operation to be carried out.
Commands are typically typed by users on a command line.

configuration

In a network context, the complete set of inter-related systems, devices and programs that
make up the network. For example the components of a network may include computer
systems, routers, switches, hubs, operating systems and network software. The configuration
of the network determines the way that it works and the way that it is used. In a software
context, the combination of settings of software parameters and attributes that determine the
way the software works, the way it is used, and how it appears.
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configuration file

A file that contains specifications or information that can be used for determining how a
software program should look and operate.

configure

To define and modify specified software settings to fulfill the requirements of a specified
environment, application or usage.

connection

A representation of a logical or physical relationship between objects.

console

An instance of the user interface from which the user can control an application or set of
applications.

customization

The process of designing, constructing or modifying software to meet the needs and
preferences of a particular customer or user.

customize

To design, construct or modify software to meet the needs and preferences of a particular
customer or user.

data type

A particular kind of data; for example database A repository of data that is electronically
stored. Typically databases are organized so that data can be retrieved and updated.

deploy

To install and start software, hardware, capabilities, or services so that they work in the
business environment.

Deployed application

An application and its components that have been installed and started to work in the
business environment.

deployed policy

A policy that is deployed on one or more resources in the computing environment.

deployment

The process of installing and activating software, hardware, capabilities or services so that
they work in the business environment.

Deployment package

A software package that can be deployed automatically and installed on a managed node.

error log

An output file containing error messages.



event

An event is an unsolicited notification such as an SNMP trap or WMI notification generated
by an agent or process in a managed object or by a user action. Events usually indicate a
change in the state of a managed object or cause an action to occur.

HP OpenView

A family of network and system management products, and an architecture for those
products. HP OpenView includes development environments and a wide variety of
management applications.

Hypertext Transfer Protocol (HTTP).

The protocol that World Wide Web clients and servers use to communicate.

HTTPS

Hypertext Transfer Protocol Secure.

icon

An on-screen image that represents objects that can be monitored or manipulated by the user
or actions that can be executed by the user.

managed object

A network, system, software or service object that is both monitored for performance, status
and messages and is manipulated by means of actions in the management software.

management console

An instance of the user interface from which the user can control the management application
or set of management applications. The console may be on the system that contains the
management software or it may be on another system in the management domain.

management server

A server that provides management services, processes, or a management user interface to
clients. A management server is a type of management station.

message

A structured, readable notification that is generated as a result of an event, the evaluation of
one or more events relative to specified conditions, or a change in application, system,
network, or service status.

message browser

A graphical user interface that presents notifications that are generated as a result of an
event, the evaluation of one or more events relative to specified conditions or a change in
application, system, network, or service status.

message description

Detailed information about an event or message.
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message key

A message attribute that is a string used to identify messages that were triggered from
particular events.The string summarizes the important characteristics of the event. Message
keys can be used to allow messages to acknowledge other messages, and allows for the
identification of duplicate messages.

message severity level

A property of a message indicating the level of impact of the event or notification that
initiated the message. See also severity level.

metadata
Data that defines data.

metric

A measurement that defines a specific operational or performance characteristic.

Microsoft Management Console (MMC)

A Microsoft product that provides a software framework for the management of IT
environments. Management products are added or "snapped into" the management console
and thus extend the management capability of the Microsoft Management Console.

module

A self-contained software component that performs a specific type of task or provides for the
presentation of a specific type of data. Modules can interact with one another and with other
software.

node

When the context is network, a computer system or device (for example, printer, router,
bridge) in a network. When the context is a graphical point to point layout, a graphical
element in a drawing that acts as a junction or connection point for other graphical elements.
Oovo

HP OpenView Operations

OVPA
HP OpenView Performance Agent

OVPM

HP OpenView Performance Manager

parameter

A variable or attribute that may be given an arbitrary value for use during an execution of
either a computer program or a procedure within a program.

parameter type

An abstraction or categorization of a parameter that determines the particular kind of data
that is valid for the parameter. For example a parameter type could be IP Address which



indicates that parameter values must have 4 numbers separated by decimals with the value
for each number being in the range of 0 to 255.

parameter value

A value that is given to a variable.

policy

A set of one or more specifications rules and other information that help automate network,
system, service, and process management. Policies can be deployed to various targets (for
example, managed systems, devices, network interfaces) providing consistent, automated
administration across the network.

Policy management

The process of controlling policies (for example, creating, editing, tracking, deploying,
deleting) for the purposes of network, system or service management.

policy type
An abstraction or categorization of policies based on the function of the policy or the services
that the policy supports.

port

If the context is hardware, a location for passing information into and out of a network device.
If the context is ECS, a location for passing information into and out of a correlation node.

server

If the context is hardware plus software, a computer system that provides a service (for
example, management capabilities, file storage capabilities) to other computer systems
(clients) on the network. If the context is a software component, a program or executable
process that responds to and services requests issued by clients.

severity level
A property of an object indicating the status of the object. Severity level is based on the impact
of events or messages associated with the object.

SMART Plug-In (SPI)

Prepackaged software that installs into a management console and provides management
capabilities specific to a given type of business application, database, operating system, or
service.

trace log

An output file containing records of the execution of application software
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Index

A

actions
automatic, 61
customizing, 61
distributing, 43
operator-initiated, 61

Add Application Server action, 161, 162

adding
nodes to WLS SPI node group, 48

Add Node action, 161, 163

ADDRESS property, 46, 170
ADMIN_HOST property, 170
ADMIN_PORTS property, 46, 170, 171

alarms
modifying, 62
ALIAS property, 172

application bank
reports, 73

applications, 16, 185
Check WebLogic, 18, 198
Configure WLSSPI, 17, 186
Deploy UDM, 19
Discover, 44, 187
Discover WebLogic, 17
Gather MBean Data, 19
Init Non-Root, 17, 189
JMX Metric Builder, 19
Self-Healing Info, 17, 189
Start Monitoring, 17, 192
Start Tracing, 17, 193
Start WebLogic, 18, 199
Start WLS Console, 18, 199
Stop Monitoring, 17, 192
Stop Tracing, 17, 193
Stop WebLogic, 18, 199
UDM Graph Disable, 19
UDM Graph Enable, 19
Verify, 17, 193

View Application Activation Status, 18

View Application Timeout, 18
View Deployed Apps, 18, 200
View Error File, 17, 196

View Graphs, 17, 197

View WebLogic Log, 18, 201
View WebLogic Servers, 18, 202
WebLogic group, 18

WLSSPI Admin group, 16

WLS SPI Reports group, 19

application server
verifying status, 40

Application Servers tree item, 160
ASCII-Text Reports, 13

assigning operator responsibilities, 29, 36
AUTO_DISCOVER, 166
AUTO_DISCOVER property, 172
automatic action reports, 72

automatic actions, 61

B
BEA_HOME_LIST property, 173
bundles, 24
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C Config WLSSPI

actions, 161
Cancel button, 161 Add Application Server action, 161, 162

Check WebLogic application, 18, 198 Add Group action, 161, 163
what it does, 198 Add Node action, 161, 163
CODA Application Servers tree item, 160
using, 84 buttons, 161
Cancel button, 161
COLLECT_METADATA property, 173 Configuration tree item, 160
collection intervals Default Properties tree item, 160
changing, 68 Defaults tree item, 160
changing for selected metrics, 69 Exit action, 162
collector Finish button, 161
wasspi_wls_ca command, 63 GTOUPS tree item, 160
collector templates, 20 gzz:’b{i?;on, 161
commands Nodes tree item, 160
distributing, 43 Remove ALL App Servers action, 162, 164
components, 16 Remove ALL Groups, 162, 164

Remove ALL Nodes action, 162, 165
Remove Application Server action, 162, 164
Remove Group action, 162, 164

conditional properties
configuring, 50

sefting, 50 Remove Node action, 162, 165
configuration Save action, 162

properties, 168 Save button, 161

structure, 157 Set Configuration Properties tab, 162, 165

syntax, 157 tree, 159
configuration editor using, 159

See Config WLSSPI View Configuration Settings tab, 162, 166
Conﬁguration example Conﬁg WLSSPI application, 17

group and node properties, 182 customization, 12

multiple WLS versions, 183 ..

non-default WLS startup location, 184 custom‘l Zng

actions, 61

single node/two servers, 181

virtual IP addresses, 184 duration, 60

message text, 61

Configuration tree item, 160 severity, 60

Configure WLSSPI application, 186 thresholds, 60
what it does, 186

configuring D
managed nodes, 40 Default Properties tree item, 160
Igg;i%?;%ent server, 36, 42 Defaults tree item, 160
ovweb.conf, 36 Deploy UDM application, 19
prerequisites, 35 directories
remote systems, 78 locations for trace file/error logs, 106

WebLogic Server user, 40 Discover application, 17, 44, 187

setting LOGIN and PASSWORD, 45
what it does, 187

discovery process
verifying, 47

discovery template, 20

displaying graphed metrics, 36
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distributing
actions, monitors, and commands, 43
templates, 49

duration
customizing, 60

E

editing
alarms, 62
templates, 59

error messages, 113 to 154
EXCLUDE_SAMPLES property, 47, 174
Exit action, 162

F

files, locations on management server/managed
nodes, 104, 106

filesets, 24
Finish button, 161

G

Gather MBean Data application, 19
global properties, 157
GRAPH_URL property, 174

graphs
date range, 93
generating, 92
metrics used to generate, 90
operator action, 92
OVPM, 83
viewing alarm conditions, 89
viewing conditions, 90

GROUP block, 157
Groups tree item, 160

H
HOME_LIST property, 46, 174
HOME property, 174

Init Non-Root application, 17, 189
what it does, 189

installing, 23
bundles, 24
filesets, 24
swinstall, 23
WLS SPI report package, 84

instruction text
location, 13

J

JAVA_HOME property, 47, 174
JMB_JAVA_HOME property, 175
JMX_CLASSPATH property, 175
JMX Metric Builder application, 19

K
KEYSTORE property, 175

L
LAUNCH_DIR property, 175

license count, 81

limitations
remote systems, 81

LOGFILE property, 175

logfiles templates, 20

LOGIN property (WLS version 6.1), 175
LOGIN property (WLS version 7.0, 8.1), 175

M

managed nodes
adding to WLS SPI node group, 48
configuring, 40

management server
configuring, 42

MAX_ERROR_LOG_SIZE property, 176

messages
instruction text, 13
message browser, 12

message template, 20

message text
customizing, 61

metrics
data collected, 11
graphs generated from, 90
OVPI reports generated from, 88
Reporter reports generated from, 86

metrics templates, 20

modifying
alarms, 62
templates, 59

monitoring
logfiles on remote systems, 80
unsupported platforms, 77
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monitors
distributing, 43

N

NAME property, 176

Next button, 161
NODE_NAMES property, 47, 176
NODE block, 158

Nodes tree item, 160
NUM_SERVERS property, 176

(0

operator
assigning responsibilities, 29, 36

operator-initiated actions, 61
ov.envvars.sh, 36

OV_CONF environment variable, 36
OVPA, 83

OVPI reports, 88

OVPM
integrating with WLS SPI, 36, 89

ovweb.conf
configuring, 36
OV_CONF environment variable, 36

P

PASSPHRASE property, 176

PASSWORD property (WLS version 6.1), 177
PASSWORD property (WLS version 7.0, 8.1), 177
PORT property, 177

prerequisites
configuring, 35
properties, 168
configuring conditional, 50
definitions, 169 to 180
global, 157
listed by WLS SPI requirements, 169
precedence, 158
server-specific, 158
setting conditional, 50

PROTOCOL, 47
PROTOCOL property, 177

R

reinstalling
templates, 71

216

remote systems, 77
agent deployment requirement, 78
configuration requirements, 78
configuring, 78
how it works, 77
limitations, 81
logfile monitoring, 80
overview, 77
requirements, 77
template requirements, 78

Remove ALL App Servers action, 162, 164
Remove ALL Groups action, 162, 164
Remove All Nodes action, 162, 165

Remove Application Server action, 162, 164
Remove Group action, 162, 164

Remove Node action, 162, 165

removing
swremove, 24, 28
WLS SPI, 24

Reporter
integrating with WLS SPI, 84

Reporter reports, 86
Report package, 14

report package
installing, 33, 84
removing, 26

reports
application bank, 73
automatic action, 72
generated from alarms, 19
included, 14
Manually Generated Reports, 73
metrics used to generate in OVPI, 88
metrics used to generate in Reporter, 86
OVPI, 83, 88
Reporter, 83, 86
viewing, 73, 74

requirements
remote systems, 77

resetting thresholds, 62
RMID_PORT property, 178
RMID_START_TIME property, 178

S
Sample Reports, 74

Save action, 162
Save button, 161
schedule templates, 20



Self-Healing Info application, 17, 189
required setup, 189
what it does, 190

server-specific properties, 158
Set Configuration Properties, 162
Set Configuration Properties tab, 165

Set Configuration Settings tab
AUTO_DISCOVER, 166
modifying a property, 165
removing a property, 166
setting a property, 165

setting
conditional properties, 50

severity
customizing, 60

START_CMD property, 178

Start Monitoring application, 17, 192
what it does, 192

Start Tracing application, 17, 193
what it does, 193

Start WebLogic application, 18, 199
required setup, 199
what it does, 199

Start WLS Console application, 18, 199
required setup, 199
what it does, 199

status of application server
verifying, 40

STOP_CMD property, 178

Stop Monitoring application, 17, 192
what it does, 192

Stop Tracing application, 17, 193
what it does, 193

Stop WebLogic application, 18, 199
required setup, 199
what it does, 199

structure
configuration, 157

swinstall, 23
reinstalling templates, 71

swremove, 24, 28

syntax
configuration, 157

T

tag option
creating custom template groups, 70

template groups, 20
changing collection intervals, 69
customizing, 70
WLSSPI Discovery, 20
WLSSPI-Logfiles, 20
WLSSPI-Metrics, 20
WLSSPI-Schedule, 20

templates, 20
collector, 20
continuously setting, 62
customizing, 59
discovery, 20
distributing, 49
logfiles, 20
message, 20
metrics, 20
modifying, 59
reinstalling, 71
resetting thresholds, 62
Schedule, 20
thresholds without reset, 62
WLSSPI-Messages, 20

thresholds
customizing, 60
resetting, 62
settings for different servers, 69
without reset, 62

TIMEOUT property, 179

To Launch Check WebLogic application, 198

To Launch Configure WLS SPI application, 186
To Launch Discover WebLogic application, 187
To Launch Init Non-Root application, 189

To Launch Self-Healing Info application, 192

To Launch Start/Stop Monitoring application, 193
To Launch Start/Stop Tracing application, 193
To Launch Start/Stop WebLogic application, 200
To Launch Start WLS Console application, 199
To Launch Verify application, 195

To Launch View Application Activation Status
application, 204

To Launch View Application Timeout application,
205

To Launch View Deployed Apps application, 200
To Launch View Error File application, 196

To Launch View Graphs application, 197

To Launch View WebLogic Log application, 201
To Launch View WebLogic Severs application, 203
TYPE property, 179
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U

UDM_DEFINITONS_SOURCE property, 179

UDM Graph Disable application, 19
UDM Graph Enable application, 19

unsupported platforms
monitoring, 77

upgrading, 27
management server, 29
WLS SPI graph package, 33
WLS SPI report package, 26, 27, 33

URL, 179
URL_PATH Property, 179

user
configuring WebLogic Server, 40

user defined metrics
graphing, 101

USER property, 179

using
Config WLSSPI, 159

Using the JMX Command Parameters, 65

\'}

Verify application, 17, 193
what it does, 193

verifying
application server status, 40
discovery process, 47

VERSION property, 180
View Application Activation Status, 203

View Application Activation Status application, 203

Function, 203
Required Setup, 203

View Application Timeout, 204

View Application Timeout application, 204
Function, 204

View Configuration Settings tab
View Inherited Properties, 167

View Current Configuration, 162
View Current Configuration tab, 166

View Deployed Apps application, 18, 200
what it does, 200

View Error File application, 17, 196
what it does, 196

View Graphs application, 17, 197
required setup, 197
what it does, 197
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viewing

reports, 73, 74
Viewing Text-based Reports, 72
View Inherited Properties, 167

View WebLogic Log application, 18, 201
what it does, 201

View WebLogic Servers application, 18, 202
what it does, 202

w
WASSPI-35, 125, 126, 127, 128

wasspi_wls_ca command, 63
parameters, 63

WebLogic application group, 18

WebLogic Server user
configuring, 40

WLS SPI
components, 16
overview, 12

WLSSPI Admin application group, 16
WLSSPI Discovery template group, 20
WLSSPI-Logfiles template group, 20
WLSSPI-Messages template, 20
WLSSPI-Metrics template group, 20

WLS SPI node group
adding nodes, 48

WLS SPI Reports application group, 19
WLSSPI-Schedule template group, 20
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